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Welcome to this Tutorial

Welcome to HP Application Lifecycle Management (ALM). ALM empowers organizations to
manage the core application lifecycle, from requirements through deployment, granting application
teams the crucial visibility and collaboration needed for predictable, repeatable, and adaptable
delivery of modern applications.

This tutorial is a self-paced guide that instructs you how to use the ALM application to organize and
manage all phases of the application lifecycle. To successfully complete this tutorial, you should
perform the tutorial in the order in which the information is presented.

Note: To learn how to work with the HP ALM Performance Center Edition, refer to HP ALM
Performance Center Quick Start.

How This Tutorial is Organized

This tutorial contains the following lessons:

Chapter Description

"Introducing Introduces you to the application lifecycle management process, and
HP ALM" on page 15  familiarizes you with the ALM user interface and the sample Mercury
Tours Web site.

"Specifying Shows you how to define releases and cycles and monitor their progress
Releases and and quality.
Cycles" on page 26

"Specifying Shows you how to define requirements, view the requirements tree, and
Requirements" on convert requirements to tests.
page 30

"Planning Tests" on = Shows you how to create a test plan tree, define test steps, define test
page 42 configurations, link test configurations to requirements, and automate
manual tests.

"Running Tests" on Shows you how to define test sets, schedule test runs, and run manual
page 63 and automated tests.

"Adding and Tracking = Shows you how to add new defects, update defects, and manage

Defects" on page defects.

108

"Alerting on Shows you how to keep track of changes made to your requirements,
Changes" on page tests, and defects as you perform your project testing.

122
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Chapter Description

"Analyzing ALM Shows you how to monitor the application lifecycle management process
Data" on page 127 by creating reports and graphs.

"Creating Libraries Shows you how to create libraries and baselines, and how to compare
and Baselines" on baselines to track changes in your project.

page 157

"Customizing Shows you how to set up project users, and how to create project fields
Projects" on page and lists.

166

"Conclusion" on Summarizes the ALM application lifecycle management process and
page 182 suggests the steps to consider for each phase.

Before You Begin

To work with this tutorial, consider the following specifications:

Specification Description

ALM Editions = HP ALM is also available in several editions which provide subsets of ALM
functionality — HP ALM Essentials Edition, HP Quality Center Enterprise
Edition, and HP ALM Performance Center Edition. This tutorial assumes that
you are working in HP ALM Edition or HP Quality Center Enterprise Edition.
Some of the lessons and exercises in this tutorial are not applicable if you are
working in HP ALM Essentials Edition. To determine which edition you are
using, contact your ALM site administrator.

Note: If you are working with the HP ALM Performance Center Edition,
refer to HP ALM Performance Center Quick Start.
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Specification

ALM_Demo
Project

Mercury
Tours

HP Unified
Functional
Testing

HP Sprinter

HP ALM (12.00)

Description

The demo project is available with the ALM 12.00 installation DVD and is
obtained by importing the ALM_Demo.qcp file using Site Administration. For
more information on importing projects, refer to the HP Application Lifecycle
Management Administrator Guide.

To ensure that you get the same results as the ones specified in this tutorial,
make sure that you work on a new copy of the ALM_Demo project. For more
information, contact your ALM site administrator.

ALM projects can be version controlled. Some of the screenshots in this
tutorial assume a version-controlled project, and display additional icons and
options. For more information on version control, refer to the HP Application
Lifecycle Management User Guide.

This tutorial also contains steps related to functional testing. Functional
testing is relevant only if you are using ALM Edition with the Lab
Management extension enabled. For details on enabling project extensions,
refer to the HP Application Lifecycle Management Administrator Guide.
Running automated tests also assumes that you have a working UFT host
set up for your project. For more details, see HP Unified Functional Testing
below.

Mercury Tours is a sample application that simulates a Web-based site for
reserving flights, hotel rooms, car rentals, cruises, and vacation deals.

Mercury Tours is available at http://newtours.demoaut.com/.

To run the automated tests in this tutorial, Unified Functional Testing (UFT)
must be installed.

To integrate ALM with UFT, download and install the HP UFT add-in and the
HP ALM Connectivity tool from the HP Application Lifecycle Management
Tools page. For details on ALM tools, refer to the HP Application Lifecycle
Management Installation and Upgrade Guide.

To run manual tests in this tutorial, you can use Manual Runner, HP Sprinter,
or both. For enhanced functionality and a variety of tools to assist in the
manual testing process, run manual tests with Sprinter.

To run tests with Sprinter, download and install the Sprinter add-in from the
HP Application Lifecycle Management Add-ins page. For more information on
ALM add-ins, refer to the HP Application Lifecycle Management Installation
and Upgrade Guide.
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ALM Help

The ALM Help is an online help system that describes how to use ALM. You can access the ALM
Help in the following ways:

¢ Inthe ALM main window select Help > ALM Help to open the ALM Help home page. The home
page provides quick links to the main help topics.

o Click 0 in the ALM masthead to open the ALM Help to the topic that describes the current
page.

ALM Help Guides

The ALM Help consists of the following guides and references, available online, in PDF format, or
both. PDFs can be read and printed using Adobe Reader, which can be downloaded from the Adobe
Web site (http://www.adobe.com).

Reference Description

Using the ALM Help Explains how to use the Help and how it is organized.

What’s New? Describes the newest features in the latest version of ALM.
To access, select Help > What's New.

Movies Short movies that demonstrate the main product features.
To access, select Help > Movies.

Readme Provides last-minute news and information about ALM.

HP Application

Lifecycle

Management (ALM)

Guides Description

HP ALM User Explains how to use ALM to organize and execute all phases of the

Guide application lifecycle management process. It describes how to specify
releases, define requirements, plan tests, run tests, and track defects.

HP ALM Explains how to create and maintain projects using Site Administration,

Administrator and how to customize projects using Project Customization.

Guide

HP ALM Lab Explains how to use Lab Management to manage lab resources used for

Management Guide

HP ALM Tutorial

HP ALM (12.00)

functional and performance testing on remote hosts.

A self-paced guide teaching you how to use ALM to manage the
application lifecycle management process.
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HP Application

Lifecycle

Management (ALM)

Guides Description

HP ALM Installation Describes the installation and configuration processes for setting up
and Upgrade Guide = ALM Server, and the project upgrade process.

HP ALM Lab Provides information for troubleshooting problems while working with HP
Management ALM Lab Management.

Troubleshooting

Guide

HP ALM External Describes the configuration needed to access ALM with external
Authentication authentication.

Configuration

Guide

HP ALM Business Explains how to install and use the Business Views Microsoft Excel
Views Microsoft Add-in to create and configure business view Excel reports.

Excel Add-in User

Guide

Business Process Explains how to use Business Process Testing to create business
Testing User Guide | process tests.

HP ALM

Performance

Center Guides Description

HP ALM A self-paced guide giving the Performance Center user a high level
Performance overview of creating and running performance tests.

Center Quick

Start

HP ALM Explains to the Performance Center user how to create, schedule, run, and
Performance monitor performance tests. Explains to the Performance Center

Center Guide administrator how to configure and manage Performance Center projects.
HP ALM Describes the installation processes for setting up Performance Center
Performance Servers, Performance Center Hosts and other Performance Center
Center components.

Installation Guide

HP ALM Provides information for troubleshooting problems while working with HP
Performance ALM Performance Center.

Center

Troubleshooting

Guide
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HP ALM Best Practices Guides

HP ALM Agile Testing Best Practices
Guide

HP ALM Business Process Models
Best Practices Guide

HP ALM Database Best Practices
Guide

HP ALM Entities Sharing Best
Practices Guide

HP ALM Project Planning and
Tracking Best Practices Guide

HP ALM Project Topology Best
Practices Guide

HP ALM Upgrade Best Practices
Guide

HP ALM Versioning and Baselining
Best Practices Guide

HP ALM Workflow Best Practices
Guide

HP ALM Performance Center
Best Practices Guides

HP Performance Centers of
Excellence Best Practices

HP Performance Monitoring
Best Practices

HP ALM API

References Description

HP ALM
Project
Database
Reference

fields.

HP ALM Open
Test
Architecture

API Reference  project.

HP ALM (12.00)

Description

Provides best practices forimplementing agile
testing principles.

Provides best practices for working with the
Business Models module.

Provides best practices for deploying ALM on
database servers.

Provides best practices for sharing entities.

Provides best practices for managing and tracking
releases.

Provides best practices for structuring projects.

Provides methodologies for preparing and planning
your ALM upgrade.

Provides best practices for implementing version
control and for creating baselines.

Provides best practices for implementing workflows.

Description

Provides best practices for successfully building and
operating Performance Centers of Excellence.

Provides best practices for monitoring the performance of
applications under test.

Provides a complete online reference for the project database tables and

Provides a complete online reference for the ALM COM-based API. You can
use the ALM open test architecture to integrate your own configuration
management, defect tracking, and home-grown testing tools with an ALM
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HP ALM API
References

HP ALM Site
Administration
API Reference

Description

Provides a complete online reference for the Site Administration COM-based
API. You can use the Site Administration API to enable your application to
organize, manage, and maintain ALM users, projects, domains, connections,
and site configuration parameters.

HP ALM REST Provides an online reference for the ALM REST-based API. You can use the
API Reference = REST API to access and work with ALM data.

HP ALM COM  Provides a complete online guide for creating your own testing tool and
Custom Test integrating it into the ALM environment using native COM development tools.
Type

Developer

Guide

HP ALM .NET  Provides a complete online guide for creating your own testing tool and
Custom Test integrating it into the ALM environment using a combination of DCOM and
Type .NET classes.

Developer

Guide

HP ALM

Performance

Center API

References Description

HP Provides an online reference for the ALM Performance Center REST-
ALM Performance based API. You can use the REST API to execute actions to support
Center REST API automation and continuous integration.

Reference

Topic Types

The content in the above mentioned ALM guides is organized by topics. Three main topic types are
in use: Concepts, Tasks, and Reference.

Topic Type

Concepts

HP ALM (12.00)

Description Usage
Background, descriptive, or conceptual Learn general information
information. about what a feature does.
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Topic Type

Tasks

Reference

Troubleshooting
and Limitations

Description

Instructional Tasks. Step-by-step guidance
to help you work with the application and
accomplish your goals.

Task steps can be with or without numbering:

o Numbered steps. Tasks that are
performed by following each step in
consecutive order.

¢ Non-numbered steps. A list of self-
contained operations that you can perform
in any order.

Use-case Scenario Tasks. Examples of how
to perform a task for a specific situation.

General Reference. Detailed lists and
explanations of reference-oriented material.

User Interface Reference. Specialized
reference topics that describe a particular
user interface in detail. Clicking @) onthe

masthead, or selecting ALM Help from the
Help menu in the product generally opens the
user interface topics.

Troubleshooting and Limitations.
Specialized reference topics that describe
commonly encountered problems and their
solutions, and list limitations of a feature or
product area.

Additional Online Resources

The following additional online resources are available from the Help menu:

Resource

Troubleshooting
& Knowledge
Base

HP ALM (12.00)

Description

Usage

e Learn about the overall
workflow of a task.

o Follow the steps listed in
a numbered task to
complete a task.

e Perform independent
operations by completing
steps in a non-numbered
task.

Learn how a task could be
performed in a realistic
scenario.

Look up a specific piece of
reference information
relevant to a particular
context.

Look up specific information
about what to enter or how
to use one or more specific
user interface elements,
such as awindow, dialog
box, or wizard.

Increase your awareness of
important issues before
working with a feature, or if
you encounter usability
problems in the software.

Opens the Troubleshooting page on the HP Software Support Web site
where you can search the Self-solve knowledge base. Choose Help >
Troubleshooting & Knowledge Base. The URL for this Web site is
http://h20230.www2.hp.com/troubleshooting.jsp.
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Resource Description
HP Software Opens the HP Software Support Web site. This site enables you to browse
Support the Self-solve knowledge base. You can also post to and search user

discussion forums, submit support requests, download patches and updated
documentation, and more. Choose Help > Software Support Online. The
URL for this Web site is www.hp.com/go/hpsoftwaresupport.

o Most of the support areas require that you register as an HP Passport
user and sign in. Many also require a support contract.

o To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

o Toregister foran HP Passport user ID, go to:
http://h20229.www2.hp.com/passport-registration.html

HP Software Opens the HP Software Web site. This site provides you with the most up-
Quality Center to-date information on HP Software products. This includes new software
Website releases, seminars and trade shows, customer support, and more. Choose

Help > HP Software Quality Center Website. The URL for this Web site
is www.hp.com/go/software.

HP Software Opens the HP ALM Software Web site. This site provides you with the most
Application up-to-date information on HP ALM. This includes new software releases,
Lifecycle seminars and trade shows, customer support, and more. Choose Help >
Management HP Software Application Lifecycle Management Website. The URL for
Website this Web site is http://www8.hp.com/us/en/software-

solutions/software.html?compURI=1172141#tab=TAB1.

Add-ins Opens the Add-ins page, which offers integration and synchronization
solutions with HP and third-party tools.

ALM Tools Opens the ALM Tools page, which offers integration and synchronization
solutions with HP and third-party tools that are installed with ALM on the
ALM Server.

ALM Extension Guides

Extensions provide added functionality to HP ALM. If you have a license for an ALM extension, you
can utilize the added functionality by enabling the extension on a per project basis. For details on
enabling extensions, refer to the HP Application Lifecycle Management Administrator Guide.

To view the list of extensions available with ALM 12.00, or to download documentation for ALM
extensions, visit the HP ALM Add-ins page, available from the HP Application Lifecycle
Management Add-ins page (Help > Add-ins).

HP ALM (12.00) Page 14 of 184
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Chapter 1: Introducing HP ALM

ALM helps you organize and manage all phases of the application lifecycle management process,
including defining releases, specifying requirements, planning tests, executing tests, and tracking
defects.

In this lesson, you will learn about:

The Application Lifecycle Management Process ... . ... 16
Starting ALM 16
ALM WINdOW 19
The Mercury Tours Sample Web Site ... ... 22
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The Application Lifecycle Management Process

The application lifecycle management process with ALM includes the following phases:

Rgl_e as_e Reqqirement Test Planning Test Execution Defect Tracking
Specifications Specifications
' Analysisi

Phase Description

Release Develop a release-cycle management plan to help you manage application
Specifications = releases and cycles efficiently.

Requirement | Define requirements to meet your business and testing needs.
Specifications

Test Planning = Based on the project requirements, you can build test plans and design tests.

Test Create a subset of the tests in your project designed to achieve specific test
Execution goals. Execute scheduled tests to diagnose and resolve problems.

Defect Submit defects and track their repair progress.

Tracking

Throughout the process, you can generate reports and graphs to assist you in “go/no-go” decisions
about your application readiness.

Starting ALM

Start ALM from your Web browser using the HP ALM URL.
To start ALM:

1. Verify tutorial prerequisites.

Before you begin the lessons in this tutorial, verify that you have the appropriate prerequisites.
For more information, see "Before You Begin" on page 7.

2. Open the Application Lifecycle Management Options window.

HP ALM (12.00) Page 16 of 184
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Open your Web browser and type your ALM URL:

http://<ALM server name>[<:port number>]/qcbin. Contact your system administrator if you do
not have the correct path.

The HP Application Lifecycle Management Options window opens.

@ Application Lifecycle Management

= ALMDesktop Client &
= ALMWeb Client

= Lab Management &

= SampleProjects &

= MyPerformance Center
= Site Administration

= Tools

3. Open ALM.

Each time ALM is run, it checks the version. If it detects a newer version, it downloads the
necessary files to your machine.

Note:

= Windows 7/8/2008R2/2012: If you do not have administrator privileges on your
machine, and a Security Warning displays, click Don’t Install. You will be redirected to
the Install screen.

= [f file downloads are prohibited by your browser, you can install these files by using the
HP ALM Client MSI Generator Add-in on the More HP Application Lifecycle
Management Add-ins page. For more information on add-ins, refer to the HP Application
Lifecycle Management Installation Guide.

HP ALM (12.00) Page 17 of 184
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The ALM Login window opens.

@ Application Lifecycle Management

Name:

Password:

Domain:

Project:
r

Note: If ALM was configured for external authentication, the Name and Password fields
do not appear in this window. Continue with step 5.

4. Type auser name and authenticate.
In the Login Name box, type alex_alm.
Skip the Password box. A password was not assigned.

Click the Authenticate button. ALM verifies your user name and password and determines
which domains and projects you can access.

5. Loginto the project.
In the Domain list, select DEFAULT.

In the Project list, select ALM_Demo. If more than one ALM_Demo project is listed, contact
your ALM site administrator to determine which project to use.

Click the Login button.

The first time you run ALM, the Welcome page opens. From the Welcome page, you can
directly access the ALM documentation and feature movies.

When you log in to a project, the ALM main window opens and displays the module in which

you were last working. In the upper-right corner of the window, the domain name, project name,
and your user name are displayed.
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ALM Window

In this exercise, you will explore the ALM modules and their common elements. You will also learn

how to navigate the online help.

To explore the ALM window:

1. Explore the ALM modules.

Click the following sidebar buttons:

Button

£

(v] Dashboard

£

I Management

£

] Requirements

HP ALM (12.00)

Description

Includes the following modules:

= Analysis View. Enables you to create graphs and
reports.

= Dashboard View. Enables you to create
dashboard pages, in which you can view multiple
graphs in a single display.

Includes the following modules:

= Releases. Enables you to define releases and
cycles for the application management process.

» Libraries. Enables you to define libraries to track
changes in your project, reuse entities in a project,
or share entities across multiple projects.

Includes the following modules:

= Requirements. Enables you to manage
requirements in a hierarchical tree-structure.
Requirements can be linked to other requirements,
tests, or defects.

= Business Models. Enables you to import
business process models, and test the quality of
the models and their components. Access to this
module is dependent on your ALM license.
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Button Description

Includes the following modules:

£

I R
&y Testing

= Test Resources. Enables you to manage test
resources in a hierarchical tree-structure. Test
resources can be associated with tests.

= Business Components. Depending on your ALM
license, you may also have access to the
Business Components module. This module
enables subject matter experts to drive the quality
optimization process using Business Process
Testing, the HP test automation solution. For more
information, refer to the HP Business Process
Testing User Guide.

= Test Plan. Enables you to develop and manage
tests in a hierarchical tree-structure. Tests can be
linked to requirements and defects.

= Test Lab. Enables you to manage and run tests.
After running tests, you can analyze the results.

= Test Runs. Enables you to view the results of
executed tests.

Enables you to add defects, determine repair

B! Defects o .
priorities, repair open defects, and analyze the data.

2. Explore the common ALMelements.
All the ALM modules have common elements. For example, click the Defects sidebar button.
Each of the ALM modules contains the following key elements:

= ALM common toolbar. This toolbar is accessible from all modules and contains the
following buttons:

Button Description

Navigates to your previous/next view in ALM.

{j' g Provides commands that you can run from each of the ALM modules.
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Button Description

Help Enables you to open the HP ALM online help and additional online
resources. It also enables you to display version information for each ALM
client component. For more information, see "ALM Help" on page 9 and
"Additional Online Resources" on page 13.

<domain, Details of the current domain, project, and user.
project,
user>

Logout Logs you out of your current project and returns you to the Application
Lifecycle Management Login window.

= Module menu bar. Displays the menus from which you select commands in the current
ALM module.

= Module toolbar. This is located below the menu bar. It contains buttons for frequently used
commands in the current ALM module.

3. View ALM help topics.
a. Toview the help topic of the Defects module window, click the Defects sidebar button. The
Defects module is displayed. Click 0 . The help topic opens in a separate window.

b. To view the Application Lifecycle Management Documentation Library home page, in the
Contents tab, click Home. The ALMhome page opens.

@ Application Lifecycle Management « » [ 8 & # @

[) Home Send documentation feedbackto HP
[) What's New Home

[ Getting Started

i ALV User Guide HP ALM Help

il ALV Administrator Guide

i ALM Lab Management Guide . .
Show Me How Movies

M ALM Business Views Microsoft Excel A Getting Started <\ Key Tasks

[1) ALM Extension Guides What's New in version 12:00 ‘ How to Display ALM Data How to Build a Filter

M Business Process Testing User Guide

w w
B8 Performance Center Guide ALM at a Glance How fo Use Releases and Cycles Bg;EELESChECK for Duplicate
[) Best Practices Guides ALM Tutorial How to Create Requirement and
[] API References Test Coverage How to Create Requirement 3
Performance Center Quick Start Coverage
[ Troublesheoting Guides How to Track Defects
[ Installation Guides ALM Help Guides How to Create Test Coverage
How to Analyze Data
Searching and Navigating the How to Analyze Coverage
ALM Help How to Manage Projects in Site

Administration

How to Customize Projects
Other Resources

Expert Users How to Work with Lab
P Management Administration Proguct Manuals
Setting ALM Configuration Parameters HP Software Solutions and
)ik 9 9 How to Manage Lab Resources Integrations 4

Customizing Workflow How to Run Tests Software Patches

Getting Started with ALM Open Test ALM Enterprise Business

How to Plan Business Process

< m » Architecture Reference Tests and Flows Cummum(y
W contents
oo ‘ How to Design a Performance
O, Search Test
[ Glossa
L Y How to Conduct a Performance
% Favorites Test

The ALM Help consists of guides and references, available online, in PDF format, or both.
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c. Under the Contents tab, click the Using The ALM Help link. The HP ALM Help section
links to the key tasks, movies, and other resources.

d. Click the Close () button.

The Mercury Tours Sample Web Site

Mercury Tours is the sample Web application used in this tutorial. It simulates a Web-based
application for reserving flights, hotel rooms, car rentals, cruises, and vacation deals. Before
continuing with the tutorial, familiarize yourself with this application.

To explore Mercury Tours:

1. Open the Mercury Tours application.

Open a separate instance of your Web browser, and go to the following URL:
http://newtours.demoaut.com/

The Mercury Tours home page opens.

Flights

SIGN-ON

REGISTER | SUPPORT | CONTACT

Hotels
Car Rentals

Cruises
Destinations

Vacations

HP ALM (12.00)

This island is surrounded by coral reefs

taken up residence along maost of the
beachfronts on the southern coast, but
there are still undeveloped areas on the

interior is inhabited by nothing maore

offers guaranteed sunshine and is blessed
with beautiful beaches. Luxury resorts have

exposed narthern coast, and much of the

\__substantial than goats. J
l Specials | |
Atlanta to Las Vegas $398
Boston to San Fransisco $913
Los Angeles to Chicago $168
Mew York to Chicago $198
Phoenix to San Fransisco $213

|»

| Find A Flight |

Registered users can sign-in
here to find the lowest fare on

participating airlines.

I Dastinations I I

Find detailed
A infarmation about

S S your destination.

Read about our
featured vacation
destinations.

User Mame:

Password:

I Vacations I

&

I Ragistar I I
Register here to
@ Jain Mercury
Taurs!
| vLinks | | =
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2. Register with Mercury Tours.

a. Click Register. The Register page opens.

REGISTER

Flights To create your account, we'll need some basic information about you. This

information will be used to send reservation confirmation emails, mail tickets when
Car Rentals needed and contact you if your travel arrangements change. Please fill in the form
Tl completely.

Destinations
Contact Information

Vacations

First Name: |

"TM'. Last Name: |
VERSIODN Phone:l

Use Java sian

Email: I

Mailing Information

SAVINGS!

Address: |

|
ay: [

State/Province: |

Postal Code: I

Country: |UNITED STATES =l

User Information

User Name:

Passwaori:

Confirm Passwori:

b. Under User Information, enter any user name and password, and confirm your password.
(Other information is not required.)

c. Click Submit. Mercury Tours confirms your registration.

3. Logonto Mercury Tours.
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a. Click Sign-on. The

Sign-on page opens.

one cool summer XY

SIGN-ON | REGISTER | SUPPORT | CONTACT

SIGN-ON

|

Hotels

Car Rentals

Destinations
Vacations

Use

Flights Welcome back to Mercury Tours! Enter your user information to access the

member-only areas of this site. If you don't have a log-in, please fill out the

registration form.

User Hame: I

Password: |

b. Type your registered user name and password. Click Submit. The Flight Finder page

opens.

HP ALM (12.00)
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one cool summer X

SIGN-OFF | ITINERARY | PROFILE | SUFFORT | CONTACT

Flights Use our Flight Finder to search for the lowest fare on participating airlines. Once
Hotels you've booked your flight, don't forget to visit the Mercury Tours Hotel Finder to
reserve lodging in your destination city.

|FI.IGHT FINDER

Car Rentals

Cruises

Flight Details
Destinations

Type: @ Round Trip ' One Way
Passengers: IE,
Departing From: W
On: Im Iﬂ “iews Calendar |
Arriving In: Im
Returning: [May =] [21 7] __ View Celendar |

Vacations

HTML

Use Jawa

Preferences
Service Class: @& Economy class
" Business class
' First class

Airline: |Nc: Freference j

4. Reserve aflight.
Follow the on-screen instructions to reserve aflight.
5. End your Mercury Tours session.

Click Sign-off.
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You begin the application lifecycle management process by specifying releases and cycles. A
release represents a group of changes in one or more applications that will be available for
distribution at the same time. Each release can contain a number of cycles. A cycle represents a
development and QA cycle based on the project timeline. The releases and cycles have defined
start and end dates.

You can organize and track your upcoming releases by defining a hierarchical release tree
containing releases and cycles. In this lesson, you will add a release to an existing release tree, and
then add cycles to the release.

Note: This lesson is not available for HP ALM Essentials Edition.
In this lesson, you will learn about:

DefiningReleases and Cycles ...l 27

Viewing Releases and Cycles ... ... . . 28
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Defining Releases and Cycles

In this exercise, you will define a release and then add cycles to the release. Releases and cycles
each have start dates and end dates. The date range for a cycle must be contained within the date
range of the release.

To define a release and its cycles:

1.

4.

Open the ALM_Demo project.

If the ALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 16.

Display the Releases module.

On the ALM sidebar, under Management, select Releases.

Create a new release folder.

a.

In the releases tree, select the root Releases folder. Click the New Release Folder
button. The New Release Folder dialog box opens.

In the Release Folder Name box, type Service Packs.
Click OK. The Service Packs release folder is added to the releases tree.

In the Description box in the right pane, type the following description for the release
folder: This folder contains service pack releases.

Add arelease.

In the releases tree, make sure that the new Service Packs release folder is selected.
Click the New Release button. The New Release dialog box opens.
In the Name box, type Service Pack 1.

In the Start Date box, click the down arrow and select yesterday’s date. In the End Date
box, click the down arrow and select the date two months from today’s date.

In the Description box, type the following description for the release: This release is the
first service pack release.

Click OK. The Service Pack 1 release is added to the Service Packs release folder.
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5. Addacycletothe release.
a. Inthereleases tree, make sure that the Service Pack 1 release is selected.
b. Click the New Cycle button. The New Cycle dialog box opens.
c. Inthe Name box, type Cycle 1 - New Features.

d. Inthe Start Date box, click the down arrow and select yesterday’s date. In the End Date
box, click the down arrow and select the date a month from today’s date.

e. Inthe Description box, type the following description for the cycle: This cycle tests new
features added for this service pack.

f. Click OK. The Cycle 1 - New Features cycle is added to the Service Pack 1 release.
6. Add asecond cycle to the release.

a. Inthereleases tree, right-click the Service Pack 1 release and choose New Cycle. The
New Cycle dialog box opens.

b. Inthe Name box, type Cycle 2 - Full.

c. Inthe Start Date box, click the down arrow and select the date one month and a day from
today’s date. In the End Date box, click the down arrow and select the date two month
from today’s date.

d. Inthe Description box, type the following description for the cycle: This cycle fully tests
all application features.

e. Click OK. The Cycle 2 - Full cycle is added to the Service Pack 1 release.

Viewing Releases and Cycles

You can view the status of your releases and cycles. ALM shows a high-level overview of the
progress of the currently selected release or cycle. It also shows the number of defects opened
over the course of the currently selected release or cycle. You can also view the number of
outstanding defects.

In this exercise you will learn how to display the progress and graphs of a selected release and
cycle.

To view releases and cycles:
1. Make sure the Releases module is displayed.
On the ALM sidebar, under Management, select Releases.

2. Display the Progress graph for the Service Pack 1 release.
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In the releases tree, select the Service Pack 1 release, located in the Service Packs release
folder. In the right pane, click the Status tab. The Progress tab is displayed by default.

Progress  Quality

Total days in release:

Remaining days in release:

Total test instances for release:

Remaining test instances to run

Required execution rate (test instances/day)

Actual execution rate (test instances/day):

Coverage Progress

62
61 |

0  Elapsed
0
0.00 ‘
0.00

Days

Remaining

Test Instance Runs
N/A

0%
Cycle 1 - New Features
Cycle

v [l Assigned requirements ¥ Planned coverage

v/l Executed coverage

Cycle 2 - Full

/[l Passed coverage

The Progress tab displays the progress of the release based on requirement coverage, elapsed
and remaining time, and actual and remaining test instances to run. As you have not yet
created requirements or tests, the information in the Coverage Progress graph indicates 0%

progress.

Display the Progress graph for a cycle.

In the releases tree, select the Cycle 1 - New Features cycle, located in the Service Pack 1

release.

In the right pane, click the Progress tab. You can see that the information available is similar to
that available for the release, but at the cycle level. As in the case of the release, you have not
yet created requirements and tests, therefore the information in the Coverage Progress graph

indicates 0% progress.

HP ALM (12.00)
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Requirements describe in detail what needs to be solved or achieved to meet the objectives of your
application under development.

You define the requirements in ALM by creating a requirements tree in the Requirements module.
This is a hierarchically graphical representation of your requirements. You can group and sort
requirements in the tree, monitor the progress in meeting requirements, and generate detailed
reports and graphs.

In this lesson, you will create requirements in an existing requirements tree. You will then assign
the requirements to a cycle in the releases tree. You will also learn how to convert requirements to
tests.

In this lesson, you will learn about:

Defining Requirements ... .. ... 31
VieWing RequUIremMentS . 34
Converting Requirements to Tests ... ... 37

HP ALM (12.00) Page 30 of 184



Tutorial

Chapter 3: Specifying Requirements

Defining Requirements

In this exercise, you will define requirements for testing the functionality of reserving cruises in
Mercury Tours.

To define a requirement:

1.

Open the ALM_Demo project.

Display the Requirements module.

Create a new requirement.

Note: If you are using HP ALM Essentials Edition, multiple requirement types are not
supported. In addition, fields and commands related to cycles and releases are not available.

If the ALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 16.

a. Onthe ALM sidebar, under Requirements, select Requirements.
b. Choose View > Requirements Tree to display requirements in a tree.
Select the Mercury Tours Application requirement.

Expand the Requirements root requirement and select the Mercury Tours Application
requirement.

a. Click the New Requirement button. The New Requirement dialog box opens.

[£] New Requirement

S |

K| % EB

« Name:

& Details Details

A= Rich Text Author:

§ Attachments uthor: alex_alm ~
Creation Time:
Modified:
Priority: ~
Description = Comments
BI U AfE= =& eT™

=« Requirement Type: |@ Undefin [ v

Creation Date: v
Direct Cover.. v
Old Type (obs... v
Product: v

alE%aalm
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In the Name box, type Cruise Reservation.

In the Requirement Type box, select Functional. Each requirement belongs to a
requirement type. The requirement type to which a requirement belongs determines which
fields are available for the requirement. Your project administrator can modify existing
types and add new types.

Note: If you are using HP ALM Essentials Edition, ignore this step.

In the Details tab, type or select the following:
Priority: 4-Very High

Product: Mercury Tours Web Site

Click Submit.

Click Close to close the New Requirement dialog box. The Cruise Reservation
requirement is added to the requirements tree under the Mercury Tours Application
requirement.

5. Add the Cruise Search child requirement.

a.

In the requirements tree, make sure that the new Cruise Reservation requirement is
selected.

Click the New Requirement button to add a requirement below Cruise Reservation. The
New Requirement dialog box opens.

In the Name box, type Cruise Search.

In the Requirement Type box, select Functional.

Note: If you are using HP ALM Essentials Edition, ignore this step.

In the Details tab, type or select the following:
Priority: 4-Very High

Product: Mercury Tours Web Site

Click Submit.

Click Close to close the New Requirement dialog box. The Cruise Search requirement is
added as a child of the Cruise Reservation requirement.
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6. Add the Cruise Booking child requirement.
a. Inthe requirements tree, make sure that the Cruise Reservation requirement is selected.

b. Click the New Requirement button to add a requirement below Cruise Reservation. The
New Requirement dialog box opens.

c. Inthe Name box, type Cruise Booking.

d. Inthe Requirement Type box, select Functional.

Note: If you are using HP ALM Essentials Edition, ignore this step.

e. Inthe Details tab, type or select the following:
Priority: 4-Very High
Product: Mercury Tours Web Site

f. Click Submit.

g. Click Close to close the New Requirement dialog box. The Cruise Booking requirement
is added as a child of the Cruise Reservation requirement.

7. Assign the requirements to a cycle.

Note: If you are using HP ALM Essentials Edition, ignore this step.
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e.

In the requirements tree, select Cruise Reservation.

Choose Requirements > Assign to Cycle. The Select Cycles dialog box opens.

Select Cycles ﬁ

| S T- Q|»

+ B8 Mercury Tours Application
- Service Packs
v 2z Service Pack 1
v (2 Cycle 1 - New Features

(2 Cycle 2 - Full

h

Locate the Service Packs releases folder. Under Service Pack, select the check box for
the Cycle 1 - New Features cycle.

Click OK to close the releases tree.

Click Yes to assign the requirement and its sub-requirements to the cycle.

8. Assign additional requirements to a cycle.

Note: If you are using HP ALM Essentials Edition, ignore this step.

In the requirements tree, under Mercury Tours Application, select Online Travel
Booking Services.

Choose Requirements > Assign to Cycle. In the Select Cycles dialog box, locate the
Service Packs releases folder. Under Service Pack 1, select the check box for the Cycle
1 - New Features cycle. Click OK.

Version Control: If the Check Out dialog box opens, click OK.

Click Yes to assign the requirement and its sub-requirements to the cycle.

Viewing Requirements

You can change the way requirements are displayed. In this exercise, you will learn how to zoom in
and out of the requirements tree, rearrange the requirement order, and display and filter
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requirements in the requirements grid.

To view requirements:
1. Make sure the Requirements module is displayed.

a. If the Requirements module is not displayed, on the ALM sidebar, under Requirements,
select Requirements.

b. Choose View > Requirements Tree to display requirements in a tree..
2. Zoom in and out of the requirements tree.
a. Select Cruise Reservation in the requirements tree.

b. Tozoomin, click Zoom and choose Zoom In. The requirements tree displays only the
child requirements of Cruise Reservation.

Requirements Edit View Versions Favorites Analysis
EOX|UYCTBaxl*|m|p|aln-u B

Mo Filter Defined

Zoomed in to:

0@ mpP Name 4 Direct Cover... Author Req ID
% ) Cruise Search W Not Covered  alex_alm 366
% ) Cruise Booking W Mot Covered alex_alm 367

c. Toreverse the zoom-in action and display the entire requirements tree, click Zoom and
choose Zoom Out To Root.

3. Rearrange the order of requirements in the requirements tree.

ALM adds requirements to the requirements tree in order of creation. To rearrange the order,
select the Cruise Search requirement and click the Move Down button. The Cruise Search

requirement moves down below the Cruise Booking requirement.

4. View requirements in the requirements grid.

Choose View > Requirements Grid to display requirements in a flat nonhierarchical view.
Each line in the grid displays a separate requirement.
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5. Define afilter to view requirements created on a specific date.

a. Click the Filter button. The Filter dialog box opens.

-
Filter requirements

el

¥ |6y O

Na Filter Defined

Requirement Type:

Field Name

Filter | Cross Filter

Hide Risk-Based Quality Management fields

View Order | Group

£ Filter Condition

Author

Creation Date
Creation Time
Direct Cover Status
Modified

MName

0Old Type (obsolete)
Priority

Product

RBQM custom Risk

REQM custom failure probabili
RBQM custom Functional Com

b. Forthe Creation Date field, click the Filter Condition box. Click the down arrow button.
The Select Filter Condition dialog box opens, displaying today’s date in the calendar.

i N
Select Filter Condition o 35X
Condition: | 10/21/2013
[Today] = | |And -
< | oOctober, 2013 » | [Vesterday] [ |Or [
[PreviousWee| = || |(
[PreviousMon ) _
269 37? ; : 130 141 12 [PreviousYear | |Not 5
[Tomorrow] =
13 14 15 16 17 18 19 ||[Thisweek] < P
20 22 23 24 25 26 ||[ThisManthl | [>=
27 28 29 30 31 1 2 ||«[m | b <= v
3 4 5 6 7 8 9
e

c. Select the date on which you added requirements.
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d. Click OK to close the Select Filter Condition dialog box.
e. Click OK to apply your chosen filter.
f. The Requirements Grid displays the requirements you added.

Requirements Edit View Versions Favontes Analysis

X|Wa|Sr- (Mo 2 a|palE
Filter: Creation Date[10/20/2013]

Sl Req ID Name Direct Cowver... Author
=Yg
& 367 Q) Cruise Booking % Mot Covered alex_alm
& 366 Q) Cruise Search % Mot Covered alex_alm
365 @ Cruise Reservation % Mot Covered alex_alm

Converting Requirements to Tests

After you create the requirements tree, you can use the requirements as a basis for defining your
test plan tree in the Test Plan module.

You can use the Convert to Tests wizard to assist you when designing your test plan tree. The
wizard enables you to convert selected requirements or all requirements in the requirements tree to
subjects or tests in the test plan tree.

In this exercise, you will convert the Cruise Reservation requirement to a subject in the test plan
tree, and the child requirements of Cruise Reservation to tests in the Cruise Reservation subject
folder.

To convert a requirement to a test:
1. Make sure the Requirements module is displayed.

If the Requirements module is not displayed, on the ALM sidebar, under Requirements, select
Requirements.

2. Select arequirement.
a. Choose View > Requirements Tree to display requirements in a tree.
b. Inthe requirements tree, select Cruise Reservation.

3. Open the Convert to Tests wizard.
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Choose Requirements > Convert to Tests. The Step 1 dialog box opens.

Step 1 of 3: Select Automatic Conversion Method u
ic C ion Method
/
@ . E Reat
" . :Convert lowest child requirements to design steps. = [l Req?
Application & Py
Lifecycle e
Minagement Convert lowest child requirements to tests S Reat
Convert To Test = Elreqz
- [lgRen3
Convert all requirements to subjects E Rea
= E Req2
e Req3
Generate single test. SR
Ji& Reqgi
B Req2
~[2) Reg3
Add Test to Test Set
Keep current Reguirements filter
L = [ text> | Hep ]

4. Choose an automatic conversion method.

Select the second option, Convert lowest child requirements to tests, to convert the

selected requirement to a subject folder, and its subrequirements to tests.

5. Start the conversion process.

a. Click Next to begin converting the requirements. When the conversion process is
complete, the results are displayed in the Step 2 dialog box.
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Step 2 of 3: Manual Change Conversion
Auto Complete Children Legend
1 -
QD BhesB|E %
A ';a:m - Cruise Reservation
Management l-—'; Crurse Booking
Convert To Test L Cruise Search

v [oance | <o ] tor> | oo |

b. Click Next. The Step 3 dialog box opens.

Step 3 of 3: Select Destination Path g
@ Destination Subject Path
1}
Subject: I [~
A‘prplicatiun
Lifecycle
Management
Convert To Test

» [“cancet ] < pack | ey |

6. Choose the destination subject path.

a. Inthe Subject box, click the down arrow button. A dialog box displaying the test plan tree
opens.
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b. Inthe test plan tree, select the Cruises subject.

T

ruises
» B8 Flight Reservation
» Itinerary
» B8 Mercury Tours Site
» B Modeling
r B Payment Methods
» B8 Profiling

| 0k | Cancel | cexr [P

c. Click OK to close the Select Destination Subject dialog box. The Subject box now
indicates this test plan.

7. Finalize the conversion process.

Click Finish. The Required Test Fields dialog box opens and displays the missing required
fields of the Cruise Booking test.

8. Specify the required test fields.
a. Select the following:
Level: Basic
Priority: 4-Very High
Reviewed: Reviewed

b. Click OK. The Required Test Fields dialog box reopens and displays the missing required
fields of the Cruise Search test.

c. Select the same values entered for the Cruise Booking test. Click OK.
d. Click OK to close the Convert to Tests wizard.
9. View the tests in the test plan tree.
a. Onthe ALM sidebar, under Testing, select Test Plan.
b. Choose View > Test Plan Tree to display the test plan tree.

c. Expand Cruises. The test plan tree displays Cruise Reservation under Cruises.
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d. Expand Cruise Reservation. The test plan tree displays the Cruise Booking and Cruise
Search tests.

- Subject
»  JL Unattached
~ [ Cruises

+ [ Cruise Reservation

& & Cruise Booking
s 3 Cruise Search

£3 Flight Reservation

&3 ltinerary

£ Mercury Tours Site

£ Madeling

8 Payment Methods

&3 Profiling

* ¥ ¥ ¥ v ¥
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After you define your requirements, you need to determine your testing goal and outline the strategy
for achieving your goal.

After you determine your testing goal, you build a test plan tree, which hierarchically divides your
application into testing units, or subjects. For each subject in the test plan tree, you define tests that
contain steps. For each test step, you specify the actions to be performed on your application and
the expected result.

ALM enables you to use the same test to test different use-cases, each with its own test
configuration. Each test configuration uses a different set of data. You define the data by adding
test parameter values for each test configuration. A test parameter is a variable that can be
assigned a value.

When you create a test, a single test configuration with the same name as the test is created
simultaneously. You can create as many additional test configurations as needed.

It is essential that the tests in your test plan comply with your requirements. To help ensure
compliance throughout the application lifecycle management process, add coverage between tests
and requirements. For finer granularity, you add coverage between test configurations and
requirements.

In this lesson, you will learn about:

Developing a Test Plan Tree ... o e 43
Designing Test Steps ... . 44
Defining Test Parameters ... .. . . i 47
Defining Test Configurations . . ... . 50
Creating and Viewing Coverage ... .. .. .. 52

Creating Coverage ... il 53

ANalyzZing COVErage ... . o 55
CopYiNg Test StePS ... 58
Generating Automated Test SCriptS ... . 60
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Developing a Test Plan Tree

The typical application is too large to test as a whole. The Test Plan module enables you to divide
your application according to functionality. You divide your application into units, or subjects, by
creating a test plan tree. The test plan tree is a graphical representation of your test plan, displaying
your tests according to the hierarchical relationship of their functions. After you define subjects in
the tree, you decide which tests to create for each subject, and add them to the tree.

In this exercise, you will add a subject and a test to the test plan tree in the Test Plan module.

To develop a test plan tree:
1. Openthe ALM_Demo project.

If the ALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 16.

2. Display the Test Plan module.
On the ALM sidebar, under Testing, select Test Plan.
3. Add a subject folder to the test plan tree.

a. Select the Subject folder and click the New Folder button. The New Test Folder dialog
box opens.

b. Inthe Test Folder Name box, type Payment Methods. Click OK. The new folder is added
to the test plan tree.

c. Inthe Description tab in the right pane, type a description of the subject: This folder
contains tests that verify the payment methods.

4. Add atest to the subject folder.

a. Select the Payment Methods folder and click the New Test button. The New Test dialog
box opens.
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~
2L New Test l Bl X |
# | *® B | B UseDefaull Values @ Set Default Values
= Test Name: | B =Type: | & MANUAL ~
E Details Details
I Aftachments
=Level ~ = Priarity: ~
=Reviewed: ~ Creation Date: ~
Designer: alex_alm v Reviewer: ~
Status: Design v Version Numb...

Description | Comments

B I U Aay == S (e G HEY Qa =

b. Inthe Test Name box, type a name for the test: Credit Cards.
c. Inthe Type box, select MANUAL to create a manual test.
d. Inthe Details tab, select the following:
Level: Basic
Reviewed: Not Reviewed
Priority: 4-Very High
e. Inthe Description tab, type a description for the test: The test verifies credit card types.

f. Click OK. The new test is added to the test plan tree under the Payment Methods folder.

Name

- Subject

J, Unattached

ES Cruises

[E Flight Reservation

Bl itinerary

B Mercury Tours Site

B Modeling

3 Profiling

= Payment Methods
& 2 Credit Cards

div v = v =

Designing Test Steps

After you add a test to the test plan tree and define basic test information, you define test steps—
detailed, step-by-step instructions that specify how to execute the test. A step includes the actions
to be performed on your application and the expected results. You can create test steps for both
manual and automated tests. For manual tests, you complete test planning by designing the test
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steps. Using your plan, you can begin test execution immediately. For automated tests, you create
automated test scripts using HP testing tools, custom testing tools, or third-party testing tools.

In this exercise, you add test steps to the Credit Cards test. This test verifies the credit card type

used to book a flight.

To design a test step:

1. Make sure the Test Plan module is displayed.

If the Test Plan module is not displayed, on the ALM sidebar, under Testing, select Test Plan.

2. Display the Credit Cards test.

Expand the Payment Methods folder, and select the Credit Cards test.

3. Open the Design Step Details dialog box.

a. Click the Design Steps tab.

b. Click the New Step button. The Design Step Details dialog box opens.

[=! Design Step Details =X
Moo el PR %Q ¥ W
Step Name: | Step 1
[ Details Details
il Attachments
Description:
B I UA&yE§gE= o7 Ta q | @
Expected Result:
B I UAahy === o Ta a &|m

In the Step Name box, a step name is displayed. The default name is the sequential

number of the test step.

4. Define the first test step.

In the Design Step Details dialog box, type the following:

Step Name: Step 1: Log in to Mercury Tours.
Description:

1. Enter URL.
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2. Login.

Expected Result: Useris logged in to Mercury Tours.

5. Close the Design Step Details dialog box.

Click OK.

6. Add the remaining test steps.

For each of the following test steps, click the New Step button to open the Design Step Details
dialog box, type the required information, and click OK to close the Design Step Details dialog box:

Step Name

Step 2: Select aflight
destination.

Step 3: Enter departure and
return flight.

Step 4: Enter passenger
details.

Step 5: Enter credit card

details.

Step 6: Enter addresses.

Step 7: Complete the

purchase.

Step 8: Log out.

HP ALM (12.00)

Description

1. Click the Flights button.

2. Enterflight details and
preference.

3. Click Continue.

1. Select departure and return
flights.

2. Click Continue.

Enter first name, last name, and
meal preference.

1. Enter credit card type.
2. Enter credit card number.

3. Enter expiration date.

Enter billing and delivery
addresses.

Click Secure Purchase.

Click the Log Out button.

Expected Result

Flight details and preference
are entered.

The flights are selected.

Passenger details are
entered.

Credit card details are

entered.

Addresses are entered.

Purchase completed.

User logs out of Mercury
Tours.
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The Design Steps tab displays the design steps.

Details = ® Design Steps = ® Parameters Test Configurations = Aftachments = Reqg Coverage | Linked Defects

PSHR IO 0LF % mI AN

[} Step Name Description Expected Result
Step 1: Login to Mercury Tours 1. Enter URL. User is logged in to Mercury Tours.
2 Login.
Step 2: Select a flight. 1. Click the Flights button. Flight details and preference are
2. Enter flight details and entered.
preference.

3. Click Continue.

Step 3: Enter departure and 1. Select departure and return The flights are selected.
return flight. flights.
2. Click Continue.
Step 4: Enter passenger details Enter first name, last name, and Passenger details are entered
meal preference.
Step 5: Enter credit card details. 1. Enter credit card type. Credit card details are
2 Enter credit card number. entered.

3. Enter expiration date.

Step 6: Enter addresses. Enter billing and delivery Addresses are entered.
addresses.
Step 7: Complete the purchase. Click Secure Purchase. Purchase completed.
Step 8: Log out. Click the Log Out button. User logs out of Mercury
Tours.

Defining Test Parameters

To increase the flexibility of your tests, you can add parameters to your tests. This enables you to
run the same test repeatedly with different data each time.

When working with a manual test, you can add parameters to the design steps from within the test
or you can add parameters by calling them from other tests. This is useful if you have common
steps you often want to perform as part of other tests.

When working with an automated test, you can define parameters for a test script from within the
test or you can load parameters from a shared test resource file.

When defining a test configuration, you define data by setting test parameter values for each test
configuration.

In "Designing Test Steps" on page 44, you defined steps for the Credit Cards test. In this exercise,
you will add parameters to enhance this test.

To define test parameters:
1. Display the Parameters tab for the Credit Cards test.

a. Inthe test plan tree, expand the Payment Methods folder, and select the Credit Cards
test.

b. Click the Parameters tab.
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2. Add a parameter.

a. Click the New Parameter button. The Test Parameter Details dialog box opens.

! Test Parameter Details = & ]

Ba e %ka
« Parameter Name:
& Details Details

Mapping Statu... Order: 1

Default Value

BI UAMEE:= B aa @

ok ] Cancel | Help |

b. Type the following:

Parameter Name: Credit card type.

Default Value: American Express, Visa, or MasterCard.

c. Click OK to close the Test Parameter Details dialog box. The parameter is added to the

Parameters tab.

3. Add an additional parameter.

a. Click the New Parameter button. The Test Parameter Details dialog box opens.

b. Type the following:

Parameter Name: Credit card number.

Default Value:1111-2222-3333-4444.

c. Click OK to close the Test Parameter Details dialog box. The parameter is added to the

Parameters tab.

4. Assign parameters to the test steps.
a. Click the Design Steps tab.

b. Click the Description box of Step 5.
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c. Place the cursor after 1. Enter credit card type and click the Insert Parameter button. The

Parameters dialog box opens.

r

<P> Parameters

-

==y X

“% MNew Parameter T -| [} =& | & &
Sort By: Order[Ascending]
Used Parameter... Default Value Description
Credit card type  American Expre..
Credit card num.. 1111-2222-333..
Description = = Default Value
B I UAab= o Ta| 5 @ EHY| Q& @&

American Express, Visa, or MasterCard

<«

Place the cursor after 2. Enter credit card number and click the Insert Parameter button.

The Parameters dialog box opens. Select the Credit Card Number parameter. Click OK.

d. Select the Credit Card Type parameter. Click OK.
e.
f. The parameters are added to your design step.

Details = ® Design Steps " Parameters = Test Configurations = Attachments

EA A SN Y=
]

ama ‘e

Step Name Description
Step 1: Log in to Mercury 1. Enter URL.

Tours 2. Login.

Step 2: Select a flight. 1. Click the Flights button.
2. Enter flight details and
preference.

3. Click Continue.

Step 3: Enter departure
and return flight.

1. Select departure and return
flights.
2. Click Continue.

Step 4: Enter passenger
details

Enter first name, last name, and
meal preference.

Step 5: Enter credit card
details.

1.Enter credit card type. =<<Credit card type>>>
2 Enter credit card number. <<<Credit card number >=>>
3.Enter expiration date.

Enter billing and delivery
addresses.

Step B: Enter addresses.

Step 7: Complete the Click Secure Purchase.

purchase.

Step 8: Log out. Click the Log Out button.

HP ALM (12.00)

Req Coverage

Linked Defects  Dependencies

Expected Result
User is logged in to Mercury Tours.

Flight details and preference are
entered.

The flights are selected.

Passenger details are entered

Credit card details are
entered.

Addresses are entered.
Purchase completed.

User logs out of Mercury
Tours.
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Defining Test Configurations

You canreuse a test to test different use-cases. For each use-case you create a test configuration
that uses a different data set. When working with a manual test, the data set of a test configuration
contains values for your defined test parameters. When working with a UFT or a business process
test, the data set can use an external test resource file.

In the following exercise, you will create a test configuration for each of the following credit cards:
American Express, Visa, and MasterCard. You will then define the actual parameter values to be
used when running these instances.

To define test configurations:
1. Display the Test Configurations tab for the Credit Cards test.

a. Inthe test plan tree, expand the Payment Methods folder, and select the Credit Cards
test.

b. Click the Test Configurations tab.

Details | * Design Steps ® Parameters Test Configurations = Attachments = Req Coverage b

PRoOE MY

] 1D Name Created by Creation date  Execution...
1190 Credit Cards  alex_alm 10/21/2013 © No Run

Description = Dats = Aftachments | History ¥

BI UAdAahyEEZ == oTm9 @ B aa B

By default, ALM created the Credit Cards test configuration.
2. Rename the test configuration name to American Express.
a. Under Name, click Credit Cards. Type American Express.

b. Under Description, type: Test configuration for American Express.
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3. Assign data to the test configuration.

a.

b.

Click the Data tab.

Under Actual Value, click the top cell. Click the arrow and click in the box. Type: 2222-
3333-4444-5555. Click OK.

Under Actual Value, click the second cell. Click the arrow and click in the box. Type:
American Express. Click OK.

Description | Data | Attachments | History A

m 77} Copy Default Values <Py Update Selected Parameters =

Used Parameter Name Default Value Actual Value Source Test
v Credit card number. 1111-2222-3333-4444.  2222-3333-4444-555 Credit Cards
v Credit card type American Express, Visa,... American Express Credit Cards

4. Add anew test configuration for Visa.

a.

b.

Click the New Test Configuration button. The New Test Configuration dialog box opens.
Type the following:

Name: Visa

Description: Test configuration for Visa.

Click OK. The test configuration is added to the Test Configuration tab.

Make sure the Visa test configuration is selected.

Click the Data tab. Under Actual Value, click the top cell. Click the arrow and click in the
box. Type: 3333-4444-5555-6666. Click OK.

Under Actual Value, click the second cell. Click the arrow and click in the box. Type:
Visa. Click OK.

5. Add a new test configuration for MasterCard.

a.

b.

Click the New Test Configuration button. The New Test Configuration dialog box opens.
Type the following:

Name: MasterCard

Description: Test configuration for MasterCard.

Click OK. The test configuration is added to the Test Configuration tab.
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d. Make sure the MasterCard test configuration is selected.

e. Click the Data tab. Under Actual Value, click the top cell. Click the arrow and click in the
box. Type: 4444-5555-6666-7777. Click OK.

f. Under Actual Value, click the second cell. Click the arrow and click in the box. Type:
MasterCard. Click OK.

Details | ® Design Steps = ® Parameters | Attachments | ® Test Configurations Req Covern >

FXRSE DT

o Name Created by Creation date  Execution...
American Ex.. alex_alm 10/21/2013 © No Run
Visa alex_alm 10/21/2013 @ No Run
MasterCard alex_alm 10/21/2013 B No Run
Description | Data  Attachments = History ¥

Iy 22 Copy Default Values R Update Selected Parameters =

Used Parameter Name Default Value Actual Value Source Test
v Credit card number. 1111-2222-3333-4444.  4444-5555-6666-7777 Credit Cards
v Credit card type American Express, Visa,.. MasterCard Credit Cards

6. Version Control: Check in the test configurations.

Check in the test and its test configurations. In the test plan tree, rightclick the Credit Cards
test, and select Versions > Check In. Click OK to confirm.

Creating and Viewing Coverage

It is essential that the tests in your test plan comply with your requirements. To help ensure
compliance throughout the application lifecycle management process, you can add coverage
between your tests and requirements. You can also add coverage between test configurations and
requirements.

You can create coverage from the Test Plan module and the Requirements module. A test or a test
configuration can cover more than one requirement, and a requirement can be covered by more than
one test or test configuration.

In these exercises, you will learn about the following:

Creating Coverage ... il 53
Analyzing CoVerage ... il 55
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Creating Coverage

In this exercise, you will create the Credit Cards requirement and then create coverage by
associating it to the Credit Cards test.

To create coverage:
1. Display the Requirements module.
a. Onthe ALM sidebar, under Requirements, select Requirements.
b. Choose View > Requirement Details. The Requirement Details view is displayed.
2. Create the Credit Card requirement.
a. Select the Mercury Tours Application folder.

b. Click the New Folder button. In the New Requirement Folder dialog box, type: Payments.
Click OK.

c. Select the Payments folder and click the New Requirement button. The New
Requirement dialog box opens.

d. Inthe Name box, type Credit Cards.

e. Inthe Requirement Type box, select Functional.
Note: If you are using HP ALM Essentials Edition, ignore this step.

f. Click Submit. Click Close. The new requirement is added to the requirements tree.
3. Display the Test Coverage tab.
a. Inthe requirements tree, make sure that the Credit Cards requirement is selected.

b. Intheright pane, click the Test Coverage tab.
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4. Display the Test Plan Tree pane.

Click the Select Tests button to show the test plan tree on the right.

Requirements Edit View Wersions Favorites Analysis

EEX g Sov-00a 2 =& -v- B 1 Requirement is checked out by alex_alm ’_’
No Filter Defined Details | Rich Text | Attachments | Linked Defects  Requirement Tracea.. Test Coverage Bu =
Name

s % | Status Filter: Al v|g v- 7| TestPlanTree

-~ [EJRequirements —
+ B Business Models Coverage Type Entity Name Coverage Status | <3| E 53| & Q T -3

+ [ EMercury Tours Applic . Subject

+ [ Online Travel Boo > I Unatiached
» [l Online Travel Info R @ .
+ [ Profile Manageme & Cruises
+ & Reservation Mang + B Flight Reservation
» [l Booking System + & Itinerary
+ [ Application Securi + & Mercury Tours Site
+ [ Application Usabili + B Modeling
» [l Application Client - Payment Methods
» [ Application Perfori E» Credit Cards
» @ Cruise Reservatio » &5 Profiling
M P_ﬁymenls Test Configurations %
® ¢ Credit Cards
+ [ Assemble order AoV
4 Caontract processing No Filter Defined
Name Test Name

American Express Credit Cards
Visa Credit Cards
MasterCard Credit Cards

5. Select the Credit Cards test in the test plan tree.

a. Inthe Test Plan Tree pane, expand the Payment Methods folder, and select the Credit
Cards test.

b. If the Test Configurations pane is not displayed, click the Show button on the bottom of the
pane. Under the Test Configurations pane, you can see that the test contains three test
configurations.

6. Add the test to the coverage grid.

Inthe Test Plan Tree pane, click the Add to Coverage button. The Credit Cards test is added
to the coverage grid.

7. Display the Test Configuration Status tab.

Click the Test Configuration Status tab.
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The Test Configuration Status tab shows the associated test configurations and their status.

Requirements Edit View Versions Favortes Analysis

)

EEOX Y ST 00L&l =~k & fy-BE 1 Requirement is checked out by alex_alm 7
No Filter Defined Details | Rich Text | Attachments | Linked Defects | Requirement Tracea..| ® TestCoverage [ 2
Name »| TestPlan T
s T | Status Filter: Al v| 8 T~ estrlan free
+ [ Requirements N " =~ -
» [ Business Models Coverage Type Entity Name Coverage Status | | 5 75 & Q T3
- Mercury Tours Applic| Test By Credit Car . @ No Run

- Subject

» [l Online Travel Boo > I Unattached
» [& Online Travel Info
» & Profile Manageme " i Cruises
»  [&l Reservation Mang > & Flight Reservatian
+  [& Booking System * (& tinerary
» [ Application Securi » B Mercury Tours Site
+ [&l Application Usabili r Madeling
» [l Application Client - 5 Payment Methods
+ [&l Application Perfon Z» Credit Cards
»  Q Cruise Reservatio r Praofiling
- Ftayments Test Configurations ¥
wQ i
N Asszmir‘:d:r;:eﬁrrds Coverage Chart  Test Configuration St.. v A e T-
+ [ Contract processing No Filter Defined
%0
Name Test Name
Name Description Status American Express  Credit Cards
American Ex.. Testconfigur.. © No Run Visa Credit Cards
Visa Test configur.. © No Run MasterCard Credit Cards

MasterCard  Testconfigur.. © No Run

Tip: To add selected configurations of a test to the requirement's test coverage, add
coverage from the Test Configurations pane.

8. Hide the test plan tree.
Click the Close button above the tests plan tree.
9. Version Control: Check in the Payments folder and the Credit Cards requirement.

a. Inthe test plan tree, right-click the Payments folder, and select Versions > Check In.
Click OK to confirm.

b. Right-click the Credit Cards requirement, and select Versions > Check In. Click OK to
confirm.

Analyzing Coverage

After you create test coverage, you can use the Coverage Analysis view in the Requirements
module to analyze the breakdown of child requirements according to test coverage.

In this exercise, you will analyze the Application Client System requirement.
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To analyze test coverage:

1. Make sure that the Requirements module is displayed.

If the Requirements module is not displayed, on the ALM sidebar, under Requirements, select
Requirements.

2. Display the requirements tree in Coverage Analysis view.

Choose View > Coverage Analysis. The Coverage Analysis view is displayed.

3. Display the Application Client System requirement in Coverage Analysis view.

a. If any filters are applied, click the Filter arrow and choose Clear Filter/Sort. Click Yes to
confirm.

b. Under the Mercury Tours Application requirement, expand the Application Client
System requirement and its children.

Requiements Edit View Versions Favorites Analysis

[FRER LI AN

No Filter Defined

Name

- Requirements

“

v v T

3
3

»

»

5 Business Models
= Mercury Tours Application

i1 Online Travel Booking Services
] Online Travel Information Source
[ Profile Management
ISl Reservation Management
] Booking System
(2] Application Security
5] Application Usability
[Z] Application Client System
{2l Hardware
i1} Software
2] Application Performance
@ Cruise Reservation
Payments.

3@ plala-o @

4 Direct Cover...

W Not Covered
¥ Not Covered

W Not Covered

Coverage analysis last calculstion time: 10/22/2013 8:39:34 AM

Description Comments = Rich Text Attachments = Histary

Coverage Analysis

Coveraae analvsis m

O Blocked @ Failed O MNoRun O NotCompleted O Not Covered O Passed X

118

&l

45

e

66

In the Coverage Analysis column, you can see graphically the number of child
requirements that have a direct cover status and those that are not yet covered.

4. Display coverage analysis for the Application Client System requirement.

Right-click the Application Client System requirement, and choose Coverage Analysis.
The Coverage Analysis dialog box opens.
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[ Coverage Analysis ﬁ

This graph displays the coverage status for requirement
230 - Application Client System
and its children according to the cument fitter.
Click a group in the graph to display its list of requirements.
2 Failed
[ | ]
14 Mot Covered
Copy to Clipboard Show Test Coverage ¥

5. Display the child requirements with a “Failed” status.

Click the red Failed area of the graph. The child requirements with a “Failed” status are
listed....

- ™
[l Coverage Analysis ﬁ

This graph displays the coverage status for requirement

230 - Application Client System

and its children according to the cument fiter.

Click a group in the araph to display its list of requiremenrts.

“ D Failed Requirements:

237 Size

238 Resolution

Copy to Clipboard Show Test Coverage ¥
o

6. Display test coverage for the requirement.

a. Click the Show Test Coverage link to extend the Coverage Analysis dialog box and
display the Test Coverage Chart.
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[l4 Coverage Analysis ﬁ

This graph displays the coverage status for requirement
230 - Application Client System

and its children according to the cument fitter.

Click a group in the graph to display its list of requirements.

2 Failed

I I |
14 Mot Covered

Copy to Clipboard Hide Test Coverage #

Test Coverage Chart
This graph displays the test status for requirement
230 - Application Cliert System
Click a group in the graph to display its list of tests.

6 Passed L -
- N

[J 2 Mo Run 18.18 % [ & Passed 54.55 %
[0 3 Failed 27.27 %

3 Failed

L

This pie chart graphically displays the full test coverage for the requirement, grouped
according to test status.

b. Click the Passed section of the chart to open the Tests Coverage dialog box and display
the list of tests with the selected status. Close the Test Coverage dialog box.

7. Close the Coverage Analysis dialog box.

Click the Close button.

Copying Test Steps

You can copy steps from another test in the same project or from a different project. In this
exercise, you will copy the test steps from the HTML Page Layout test and paste theminto a
newly created test.
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To copy a test step:
1. Display the Test Plan module.
a. Onthe ALM sidebar, under Testing, select Test Plan.
b. If the test plan tree view is not displayed, select View > Test Plan Tree.
2. Create anew test.
a. Inthe test plan tree, expand the Mercury Tours Site folder.

b. Select the HTML Pages folder and click the New Test button. The New Test dialog box
opens.

c. Inthe Test Name box, type a name for the test: New HTML Page Layout.
d. Inthe Type box, select MANUAL to create a manual test.
e. Inthe Details tab, select the following:
Level: Basic
Reviewed: Not Reviewed
Priority: 4-Very High
f. Click OK. The new test is added to the test plan tree under the HTML Pages folder.
3. Display the Design Steps tab for the HTML Page Layout test.
a. Inthe HTML Pages folder, select the HTML Page Layout test.
b. Click the Design Steps tab.
4. Select the steps that you want to copy.

Position the mouse pointer in the gray sidebar on the left. The mouse pointer changes to a
pointing hand. Select all rows.
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PLEIX MO0 LT QA RE A"

1] Step Name
Page Title

Page Text

Forms

Navigation Bars

Links

Company Logo

Graphics

Versioning

Screen Area Definitions
Compatibility
Page Length

Description

Verify the Web page title shown in the title of the browser
window.

Check the text paragraphs on the page.

Check the forms on the page:

- Input fields

- Lists

Verify the navigation bars on the page.

Check the links on the page: - text links - graphics links

Verify the company logo.

Check page graphics: - graphic buttons - banners -
advertisements - other images

Verify the version information of the page.

Verify the page on different screen area definitions:

& 640 x 480 pixels
Verify the length of the page and accessibility of the page
contents according to their importance.

5. Copy the selected steps.

Click the Copy Steps button.

6. Paste the steps into the New HTML Page Layout test.

Expected Result

_ Page should have title.

. The title should be descriptive
Different title on each page
should be used.

. Text paragraphs should be left
aligned.
Recurrina text should annearin - 4
. The input fields should be left
aligned.
. The set of input fields should be
. Allitems in the left-side
navigation bar should be left
aligned.
. All items in the top navigation
har chnnld ha rantar alianad 4
. Alllinks should be underlined.
Link labels should be
descriptive.
Company logo should be
presented on each page.
Company logo should be in a
consistent position on all pages.

. All graphic objects should have
correct horizontal and vertical
alignment.

Recurring graphics should
Each page should contain the
following versioning information:

# Company name
& Date of last update

&  Gita varcinn 4

The page should be shown correctly for
,each of these screen area definitions.
‘The most important information
should be located at the top part
of the page, so it can be
accessed immediately, without

4

a. Inthe test plan tree, select the New HTML Page Layout test.

b. Inthe Design Steps tab, click the Paste Steps button. The test steps are copied to the
Design Steps tab.

Generating Automated Test Scripts

Test planning involves deciding which tests to automate. If you choose to execute tests manually,
the tests are ready for execution as soon as you define the test steps. If you choose to automate
tests, you can generate test scripts and complete them using other HP testing tools (for example,

UFT).

Consider these issues when deciding whether to automate a test.

Do Automate

Do Not Automate

Tests that run with each new version of your application to check = Tests that are executed only

the stability of basic functionality across the entire application

(regression tests).
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Do Automate Do Not Automate

Tests that use multiple data values for the same operation (data- = Tests that require immediate
driven tests). execution.

Tests that are run many times (stress tests) and tests that check = Tests that check how easy
a multi-user client/server system (load tests). the application is to use
(usability tests).

Tests that do not have
predictable results.

In this exercise, you will generate a UFT test script for the Address Options test.
Note: For prerequisites to working with a UFT test, see "Before You Begin" on page 7.

To generate an automated test script:
1. Make sure the test plan tree view is displayed.
If the test plan tree view is not displayed, select View > Test Plan Tree.
2. Locate the Address Options manual test.

a. Select the Subject folder at the root of the test plan tree and choose Edit > Find. The Find
dialog box opens.

b. InValue To Find, type Book.
c. Inthe Search for, select Folders.
d. Click Find. The Search Results dialog box opens and displays a list of possible matches.

e. Double-click the Flight Reservation\Book Flight folder to highlight the folder in the test
plan tree. Click Close to close the Search Results dialog box.

f. Inthe test plan tree, expand the Book Flight folder and select the Address Options test.
3. Display the Design Steps tab.

In the right pane, click the Design Steps tab.
4. Generate a test script.

a. Click the Generate Script button.

b. Choose QUICKTEST_TEST to generate a UFT test.

c. Version Control: If a check out message box opens, click OK.
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The steps in the Address Options test are used to create the automated test script.

5. View the test script.

a. Click the Test Script tab.

b. Todisplay and modify your test script in UFT, click the Launch Unified Functional
Testing button.
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Throughout the application lifecycle management process, you can run automated and manual
tests to locate defects and assess the quality of your application.

You start by creating test sets and choosing which tests to include in each set. A test set contains
a subset of the tests in an ALM project designed to achieve specific test goals.

After you define test sets, you can begin to execute your tests. Some tests can be run
automatically and some can be run manually.

When you run a test automatically, ALM opens the selected testing tool, which runs the test, and
imports the test results to ALM.

When you run a test manually, you execute the test steps you defined in test planning. You pass or
fail each step, depending on whether the actual results match the expected output.

If you are using ALM Edition with the Lab Management extension enabled, you can use server-
side execution to reserve testing resources for automated tests. Server-side execution occurs on
remote testing hosts, can be scheduled or immediate, and does not require user intervention.

ALM enables you to control the execution of tests in a test set by setting conditions and scheduling
the date and time for executing your tests.

After test execution, you can use ALM to view and analyze the results of your tests.

In this lesson, you will learn about:

TSt Set TYPOS ..o 64
DefiNiNg TeSt SetS . L 65
Defining a Functional Test Set ... ... 65
Defininga Default Test Set ... o 69
Adding Tests toa Test Set .. 74
Adding Tests toa Functional Test Set ... . ... .. .. 74
Adding Tests toa Default Test Set ... L 75
Defining a Build Verification Suite ... .. 78
Setting Schedules and Conditions for Test Runs ... ... . ... 80
RUNNING T @SS 85
Running Tests ina Functional Test Set ... .. 85
Running a Functional Test Setinthe TestLabmodule ...... ... .. ........................... 86
Scheduling a Functional Test Set in the Timeslots Module ... ... ............. 87
Running Tests ina Default Test Set Manually ....... . ... ... ... 89
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Running with Manual Runner . ... e 93
Running Tests in a Default Test Set Automatically ... ... ... . ... 97
Viewing and Analyzing Test Results ... . ... 98
Viewing Test Results inthe Test RunsModule ............. . ... 99
Viewing Functional Test Set Results inthe Test SetRuns Tab ... ... ............ 99
Viewing Test Results inthe Test Runs Tab ... ... 100
Viewing Test Results in the Test Instance Properties DialogBox _.._........................ 101
Viewing Test CoVerage ... ..o oo 103
Viewing Coverage Progress .. ... il 106

Test Set Types

After you design tests in the Test Plan module, you create a test sets tree in the Test Lab module. A
test sets tree enables you to organize your testing needs by grouping test sets in folders and
organizing them in different hierarchical levels in the Test Lab module. You assign each test set
folder to a cycle. This enables you to group together test sets that will be run during the same cycle
and analyze the progress of the cycle as you run your tests.

When defining a test set, you add instances of your selected tests to the test set. Each test
instance contains a defined test configuration.

ALM provides the following types of test sets:

« Functional test sets include automatic tests that check the application under test functions as
expected. Tests in a Functional test set are scheduled in a timeslot to run on a server, without
requiring user supervision. Available for: ALM Edition with the Lab Management Extension
enabled.

o Default test sets can include automatic and manual tests, and are used to check that the
application under test functions as expected. Tests in a Default test set are controlled from the
user's machine and require the supervision of the tester.

« Performance test sets include performance tests which check that the application under test
can withstand load and demand. Tests in a Performance test set are scheduled in a timeslot to
run on a server, without requiring user supervision. Available for: ALM Edition and Performance
Center Edition only.

Note: For the purposes of this tutorial, we will only use Functional and Default test sets. The
usage of Performance tests is covered in HP ALM Performance Center Quick Start.

To decide which types of test sets to create, consider the goals you defined at the beginning of the
application lifecycle management process.
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When creating and combining different groups of test sets, consider issues such as the current
state of the application and the addition or modification of new features. Following are examples of
general categories of test sets you can create:

Test Set Description

Sanity Checks entire application at a basic level—focusing on breadth, rather than
depth—to verify that the application is functional and stable. This set includes
fundamental tests that contain positive checks, validating that the application is
functioning properly. For example, in the Mercury Tours application, you could test
whether the application opens and enables you to log in.

Regression = Tests the system in a more in-depth manner than a sanity set. This set caninclude
both positive and negative checks. Negative tests attempt to fail an application to
demonstrate that the application is not functioning properly.

Advanced @ Tests both breadth and depth. This set covers the entire application, and also tests
the application’s advanced options. You can run this set when there is ample time
for testing.

Function Tests a subsystem of an application. This could be a single feature or a group of
features. For example, in the Mercury Tours application, a function set could test
all activities related to booking a flight.

Defining Test Sets

In this exercise, you will define the Mercury Tours Site test set. You will also set failure rules for the
test set to instruct ALM how to proceed in the event that an automated test in the test set fails.
Depending on whether you are an ALM Edition user, you can either define a Functional test set or a
Default test set.

Note:

e If you are using ALM Edition with the Lab Management extension enabled, define a
Functional test set. See "Defining a Functional Test Set" below.

e If you are not using ALM Edition with Lab Management, define a Default test set. See
"Defining a Default Test Set" on page 69.

Defining a Functional Test Set

Functional test sets contain automatic tests. Tests in a Functional test set run using automated
server-side execution.
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To define a Functional test set:
1. Display the Test Lab module.
On the ALM sidebar, under Testing, select Test Lab.
2. Add afolder to the test sets tree.
a. Inthe test sets tree in the left pane, select the Root folder.
b. Click the New Folder button. The New Test Set Folder dialog box opens.
c. Inthe Folder Name box, type Service Pack 1 and click OK.
3. Create subfolders for the test set folder.

Select the Service Pack 1 folder and repeat the previous step to create two subfolders, named
Cycle 1-New Features, and Cycle 2 - Full.

4. Assign the test set folders to a cycle.

a. Right-click the Cycle 1 - New Features test set folder and select the Assign to Cycle
button. The Select Cycles dialog box opens.

b. Expand the Service Packs releases folder. In the Service Pack 1 release, select the
Cycle 1 - New Features cycle (created in Lesson 2, "Specifying Releases and Cycles" on
page 26).

c. Click OK. The icon for the folder in the test sets tree changes to show that the folder has
been assigned to a cycle.

- Root

r JL Unattached

* B3 BPT tests (Flight)

r Mercury Tours Web Site

r Madeling

r Release 10.5

- Service Pack 1
» % iCycle 1 - New Features
* E3 Cycle 2 - Full

d. Right-click the Cycle 2 - Full test sets folder and choose Assign to Cycle. Assign the
folder to the Cycle 2 - Full cycle, located in the Service Pack 1 release in the releases
tree.

5. Add atest set tothe Cycle 1 - New Features test set folder.
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a. Inthe test sets tree, select Cycle 1- New Features.

b. Click the New Test Set button. The New Test Set dialog box opens.

L, New Test Set S
®| % E:H
«MName: Type: |Jil, Default ~
& Details Details
I Attachments
Baseline: v Close Date: ~
Modified: Open Date: ~
Status: v Target Cycle:
Test SetFold_. | Cycle 1- New Feat [
Description
BI UAahy=i= = =|eT 1 & BY aa @
ok | close | Help |

c. Enterthe following:

Name: Mercury Tours Site

Description: This test set includes automatic tests that run on remote testing hosts and
verify the functionality of the Mercury Tours site.

d. Select Functional in the Type field.

e. Click OK. The Mercury Tours Site test set is added to the test sets tree in the left pane.

6. Define the Mercury Tours Site test set details.

a. Click the test set in the test sets tree. The Execution Grid tab is displayed. Click on the

Details tab.
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Details

=MName:
Close Date:
Open Date:
Target Cycle:

Test Set ID:

Description

BI UAah

Execution Grid

Requested Hosts

Mercury Tours Site

v
10/22/2013 v
Cycle 1 - New Features

312

of the Mercury Tours site.

b. Select the following:

Execution Flow

Baseline:
Modified:
Status:

Test Set Folder:

Type:

ol e

Automation

Q4 @®

This test set includes automatic tests that run on remote testing hosts and verify the functionality

Attachments

v
10/22/2013 1:27:43 PM
Open v
Cycle 1 - New Features

Z Functional

Open Date: Select a date from the calendar for the planned opening date for the test set.

Today's date is selected by default.

Close Date: Select the planned closing date for the test set.

7. Set rules for the automated tests in the test set in the event of a test failure.
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a. Click the Automation tab.

Details Execution Grd Reguested Hosts Execution Flow Automation Attachments Linked Defects History
——
On Automated Test Failure
Rerun test
Maximum test reruns:

Cleanup test before rerun:

Settings per test...

Notification
Send email in the event of any test with status "Failed”

B I U Azl

e Ta 2 H % a

Execution Summary

Send summary of results sfter test set execution

b. Inthe On Automatic Test Failure section, perform the following:
o Select the Rerun test check box.
o Set Maximum test reruns to 1.
8. Instruct ALM to send an email to specific users if certain events occur.
Under Notification, perform the following:
a. Select the check box to send an email notification if any test in the test set fails.
b. To: Enter your email address.
c. Message: Type the following:

This test failed. Please review the test results and submit a defect.

Defining a Default Test Set

Default test sets contain automatic and manual tests. You start and control tests in a Default test
set using your local machine.

Note: In this exercise, you define a Default test set. If you are using ALM Edition with Lab
Management enabled, you already defined a Functional test set. You can proceed to "Adding
Tests to a Test Set" on page 74.
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To define a Default test set:

1. Display the Test Lab module.
On the ALM sidebar, under Testing, select Test Lab.

2. Add afolder to the test sets tree.
a. Inthe test sets tree in the left pane, select the Root folder.
b. Click the New Folder button. The New Test Set Folder dialog box opens.
c. Inthe Folder Name box, type Service Pack 1 and click OK.

3. Create subfolders for the test set folder.

Select the Service Pack 1 folder and repeat the previous step to create two subfolders, named
Cycle 1-New Features, and Cycle 2 - Full.

4. Assign the test set folders to a cycle.

Note: If you are using HP ALM Essentials Edition, fields and commands related to cycles
and releases are not available. Proceed to the next step.

a. Right-click the Cycle 1 - New Features test set folder and select the Assign to Cycle
button. The Select Cycles dialog box opens.

b. Expand the Service Packs releases folder. In the Service Pack 1 release, select the
Cycle 1 - New Features cycle (created in Lesson 2, "Specifying Releases and Cycles" on
page 26).

c. Click OK. The icon for the folder in the test sets tree changes to show that the folder has
been assigned to a cycle.

- Root

r JL Unattached

* B3 BPT tests (Flight)

r Mercury Tours Web Site

r Madeling

r Release 10.5

- Service Pack 1
» % iCycle 1 - New Features
* E3 Cycle 2 - Full

d. Right-click the Cycle 2 - Full test sets folder and choose Assign to Cycle. Assign the
folder to the Cycle 2 - Full cycle, located in the Service Pack 1 release in the releases
tree.
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5. Add atest set to the Cycle 1 - New Features test set folder.

a. Inthe test sets tree, select Cycle 1- New Features.

b. Click the New Test Set button. The New Test Set dialog box opens.

JI, New Test Set

) [ |

% |96 T
= Mame:

& Details
Il Attachments

Details

Baseline: -
Modified:
Status: ~

Test SetFold.. | Cycle 1- New Feat 2]

Description

BI UAah

[

H = | T Ta

Type: | /I, Default

Close Date:
Open Date:

Target Cycle:

G HY aa @

c. Enterthe following:

Name: Mercury Tours Site

Description: This test set includes automatic and manual tests that verify the functionality

of the Mercury Tours site.

d. Select Defaultin the Type field.

e. Click OK. The Mercury Tours Site test set is added to the test sets tree in the left pane.

6. Define the Mercury Tours Site test set details.

a. Click the test set in the test sets tree. The Execution Grid tab is displayed. Click on the

Details tab.
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Details | Execution Grid | Execution Flow | Attachments | Automation | Linked Defects >

= Name: Mercury Tours Site Baseline: v
Close Date: v Modified: 10/22/2013 12:05:26 [
Open Date: 10/22/2013 v Status: Open h
Target Cycle: Cycle 1 - New Features Test Set Folder: | Cycle 1 - New Features
Test Sat ID: 212 Type: JI, Default

Description

BI UAafhy === = 67T CEY Q4 @

This test set includes automatic tests that run on remote testing hosts and verify the functionality
of the Mercury Tours site.

b. Select the following:

Open Date: Select a date from the calendar for the planned opening date for the test set.
Today's date is selected by default.

Close Date: Select the planned closing date for the test set.
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7. Setrules for the automated tests in the test set in the event of a test failure.

a. Click the Automation tab.

Detailz | BExecution Grid Execution Flow | Automation Attachments Linked Defects | History
I
On Automated Test Failure -
Rerun test

Maximum test reruns:
Cleanup test before rerun:
On final failure: Do nothing w

Maximum test set reruns:

Motification
Send email in the event of:

Any test in the Automatic Runner finishes with status "Failed”

m

Emvironmental failure (network problems, hardware failure, etc.)

All tests in the Automatic Runner that were run have finished

B I U4 ay|i=

BT Ta G E9% aa B

w,
il
|III|

Execution Summary

Send summary of results after test set execution

b. Perform the following:

o On Automatic Test Failure: Select the Rerun test check box. In Maximum test
reruns, setto1.

o On final failure: Make sure that the Do nothing option is selected.
8. Instruct ALM to send an email to specific users if certain events occur.
Under Notification, perform the following:

a. Send email in the event of: Select the first check box to send email notification if any
test in the test set fails.
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b. To: Enter your email address.
c. Message: Type the following:

This test failed. Please review the test results and submit a defect.

Adding Tests to a Test Set

After you define a test set, select tests for inclusion in the test set. ALM adds instances of the
selected tests to the test set. Each instance contains a defined test configuration. In this exercise,
you will add tests to the Mercury Tours Site test set.

Note:

o If you are using ALM Edition with Lab Management enabled, add a test to your Functional
test set. See "Adding Tests to a Functional Test Set" below.

e If you are not using ALM Edition with Lab Management, add a test to your Default test set.
See "Adding Tests to a Default Test Set" on the next page.

Adding Tests to a Functional Test Set

In this exercise, you add an automatic test to the Mercury Tours Site test set.

To add automatic tests to a Functional test set:
1. Display the Execution Grid tab.

a. Ifthe Test Lab module is not displayed, on the ALM sidebar, under Testing, select Test
Lab.

b. Click the Execution Grid tab if it is not yet displayed.
2. Select the Mercury Tours Site test set.

In the test sets tree, expand the Cycle 1 - New Features test set folder under Service Pack 1.
Select the Mercury Tours Site test set.

3. Display the right pane if it is not already displayed.
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Click the Select Tests button. The right pane displays the Test Plan Tree and Requirements
Tree tabs.

Test Sets Edit View Tests Favorites Analysis

EA K| o-loT- 8B 7 @ B> Run Ji Run Test Set »| TestPlan Tree = Requirement:
Nao Filter Defined Details | Execution Grid = Reguested Hosts > Q@ E S SaAT-»
- Roat — —
JL Unattached gap Name Test: Test... Type ~ 5 Subject
3
» B3 BPT tests (Flight) I, Unattached
» B3 Cruises

+ B3 Mercury Tours Web Site & Fiont R ;
+ £ Modeling ight Reservation

N )
» B Release 10.5 i B3 ltinerary .
- Service Pack 1 £ Mercury Tours Site

N .
~ E& Cycle 1- New Feature ’ 5 Modeling
. Mercury Tours Site £ Payment Methads

E% Cycle 2 - Full » £ Profiling

»

Test Configurations

The Test Plan Tree tab enables you to select tests from the test plan tree to add to the test
set. The Requirements Tree tab enables you to select tests covering requirements to add to
the test set.

4. Addthe Number of Passengers test to the test set.

a. Underthe Flight Reservation folder, expand the Flight Finder folder.

b. Dragthe Number of Passengers test from the test plan tree to the Execution Grid to add it
to the test set.

5. Close theright pane.

Click the Close button.

Adding Tests to a Default Test Set

Note: In this exercise, you add tests to a Default test set. If you are using ALM Edition with
Lab Management, you already added tests to a Functional test set. Proceed to "Defining a
Build Verification Suite" on page 78.
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To add manual tests to a Default test set:
1. Display the Execution Grid tab.

a. Ifthe Test Lab module is not displayed, on the ALM sidebar, under Testing, select Test
Lab.

b. Click the Execution Grid tab if it is not yet displayed.
2. Select the Mercury Tours Site test set.

In the test sets tree, expand the Cycle 1 - New Features test set folder under Service Pack 1.
Select the Mercury Tours Site test set.

3. Display the right pane if it is not already displayed.

Click the Select Tests button. The right pane displays the Test Plan Tree and Requirements
Tree tabs.

Test Sets Edit View Tests Favorites Analysis

Ealx|lolov- s ): i B> Run - Jr RunTestSet | % | & T - ).) Test Plan Tree = Requiren
Mo Filter Defined Details = Execution Grid | Execution Flow | Attachmen = 2 | & | [E 2| & Q T -9
- E5 Root

ST Tag N Test: Test... T .
» J Unattached t ame est: Tes ype

4 BPT tests (Flight)

» Mercury Tours Web Site
» Modeling
3

» Cruises
» B3 Flight Reservation

N .
Release 10.5 8 ltinerary
Service Pack 1 » B3 Mercury Tours Site
K "
~ &2 Cycle 1 - New Features . & Modeling
JI, Mercury Tours Site £ Payment Methods
» B3 Profiling

» §Z Cycle 2 - Full

»

Test Configurations

The Test Plan Tree tab enables you to select tests from the test plan tree to add to the test
set. The Requirements Tree tab enables you to select tests covering requirements to add to
the test set.

4. Addthe Credit Card test to the test set.

a. Inthe Test Plan Tree tab, expand the Payment Methods folder and select the Credit
Cards test.
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b. If the Test Configurations pane is not displayed, click the Show button on the bottom of the
pane. Under the Test Configurations pane, you can see the three test configurations for the
selected test.

Test Plan Tree | Requirements Tree

QEHSAT-D

- Subject
» JL Unattached
> Cruises
+ E§ Flight Reservatian
r B8 ltinerary
* B8 Mercury Tours Site
4 Madeling
- Payment Methods
2 Credit Cards
+ 5§ Profiling

24

Test Configurations
A NS T-
Mo Filter Defined

Name Test Name
American Ex_ . Credit Cards
Visa Credit Cards
MasterCard Credit Cards

c. Toinclude all test configurations, in the Test Plan Tree tab, click the Add Tests to Test
Set button. The instances are added to the test set.

5. Add several tests from the Book Flight folder to the test set.
a. Under the Flight Reservation folder, expand the Book Flight folder.
b. Select the Passenger Name test.
c. Press the CTRL key and select the following tests: Credit Card Number, Credit Card
Expiration Date, Credit Card Owner, and Billing And Delivery Address. Click the

Add Tests to Test Set button. The Parameter Values dialog box opens.

d. Click Close. The instances are added to the test set.
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6. Add the Number of Passengers test to the test set.
a. Under the Flight Reservation folder, expand the Flight Finder folder.

b. Dragthe Number of Passengers test from the test plan tree to the Execution Grid to add it
to the test set.

7. Close theright pane.

Click the Close button.

Details =~ Execution Grid | Execution Flow = Attachments = Automatic = ?

0o ar Name Test: Test... Type Status
[1]JAmerican Express 2 Credit Car.. MANUAL & No Run
1MasterCard Cw Credit Car.. MANUAL © No Run
1Visa # Credit Car.. MANUAL © No Run
1]Passenger Name o Passenger.. MANUAL & No Run
1]Billing And Delivery.. B Billing And.. MANUAL Q9 No Run
[1]Credit Card Expiratio.. Ey Credit Car.. MANUAL & No Run
[1Credit Card Number  E» Credit Car.. MANUAL @ No Run
[1]Credit Card Owner S Credit Car.. MANUAL © No Run

[1INumber Of Passeng.. B Number Q.. QUICKTEST.. @ No Run

<

Last Run Report

Defining a Build Verification Suite

Note: The Build Verification module is available only if you are using ALM Edition with the Lab
Management extension enabled. If you are not using ALM Edition with Lab Management,
proceed to "Setting Schedules and Conditions for Test Runs" on page 80.

The Build Verification module enables you to define a group of Functional test sets bundled together
with a single Performance test. This group of test sets is called a build verification suite. When run
together, the build verification suite checks the overall status of your build.

You can create a small suite to run immediately after a build in the middle of the day, create a suite
with a few Functional test sets to run once every hour, or create a large suite to run for several hours
every night.

Build verification suites are a key component in HP's Continuous Delivery solution. They facilitate
an automated, end-to-end deployment and testing framework that makes application development
more efficient, reliable, and quick.

In this exercise, you will create a build verification suite that includes Functional test sets.
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To define a build verification suite:

1. Display the Build Verification module.

On the ALM sidebar, under Testing, select Build Verification.

2. Add afolder to the Build Verification Suites tree.

a. Inthe Build Verification Suites tree in the left pane, select the root Build Verification

Suites folder.

b. Click the New Folder button. The New Build Verification Suite Folder dialog box opens.

c. Inthe Folder Name box, type Mercury Tours Build Verification and click OK.

3. Add a build verification suite to the Mercury Tours Build Verification set folder.

a. Inthe build verification suites tree, select Mercury Tours Build Verification.

b. Click the New Build Verification Suite button. The New Build Verification Suite dialog

box opens.
[ New Build Verification Suite Bl X

X 9B

« Build Verification Suite Mame:

& Details Details
Created by: v Creation date: v
Modified: Modified By:
Description
B I U 4Aab i=i=x== &7 & ES aalm

c. Type the following:

Name: Mercury Tours Verification - Hourly

Description: This build verification suite includes test sets that run on an hourly basis to
verify the stability of the Mercury Tours site functionality.
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d. Click OK. The Mercury Tours Verification - Hourly build verification suite is added to the
test sets tree in the left pane.

4. Open the Functional Test Sets tab.

In the build verification suites tree, select Mercury Tours Verification - Hourly. Select
Functional Test Sets from the tabs in the right pane.

5. Add a Functional test set to the build verification suite.

Click the Select Test Sets button. The right pane displays the Test Sets Tree tab. The Test
Sets Tree tab enables you to select test sets from the test set tree to add to the build
verification suite.

Add the Mercury Tours Site test set to the build verification suite.
a. Underthe Service Pack 1 folder, expand the Cycle 1 - New Features folder.

b. Dragthe Mercury Tours Site test set from the test sets tree to the Functional Test Sets
tab to add it to the build verification suite.

You can now schedule a timeslot to run this build verification suite.

Setting Schedules and Conditions for Test Runs

The Execution Flow tab enables you to specify a date and time to execute a test instance and set
conditions forit. A condition is based on the results of another specified test instance in the
Execution Flow. By setting conditions, you can postpone the execution of a test instance until
another specified test instance finishes running or passes. You can also set the sequence in which
to execute the test instances.

For example, you can determine that Test 2 will run only if Test 1 passed, and Test 3 will run only if
Test 2 passed. Test 1 is scheduled to run at 9:00 AM on a specified date. The Execution Flow
displays the tests and their conditions in a diagram.

Details = Execution Grid | Execution Flow | Attachmentis | Automation = Linked Defects >
Test Set A 10/23/2043 9:00:00 AM
N
Y

=

[1]Tést 1
B

[1]Test 2
=]

[1]Test 3
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A blue line ———— g arrow indicates that the test instance is to be executed after the previous
test instance, with no conditions. A green line ——————— arrow indicates that the test instance
is to be executed only if the previous test instance has status Passed. A black ine ————
arrow indicates that the test instance is to be executed only if the previous test instance has
finished running. When a test instance is time-dependent, a Time Dependency @ icon is added to
the diagram.

In this exercise, you will create a new Default test set and add to it three test instances that verify
the login procedure on the Sign-On page of the Mercury Tours site. Then, you will set the conditions
for each instance and specify when each one is to be run.

To schedule a test run in the Execution Flow tab:

1.

Make sure the Test Lab module is displayed.

On the ALM sidebar, under Testing, select Test Lab.

Create a new test set.

C.

In the test sets tree, choose the Service Pack 1 folder and click the New Test Set button.
The New Test Set dialog box opens.

Type the following:
Name: Test Run Schedule
Description: This test set is used to explain how to schedule a test run.

Click OK. The Test Run Schedule test set is added to the test sets tree in the left pane.

Add tests from the Sign-On/Sign-Off folder to the Test Run Schedule test set.

a.

Click the Execution Flow tab. If the right pane is not already displayed, click the Select
Tests button. The Test Plan Tree tab and the Requirements Tree tab are displayed.

In the Test Plan Tree tab, under the Profiling folder, expand the Sign-On/Sign-Off folder.

Press the CTRL key and select the following tests: Sign-On Page, Sign-On User Name,
and Sign-On Password. Click the Add Tests to Test Set button. The Parameter Values

dialog box opens.
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d. Click Close. The test instances are added to the test set.

& Select Tests [B Run - Ji Run Test Set | ?i‘ =} | [s] BP| =Y ::'| @
Details | Execution Grid | Execution Flow | Attachments = Automation  Linked Defects H
Y]
‘/T%%n S%\
4 =) o
[1]1Sign-On Page [1]Sign-On Password [1]Sign-On User Name

« o

4. Add an execution condition to the Sign-On User Name test.

a. Inthe Execution Flow tab diagram, right-click the Sign-On User Name test instance and
choose Test Run Schedule. The Run Schedule dialog box opens and displays the

Execution Conditions tab.

Run Schedule: Test <[1]Sign-On User Name> ﬂ

Execution Conditions | Time Dependency

EEE: |

Test has no Execution Conditions
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b. Click New Execution Condition. The New Execution Condition dialog box opens.

MNew Execution Condition &

Test <[1]Sign-Cn Page> runs only if

Test v | is | Finished w
Comments
BIUA@EE=c|enm @7

%

c. Inthe Testdropdown list, select [1]Sign-On Page.

d. Select Passed from the list on the right to instruct ALM to execute the Sign-On User
Name test instance only if the Sign-On Page test instance finishes executing and passes.

e. Click OK. The condition is added to the Run Schedule dialog box.

- .
Run Schedule: Test <[1]Sign-On User Name> ﬂ
Execution Conditions | Time Dependency
$ o R |
Test Runs Only If
test 2 [1]15ign-On Page i5 Passed

9

5. Add atime dependency condition to the Sign-On User Name test instance.

HP ALM (12.00) Page 83 of 184



Tutorial
Chapter 5: Running Tests

a. Click the Time Dependency tab.

Run Schedule: Test <[1]Sign-On User Mame >

Execution Conditions |~ Time Dependency

& Run At Any Time

7 Run At Specified Time
Date

Time

b. Click Run At Specified Time. Select the Date check box and select tomorrow’s date.

c. Click OK to close the Run Schedule dialog box. Your conditions are displayed in the

Execution Flow diagram.

7
7‘7 nﬂét%‘
B B C]
[1]Sign—0n\Pagg [1]1Sign-On Password 124/2013
-\‘"\\_
""\._\\-x
~a

o
[1]1Sign-On User Name

Details | Execution Grid | Execution Flow = Aftachments = Automation = Linked Defects

History

6. Add an execution condition to the Sign-On Password test.

Add the same execution condition as described in Step 4 for the Sign-On Password test. This
time select Sign-On User Name from the Test box in the New Execution Condition dialog

box.

7. Add atime dependency condition to the Sign-On Password test.
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a. Add the same time dependency condition as described in Step 5 for the Sign-On

Password test.

b. Click OK to close the Run Schedule dialog box. Your conditions are displayed in the

Execution flow diagram.

Details = Execution Grid

i

al

Execution Flow

[1]Sign-aln PVfﬁrﬂf 2013
\
\
h)

=
[1]1Sign-On User Name

Attachments

Test Run Schedule

Ty
A

s
~—
.

“\* v

-
[1]1Sign-On Password

Automation

Linked Defects

>

Running Tests

In this exercise, you will define the Mercury Tours Site test set. You will also set failure rules for the
test set to instruct ALM how to proceed in the event that an automated test in the test set fails.
Depending on whether you are an ALM Edition user, you can either define a Functional test set or a

Default test set.

Note:

o If you are using ALM Edition with the Lab Management extension enabled, run a test in your
Functional test set. See "Running Tests in a Functional Test Set" below

o If you are not using ALM Edition with Lab Management, run a test in your Default test set.
See "Running Tests in a Default Test Set Manually" on page 89 and "Running Tests ina
Default Test Set Automatically" on page 97.

Running Tests in a Functional Test Set

When you run tests from a Functional test set, ALM uses Lab Management to execute the tests on
remote testing hosts equipped with the testing tools. Lab Management updates ALM with the
results of your tests. You can run all tests in a Functional test set or run specific tests. You can use
the Execution Grid tab to run a test set immediately. You can also use the Timeslots module to
reserve resources for a test to run in the future.
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You can run build verification suites in the same way as test sets. You use the Build Verification
module to run a build verification suite immediately, and you use the Timeslots module to reserve
resources for a build verification suite to run in the future.

In these exercises, you will learn about the following:
e "Running a Functional Test Set in the Test Lab module" below

¢ "Scheduling a Functional Test Set in the Timeslots Module" on the next page

Running a Functional Test Set in the Test Lab
module

You can run tests from a Functional test set immediately using the Execution Grid.
In this exercise, you will run the Mercury Tours Site test set in the Test Lab module.

To run a Functional test set in the Test Lab module:
1. Make sure the Test Lab module is displayed.
On the ALM sidebar, under Testing, select Test Lab.
2. Select the Mercury Tours Site test set.

In the test set tree, expand the Cycle 1 - New Features test set folder under Service Pack 1.
Select the Mercury Tours Site test set.

3. Open the Run Functional Test Set dialog box.

Click the Run Test Set button. The Run Functional Test Set dialog box opens.

|2 Run Functional Test Set Mercury Tours Site SNl X
Select timeslot:
@ New Reserved
New Timeslot - Properties:
Duration: 00:30:00 & Automatically Extend Timeslot
Requested resources: 1 host(s

AUT Env. Configuration: none|

Calculate Availability
Availability results:
G Timeslot can be reserved.
B> fun | Cancel | ielp
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4. Run the test set.

Click the Run button. ALM uses Lab Management to execute your test on a testing host with
the required testing tool.

5. View the progress of the run.

ALM opens the Execution Report page, which displays the current state and results of the
tests you executed. You can refresh the page, stop tests, and view an Event Log for the entire
run.

@) Application Lifecycle Management

Execution Report
Te: ite

Run Details:

6. Close the Execution Report.

After the test run is complete, close the Execution Report page.

Scheduling a Functional Test Set in the Timeslots
Module

You can reserve resources for the execution of a Functional test set using the Timeslots module.
In this exercise, you schedule the Mercury Tours Site test set in the Timeslots module.

To schedule a Functional test set in the Timeslots module:
1. Make sure the Timeslots module is displayed.
On the ALM sidebar, under Testing, select Timeslots.

2. Create anew Timeslot.
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On the Timeslots toolbar, click the New Timeslot button. The Timeslot Reservation dialog box

opens.

3. Schedule your Functional test set.

a. Inthe Run field, select Functional Test Set.

b. Inthe Start field, select Automatically.

c. Inthe Name field, type Mercury Tours Nightly.

d. Click the [none] link in Select a test set, and select the Mercury Tours Site test set.

e. Usethe Start Time and End Time fields to schedule the test set to run from 20:00 to

22:00.

f. A host is automatically added to the Requested Hosts grid.

g. Click the Calculate Availability button to check that the timeslot is valid.

Requested Hosts

Host Type

E Autematch Quick..

Timeslot Status

B Add Automatch Host [ Add Specific Host B4

Properties

1. Any

Description

5 Timeslot can be reserved.

b4 ‘@ | Caleulate Availability
Monday, November 04, 2013
17:00 18:00 19:00 20:00

IS

- M
5 Timeslot Reservation lilﬂlg
Run: |Functional Test Set w| Start | Automatically | w | Mame: | Mercury Tours Nightly
Test Set: Mercury Tours Ste Duration: 25|hrs [0 | |mins |G
AUT Env. Configuration: [none! Start Time: | 11/04/2013 |~ |20:00 =
End Time: | 11/042013 |~ | |22:00 =

21:00

VA AASAAIAIAAIAIA IS

Start Times Insuffi R Licen
v % ®

iProject Limit

Unknown D Unavailable Resource

Automatically Extend Timeslot

22:00 23:00 0:00 1:0

4. Submit the timeslot.

Click Submit.
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Running Tests in a Default Test Set Manually

When you run a test manually, you follow the test steps and perform operations on your application.
Then, you compare the expected results with the actual outcome and record the results. You can
execute a manual test as many times as needed. The results are stored separately for each run.

Note: In these exercises, you run Default test sets. If you are using ALM Edition with Lab
Management, you already ran a Functional test set. To continue in the tutorial, proceed to
"Viewing and Analyzing Test Results" on page 98.

You can run both manual and automated tests manually as part of a Default test set. You can also
choose to run a single test or to run an entire test set.

You run manual tests in ALM using HP Sprinter, HP’s solution for manual testing. If you are not
working with Sprinter, you run tests manually using Manual Runner.

In these exercises, you will learn about the following:
¢ "Running with Sprinter" below

e "Running with Manual Runner" on page 93

Running with Sprinter

Sprinter provides advanced functionality and tools to assist you in the manual testing process.
Sprinter is fully integrated with ALM, enabling you to get the maximum benefit from both solutions.

Note:

o Sprinter functionality is not available with Quality Center Starter Edition or Performance
Center Edition.

o Forinformation on installing Sprinter, see "Before You Begin" on page 7.

In this exercise, you will run the Credit Cards test. This test contains three test configurations. For

the purpose of this exercise, you will perform the steps without testing them against the Mercury
Tours application.

To run a test using Sprinter:
1. Open Sprinter.

a. Ifthe Test Lab module is not displayed, on the ALM sidebar, under Testing, select Test
Lab.

b. Click the Execution Grid tab.
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c. Click the Run arrow and select Run with Sprinter. HP Sprinter opens.

- - O X
ﬁﬂ Sprinter Plan Run Q G ?.

HP ALM Sefiings  Help

Run Setup Q@ 7(x Visa 2
(T P g
[ Open Save Favorites
T ! Definitions || General Settings
s Test Runs e — )
General Settings
@ Name Status Steps (8) Testinstance: Visa
Visa Q
Formnaines 2] Test name: Credit Cards
M” Results Test set. Root\Service Pack 1\Cycle 1 - New Features\Wercury Tours Site
Run Summary
Steps ) Owner: alex_alm

Submitted Defects (0)

* Run name: | Run_10-17_1-17-45 |

Defect Reminders (0)

User Actions (0) Description:  The test verifies the credit card type
Storyboard

Attachments: Mo attachments.

Power Mode

Language: | ___‘

[ Tests: 1 Active Tests: 1

Domain: DEFALLT, Project ALM_Demo, User: slex_alm (T4 ]

2. Select the instances to run from the test set.
a. Click the Open HP ALM Tests button. The Open dialog box opens.

b. Inthe left pane, expand the Root folder. Under Service Pack 1, expand Cycle 1 - New
Features. Select the Mercury Tours Site test set. The test set is displayed.
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Y [

Filter Select Columns

W @

Select All Desslect All

oot Configuration: Name Test: Test Name Status Re “
% Unattached [[] [1]Passenger Hame Passengar Mame Mo Run sle
3 EiF'T ”‘“’St?r“:"‘-‘hﬁ - [F] [1]Credit Card Numbsr Credit Card Numbsr Mo Run ale
ercury Tours Web Site
B Modelir:g [[] [M1Credit Card Expirati... Credit Card Expiration... Mg Run ale
[1]Credit Card Owner Credit Card Cwner Mo Run zle
j Release 10.5
3 Service Pack 1 |:| [1]Billing And Delivery... Billing And Delivery & .. Mo Run gle
a E Cycle 1 - Mew Feature: [1l&merican Express Credit Cards Mot Completed ale
FJZ_ []visa Credit Cards Passed ale
i 3 cycle2- Fun || [1]Master Card Credit Cards Mo Run ale
AL Test Run Schedule [T] [1IMumber Of Passen... Mumber Of Passengers Mo Run ale

H x

[ 1l [T¥] ]« | i v
2 tests are currenily selected w

c. Select American Express, Visa, and MasterCard check boxes. Click Open.
3. Display the test steps to run the American Express instance.
Click the Run the Active Test button. The Steps pane is displayed.

StepsYl
Test: Credit Cards ?
O~ O~ w2~ Biv 0 |@[F% B Q

© 1.Step 1: Log in to Mercury Tours ) E
1. Enter URL
2. Legin

Expected Result:

User is logged in to Mercury Tours

= 2 Step 2: Select a flight destination _¢| (x]

= 3. Step 3. Enter depariure and return flight - | (x]

« 4, Siep 4: Enter passenger details s O F

= B Step 5. Enter credit card details _c| (x]

« 6. Step 6: Enter addresses 4| O E|
| 0/8 | Duration: 00:04:38

4. Perform the first step.

a. Click the Actual Result button. In the Actual Result dialog box, type: The Mercury Tours
site opens. Click OK.

b. Click the Passed Selected Step button.
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10.

11.

12.

Perform the second step.

a. Click the Actual Result button. In the Actual Result dialog box, type: Flight details and

preference are entered. Click OK.
b. Click the Passed Selected Step button.
Pass the remaining steps.
Click the Passed Selected Step arrow and select Pass All.

Continue on to the Visa instance.

Click Next Test. Sprinter advances to the next instance in the test list.

Pass all steps of the Visa instance.
Click the Passed Selected Step arrow and select Pass All.

Continue on to the MasterCard instance.

Click Next Test. Sprinter advances to the next instance in the test list.

Pass all steps of the MasterCard instance.

Click the Passed Selected Step arrow and select Pass All.
Fail the last step on the MasterCard instance.

Select Step 8 and click the Fail Selected Step button.

End the run and view run results.

a. Inthe upper-right side of your screen, click Run Control. The Run Control pane opens.

b. Click the End Run button.
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ﬁﬂ Sprinter Run

HP ALM Sefiings  Help

Run Setup L% N3 Master Card ?
@& B . % - m . =
> Open Save Favorites Print Email
L [ Definifi Run Summary
s Test Runs
Genersl Settings
Name Status - r
@‘ Steps (8) { Testinstance: Master Card
Amerean Exress. @ Parameters (2) | i\ Testname:| Credit Cards
- B —— |
Jisa [ ] T Status: () Failed
Master Card Q 1% Results
Run Summary = Run name:  Run_10-17_2-28-55
)
Steps (8) @ Tester:  alex_alm
Submitted Defects (0)
Gt e o) L . Start time:  10/17/2010 4:45:09 PM
e — @)  Endfime: 10172010 45404 PM
o [’ Duration:  00:05:56

Power Mode

El\l" Actions |_| Submitted Defects {75 Defect Reminders S Comments

1) o a

[_;5 Steps 8
(s Passed () Failed
7 1

‘ 2 Tests | O Active Tests Domain: DEFALULT, Project: ALM_Demo, User: slex_alm fd ]

c. Under Tests, you view the run results.
13. View results in the Execution Grid tab.
Close Sprinter.

The test run results are displayed in the execution grid. The Last Run Report pane displays run
results of each test step.

Running with Manual Runner

If Sprinter is not installed you can run tests manually using Manual Runner.

In this exercise, you will run the Credit Cards test. This test contains three test configurations. For
the purpose of this exercise, you will perform the steps without testing them against the Mercury
Tours application.

To run a test using Manual Runner:
1. Make sure the Cycle 1 - New Features test set folder is displayed in the Execution Grid.

a. Ifthe Test Lab module is not displayed, on the ALM sidebar, under Testing, select Test
Lab.

b. Inthe test set tree, expand the Cycle 1 - New Features test set folder under Service Pack
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1. Select the Mercury Tours Site test set.
c. Click the Execution Grid tab.
2. Select the instances to run from the test set.

Press the CTRL key and select the following instances in the Execution Grid: American
Express, Visa, and MasterCard.

3. Open Manual Runner.

Click the Run arrow and select Run with Manual Runner. The Manual Runner dialog box

opens.

[E Manual Runner: Test Set Mercury Tours Site, Test [1]American Express l oy
[B> segin Run (@ End Run | ¥ CancelRun | 13 +| @ 0SInfo ?
Fun Detzils

=Run Name: Run_11-2_15-25-4 = Status Mot Completed
= Test Instance: [1]American Bxpress = Test Set-hame: Mercury Tours Site
= Tester: slex_alm B | w Baseline:
Build Verification.. Build Verification..
Change Detectic.. Change Status:
Configuration 1D: 1195 Configuration: Ma.. | American Express
Comments
Add Comment
BI UAah Ei= = |67 @ EBEYl aalm
|
Test Details
Name: Credit Cards Test Details
The test verifies credit card types.
\

4. Start the test run.
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Click the Begin Run button. The Manual Runner dialog box opens.

[ Manual Runner: Test Set Mercury Tours Site, Test [1]American Express l o x
PR AR - O | A v| @ ?
L|_:] Step Name Status Exec Date Exec Time
Step : Loginto M.. &3 Mo Run 1132013 3:26:44 PM
Step 2: Select a £.. €3 No Run 1132013 3:26:44 PM
Step 3: Enter de.. €3 Mo Run 1132013 3:26:44 PM
Step 4: Enter pas_. € No Run 1132013 3:26:44 PM
Step 5: Enter cre. €3 Mo Run 11732013 3:26:44 PM
Step &: Enter ad.. €3 Mo Run 1132013 3:26:44 PM
Step 7: Complet. &3 Mo Run 1132013 32644 PM
Step 8: Log out. € No Run 1132013 32644 PM
Description

BIUAS®h|g

1. Enter URL.
2 Login.

BT Te CEY aa @

Expected Actual:
B I UAab|:

Useris logged into Mercury Tours

1
i
it

fnl
3
=
=]
—
(=]
o
]
1
il
Il
fl
3

5. Perform the first step.
a. Inthe Actual box, type: The Mercury Tours site opens.
b. Click the Pass Selected button. Step 2 is displayed.
6. Perform the second step.
a. Inthe Actual box, type: Flight details and preference are entered.
b. Click the Pass Selected button. Step 3 is displayed.
7. Pass the remaining steps.
Click the Passed Selected arrow and select Pass All.
8. Endtherun.
Click the End Run button to end your test run.
9. Continue on to the Visa instance.

Click the Begin Run button. The Manual Runner dialog box opens. Note the name of the
instance in the title bar.
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10. Pass all steps of the Visa instance.

Click the Passed Selected arrow and select Pass All.
11. End the run.

Click the End Run button to end your test run.
12. Continue on to the MasterCard instance.

Click the Begin Run button. The Manual Runner dialog box opens. Note the name of the
instance in the title bar.

13. Fail all steps of the MasterCard instance.

Click the Fail Selected arrow and select Fail All.
14. End the run.

Click the End Run button to end your test run.
15. View the runresults in the Execution Grid.

Following the execution of your tests, you can view the run results of your last run in the
Execution Grid.

l|5] tapr Test: Test Name Type Status Responsible...
':ji Number Of P QUICKTEST_TE.. &3 No Run alex_alm
B Credit Card M. MANLIAL & No Run alex_alm
G Credit Card E.. MANLIAL & No Run alex_alm
B Credit Card O MANLIAL €3 No Run alex_alm
L Passenger N MANLIAL & No Run alex_alm
Cw Billing And D.. MANLIAL & No Run alex_alm
2 Credit Cards MANUAL Q) Passed alex_alm
G Credit Cards MANUAL () Passed alex_alm
B Credit Cards MANLIAL €3 Failed alex_alm

16. View the results of each test step in the Last Run Report pane.

a. Select one of the recently run instances. If the Last Run Report pane is not displayed, click
the Show button on the bottom of the pane. The Last Run Report pane is displayed below
the Execution Grid.
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Last Run Report

Step Name

Step : Log into Mercury Tours
Step 2: Select a flight

Step 3: Enter departure

Step 4: Enter passenger details.

Step 5: Enter credit card details
Step 6: Enter addrezses.

Step 7: Complete the purchase.
Step & Log out.

Status

% Failed
¥ Failed
¥ Failed
¥ Failed
¥ Failed
¥ Failed
¥ Failed
¥ Failed

“

Steps Details
Description:
1. Enter URL.
2. Login.

Expected:
User is lngged into Mercury Tours.

b. Click each step to view its description, as well as the expected and actual results.

Running Tests in a Default Test Set Automatically

When you run an automated test from a Default test set, ALM automatically opens the selected
testing tool, which runs the test on your local machine or on remote hosts, and imports the results to

ALM.

You can run all tests in a test set or run specific tests. You can run tests from the Execution Grid

tab or the Execution Flow tab.

In this exercise, you will run a UFT test.

Note: For prerequisites to running a UFT test, see "Before You Begin" on page 7.

To run a test automatically:

1. Make sure the Test Lab module is displayed.

On the ALM sidebar, under Testing, select Test Lab.

2. Select the Number of Passengers test.

a. Inthetest sets tree, expand the Mercury Tours Web Site test set folder. Under
Functionality And Ul, select the Mercury Tours Functionality test set.

b. Click the Execution Grid tab.

c. Select the Number of Passengers test.

3. Open the Automatic Runner dialog box.
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Click the Run button. The Automatic Runner dialog box opens and displays the selected test.

= Automatic Runner <Root\Mercury Tours Web Site\Functionality And UD\Mercury Tours Func...l =RNCEL X

B Runal {peirun M Stop M Stopa @

[ Run All Tests Locally
Enable Log

Test Name Run on Host Status
":f_[, [1]Number Of Paszengers

h

4. Set the test run settings.
Select the Run All Tests Locally check box to run the test on your local computer.
5. Runthe test.

Click the Run button. ALM opens the selected testing tool automatically and runs the test. You
view the test execution progress in the Status column.

6. Close the Automatic Runner dialog box.
After the test run is complete, choose Run > Exit.
7. View a summary of test results in the Execution Grid.

The Execution Grid displays the updated status for the test run. Results for each test step
appear in the Last Run Report pane.

8. Close UFT.

In UFT, choose File > Exit.

Viewing and Analyzing Test Results

ALM provides a number of features that enable you to view and analyze the results of your tests.
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This section includes:

¢ "Viewing Test Results in the Test Runs Module" below

o "Viewing Test Results in the Test Instance Properties Dialog Box" on page 101
o "Viewing Test Coverage" on page 103

+ "Viewing Coverage Progress" on page 106

You can also use ALM reports and graphs to further analyze your test results. For more information,
see "Analyzing ALM Data" on page 127.

Viewing Test Results in the Test Runs Module

You can view results for a test in the Test Runs module. You can use the grid to compare the
results of recent test runs with previous test runs.

In the below exercise, you will learn how to view test run information in the Test Runs module.

Viewing Functional Test Set Results in the Test Set
Runs Tab

If you are using ALM Edition with Lab Management enabled, you can view the results of your
Functional test set runs in the Test Set Runs tab.

To view test set results in the Test Set Runs tab:
1. Make sure the Test Runs module is displayed.

On the ALM sidebar, under Testing, select Test Runs.
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TestRuns | TestSetRuns | Build Verification Suite Runs

TestRuns Edit View Analysis

¥ |5 T-I0 =- 8 5 cotoTestinstance | [l | §5 Data Processor Queue | & Performance Trending.
Legend
Sort By: Exec Date[D: ding];Exec Time[D\ ding]
M db P Run ID Run Name Test: Test Name Configuration:... Status State Duration Exec Date Exec Time
[&> Run_8-15_16. Returning Date Returning Date () Passed 184 8152012 5:05:37 PM
D Run_8-15_16.. View Calendar Wiew Calendar € Failed 35 281512012 5:04:40 PM
[/“v Run_8-15_16_ MNumber Of Pass_ Number Of Pass = () Passed k3 8n52012 5:00:48 PM
[> Run_8-15_16. Departing Date Departing Date ) Passed 20 81512012 5:00:19 PM
D Run_815 16.. Flight Reservation Flight Reservation & Failed 113 28152012 4:57.54 PM
[')v Run_8-15_16.. Departing And Ar. Departing And Ar.. ) Passed 92 ansi2012 4:55:28 PM
[E> Run_8-15_16.. Flight Reservation Flight Reservation (O Mot Completed 10 8152012 4:55:27 PM
Comments Report | Aftachments | History *

=]
~
(=]
B
[E]
il
il
1

oY T4 & EHY aa @

2. View detailed test results from the Test Set Run Details dialog box.
Click the Test Set Runs tab. Select the Mercury Tours Site test set runin the grid and click
the Test Set Run Details button. The Test Set Run Details dialog box opens, containing
details about the test set run.

3. Close the Test Set Run Details dialog box.
Click the Close button.

4. View test runinformation in the Execution Report page.

Select the Mercury Tours Site test run and click the Show Report button. The Execution
Report page opens. The Execution Report page displays information about the overall test set
run and detailed information about each test instance run.

Viewing Test Results in the Test Runs Tab

In this exercise, you view the results of individual test instance runs.

To view test results in the Test Runs tab:
1. Make sure the Test Runs module is displayed.

On the ALM sidebar, under Testing, select Test Runs.
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TestRuns | TestSetRuns | Build Verification Suite Runs

TestRuns Edit View Analysis

¥ |5 T-I0 =- 8 5 cotoTestinstance | [l | §5 Data Processor Queue | & Performance Trending.
Legend
Sort By: Exec Date[D: ding];Exec Time[D\ ding]
M db P Run ID Run Name Test: Test Name Configuration:... Status State Duration Exec Date Exec Time
[&> Run_8-15_16. Returning Date Returning Date () Passed 184 8152012 5:05:37 PM
D Run_8-15_16.. View Calendar Wiew Calendar € Failed 35 281512012 5:04:40 PM
[/“v Run_8-15_16_ MNumber Of Pass_ Number Of Pass = () Passed k3 8n52012 5:00:48 PM
[> Run_8-15_16. Departing Date Departing Date ) Passed 20 81512012 5:00:19 PM
D Run_815 16.. Flight Reservation Flight Reservation & Failed 113 28152012 4:57.54 PM
[')v Run_8-15_16.. Departing And Ar. Departing And Ar.. ) Passed 92 ansi2012 4:55:28 PM
[E> Run_8-15_16.. Flight Reservation Flight Reservation (O Mot Completed 10 8152012 4:55:27 PM
Comments Report | Aftachments | History *

=]
~
(=]
B
[E]
il
il
1

oY T4 & EHY aa @

2. View detailed test results from the Test Run Details dialog box.

Make sure the Test Runs tab is displayed. Select the American Express test run and click
the Test Run Details button. The Test Run Details dialog box opens.

3. View other test run information in the Test Run Details dialog box.
a. Click Reportto display results and test step details of the run.
b. Click Linked Defects to list the defects linked to the run.
c. Click History to list the changes made to the run.

4. Close the Test Set Run Details dialog box.

Click the Close button.

Viewing Test Results in the Test Instance Properties
Dialog Box

You can view results for a test in the Test Instance Properties dialog box. This includes details of a
test’s runs, attachments, linked defects, and history.
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To view test results in the Test Instance Properties dialog box:

Make sure the Test Lab module is displayed.
On the ALM sidebar, under Testing, select Test Lab.
Make sure the Cycle 1 - New Features test set folder is displayed.

a. Inthe test set tree, expand the Cycle 1 - New Features test set folder under Service Pack
1. Select the Mercury Tours Site test set.

b. Click the Execution Grid tab.

Select American Express in the Execution Grid.

In the Execution Grid tab, select American Express.

View detailed test results from the Test Instance Details dialog box.

Click the Test Instance Details button. The Test Instance Details dialog box opens.
View test run information.

Click Runs. The run details are displayed.

[E! Test Instance Details l S|
<o &= %65 P
Name: American Express Cycle: Cycle 1- New Features Type: | 23 MANUAL
(2 Details ® = @ T-[\| =~ & | (B continueManual Run
= Runs
<P> Execution Settings Leaend
§ Attachments Sort By: Exec Date[D jing]:Exec Time[D ding]
&3 Linked Defects ar Run 1D Run Name Status Duration Exec Date Exec Time
4+ History 0e
383 B Run_11-12_1.. ) Passed 25 11122013 1:25:11 PM Al

Comments Repart

€@

Step Name Status Exec Date +  Steps Details
Step 1 - Enter URL |+ Passed 111272013 Description: -
Step 2 -Select a fligh v Passed 11272013 Log into Mercury tours
Step 3: Enter depart. 4 Passed TMM22013
Step 4: Enter passen ' Passed TMM22013
Step 5: Enter credit c % Passed TM22013 il L%‘n%leu‘;:ged in to Mercury Tours
4 » -

6. View other test run information in the Test Instance Details dialog box.

a. Click Execution Settings to view parameters used to run the instance. Note that any
changes that you make are implemented in the next test run.
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b. Click Linked Defects. This view lists the defects linked to the currently selected test
instance. You can view, add, and remove defect links.

c. Click History to view a list of changes made to the test run fields.
7. Close the Test Instance Details dialog box.

Click the Close button.

Viewing Test Coverage

You previously saw how you can use the Coverage Analysis view to analyze the breakdown of
child requirements according to their tests coverage (see "Analyzing Coverage" on page 55).

In this exercise, you will learn how to filter the tests included in the coverage analysis by cycle.
Note: This exercise is not available for HP ALM Essentials Edition.

To view test coverage:
1. Display the Coverage Analysis view in the Requirements module.
a. Onthe ALM sidebar, under Requirements, select Requirements.
b. Choose View > Coverage Analysis. The Coverage Analysis view is displayed.
2. Filter the coverage analysis by cycle.

a. On the upper-right side of the window, click the Settings button. The Analysis Settings
dialog box opens.

b. Select Execution Analysis. Click the arrow. In the releases tree, expand the release
folder Service Packs and the release Service Pack 1. Select the Cycle 1 - New Features
check box and click OK.

c. Click OK to close the Analysis Settings dialog box.
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d. Expand the Payments requirement. In the Coverage Analysis column, you can see that
the requirement has failed. This is because the Credit Cards test that covers the
requirement failed.

Requirements Edit View Favorites Analysis

FERICAMINE

Mo Filter Defined

Name 4

+ 5 Requirements
» (53 Business Models
- Mercury Tours Application

» [ Online Travel Booking..
» [ Online Travel Informati..

» [ Profile Management

» [l Reservation Managem..

» [2] Booking System
» [l Application Security
» [ Application Usability

» [l Application Client Syst..
» [ Application Performan..

« 5 Payments
@ Credit Cards

» (B3 Assemble order

» B3 Contract processing

Coverage analysis last calculation time: 111220713 14:04:03.

= p| |

) - - 1
. Execution analysis by cycle(s): Cycle 1 - New Features [Sllel [ IS

Coverage Analysis

Legend

102

21

65

18

@ Failed

3. Display test coverage details for the Credit Cards requirement.

a. Right-click the Credit Cards requirement, and choose Coverage Analysis. The Coverage
Analysis dialog box opens.
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Coverage Analysis M

This graph displays the coverage status for requirement

372 - Credit Cards

and its children acconding to the cument filter.

Click & group in the graph to display its list of requirements.
1 Failed

Copy to Clipboard Hide Test Coverage #
Test Coverage Chart

This graph displays the test status for requirement

372 - Credit Cards

Click a group in the graph to display its list of tests.

1 Failed

[ 1 Failed 100 %

according to test status.
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Click the Show Test Coverage link to extend the Coverage Analysis dialog box and
display the Test Coverage Chart.

c. This pie chart graphically displays the full test coverage for the requirement, grouped
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d. Click the pie chart to open the Test Coverage dialog box.

T Test Coverage

[f] Select g | Status Filter:  Failed w @ T~ [[ﬂ B3 Full Coverage
Filter: Coverage Status[ Failed™]

Coverage Type Entity Name Coverage Status Coverage Mode
Test B Credit Cards €3 Failed Al Configurations

Test Configuration Status

%0
Name Description Status
American Express Test configuratio. () Passed
Visa Test configuratio.. () Passed
MasterCard Test configuraito.. €3 Failed

<

The dialog box shows the failed test together with the test run status of each test

configuration.
e. Close the Test Coverage dialog box.
4. Close the Coverage Analysis dialog box.

Click the Close button.

Viewing Coverage Progress

You were previously introduced to the Progress tab in the Releases module (see "Viewing

Releases and Cycles" on page 28).

In this exercise, you will view the graphs and statistics that now reflect the results of tests you ran

in previous exercises.

Note: This exercise is not available for HP ALM Essentials Edition.

To view coverage progress:
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1. Display the Releases module.
On the ALM sidebar, under Management, select Releases.
2. View the effect of your test runs on the Progress tab.

In the releases tree, expand the release folder Service Packs and the release Service Pack 1.
Select Cycle 1 - New Features and click the Progress tab.

Details | Attschments | Progress | Quality

N
Total days in cycle: 32
Days
Total test instances for cycle: ] Elapsed Remaining
Femaining test instances to run: -
Test Instance Runs
Fequired execution rate (test instancesrday): 025 -
Actusl execution rate (test instancesidayy 020 Completed Remaining

Coverage Progress
100%
B0%
50%
T0%
80%
R0%
40%
3%
20%
10%

%
0123 45687 89%1W0 12 14 16 18 20 2223 25 27 28 H
Time

Executed coverage [v] [l Passed coverage B Flanned coverage

The top pane shows information such as the total and remaining days in the cycle, total test
instances for the cycle, and actual and remaining test instances to run.

The bottom pane displays the Coverage Progress graph. Planned coverage indicates the
percentage of tests planned to be run each day within a cycle. Executed coverage indicates
the percentage of tests that ran each day within a cycle. Passed coverage indicates the
percentage of tests that ran successfully each day within a cycle.
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Locating and repairing defects is an essential phase in application development. Defects can be
detected and submitted by users in all stages of the application lifecycle management process.
Using ALM, you can submit defects detected in the application and track them until they have been
repaired and retested.

In this lesson, you will learn about:

How to Track Defects . ... ... 109
Adding New Defects ... .. 109
MatChing DefeCtS ... 111
Updating Defects .. il 112
Linking Defects t0 TeStS ... 116
Creating Favorite VieWsS 117
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How to Track Defects

When you submit a defect to an ALM project, it is tracked through these stages: New, Open, Fixed,
and Closed. A defect may also be Rejected or it may be Reopened after it is fixed.

Fixed

Closed

When you initially report the defect to an ALM project, it is assigned the status New, by default. A
quality assurance or project manager reviews the defect and determines whether or not to consider
the defect for repair. If the defect is denied, it is assigned the status Rejected. If the defect is
accepted, the quality assurance or project manager determines a repair priority, changes its status
to Open, and assigns it to a member of the development team. A developer repairs the defect and
assigns it the status Fixed. You then retest the application, making sure that the defect does not
recur.

If the defect recurs, the quality assurance or project manager assigns it the status Reopened. If the
defect is repaired, the quality assurance or project manager assigns it the status Closed.

Adding New Defects

You can add a new defect to an ALM project at any stage of the application lifecycle management
process. In this exercise, you will submit a defect connected to the Flight Confirmation test.

To add a defect:
1. Openthe ALM_Demo project.

If the ALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 16.

2. Display the Defects module.
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4.

5. Determine the cycle in which the defect was detected.

On the ALM sidebar, select Defects. The Defects Grid displays defect data in a grid. Each row

in the grid displays a separate defect record.

Open the New Defect dialog box.

Click the New Defect button. The New Defect dialog box opens.

r

| ] New Defect

¥ a1~ B G B Use Default Values Set Default Values

= Summary: ||

[z Details Details

U Attachments
= Category: ~
sDetectedon.. | 10/24/2013 h
Actual Fix Ti..
Description:
B I U Aah:i=i= = &= 67T

=Detected By: alex_alm bl
= Severity: v
Assigned To: v
o E% a9

A

Describe the defect.

Enter the following data in the specified fields. Scroll down the dialog box as necessary.

Summary: Missing information on Flight Confirmation page.

Category: Defect
Severity: 2-Medium

Subject: Flight Reservation > Flight Confirmation

Description: The defect was detected on the Flight Confirmation page. Passenger details and

meal preferences are not displayed

Note: If you are using HP ALM Essentials Edition, proceed to Step 6.

a. Inthe Detected in Cycle box, click the arrow. The releases tree opens. Expand the tree. In
the Mercury Tours Application releases folder, in the Release 10.5 release, select the
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Cycle 1 - New Features cycle.
b. Click OK to close the releases tree.
You can see that ALM automatically assigns the value Release 10.5 to the Detected in
Release field. This is because Cycle 1 - New Features is part of the Release 10.5
release.
6. Attach the URL address for the Mercury Tours page where the defect was detected.
a. Onthe New Defect dialog box sidebar, click Attachments. The Attachment page opens.
b. Click the URL button. The Attach Uniform Resource Locator (URL) dialog box opens.
c. Type the URL address of the Mercury Tours page:
http://newtours.demoaut.com/
d. Click OK. A link to the Mercury Tours page is displayed above the Description box.
7. Add the defect to the ALM project.

a. Click the Submit button. The defect is added to the Defects Grid.

b. Click Close to close the New Defect dialog box.

Matching Defects

Identifying matching defects enables you to eliminate duplicate or similar defects in your project.
Each time you add a new defect, ALM stores lists of keywords from the Summary and
Description fields. When you search for similar defects, keywords in these fields are matched
against other defects. Note that keywords must be more than two characters long, and letter case
does not affect your results.

In this exercise, you will match defects by comparing a selected defect with all other existing
defects in the ALM_Demo project.

To match defects:
1. Make sure that the Defects module is displayed.
If the Defects module is not displayed, on the ALM sidebar, select Defects.
2. Select the Defect.

a. If afilteris applied to the grid, click the Set Filter/Sort arrow and choose Clear Filter/Sort
to clear the filter.

b. Inthe Defects Grid, select the defect you added in "Adding New Defects" on page 109.

HP ALM (12.00) Page 111 of 184


http://newtours.demoaut.com/

Tutorial
Chapter 6: Adding and Tracking Defects

3. Find similar defects.

Click the Find Similar Defects button. The results are displayed in the Similar Defects pane
at the bottom of the window, sorted by the percentage of detected similarity. Note that there
are no duplicate defects in the project for the selected defect.

Search for: Missinginformationon v~ | Proximity %: 25 | Search ([N @ | ? B x
Q@ @P  DefectID Summary Description Comments
83 Missing infor.. The defect w...

Item 10f 1

Close the Similar Defects pane.

Updating Defects

Tracking the repair of defects in a project requires that you periodically update defects. You can do
so directly in the Defects Grid or in the Defect Details dialog box. The ability to update some defect
fields depends on your permission settings. After you have updated defects, you can view the
quality status of your release in the Releases module.

In this exercise, you will update your defect information by changing the severity of a defect,
assigning the defect to a cycle, and adding a comment. You will then see how updating defects is
reflected in the Quality tab of the Releases module.

In addition, you will practice updating multiple records simultaneously.

Note: If you are using HP ALM Essentials Edition, fields and commands related to cycles and
releases are not available.

To update defects:
1. Make sure that the Defects module is displayed.
If the Defects module is not displayed, on the ALM sidebar, select Defects.
2. Open the Defect Details dialog box.

In the Defects Grid, select the defect you added in "Adding New Defects" on page 109. Click
the Defect Details button. The Defect Details dialog box opens.
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E‘ Defect Details =l i&

Koo am i = 9ha

Defect ID:| 83 Bl EL Bl issing information on Flight Confirmation page.
£ Details Details
0 Attachments
== Linked Entities = Category: Defect v = Detected By: alex_alm B v
@ History =Detected on Dat.. | 10/24/2013 v = Severity: 2-Medium ~
Actual Fix Time: Assigned To: v
Browser: v Closed in Versio... v
Closing Date: ~ Detected in Cycl. | Cycle 1 - New Fea [= ~
Description: Comments:
B I UAgh === o7 T B I U Aa == eT e @

The defect was detected on the Flight
Confirmation page. Passenger details and
meal preferences are not displayed

3. Change the severity level of the defect.

In the Severity box, select 5-Urgent.

Note: If you are using HP ALM Essentials Edition, proceed to Step 5.

4. Determine the cycle in which the defect will be fixed.

a. Inthe Target Cycle box, click the arrow. The releases tree opens. Expand the tree. In the
Mercury Tours Application releases folder, in the Release 10.5 release, select the
Cycle 4 a - Full cycle.

b. Click OK to close the releases tree.
You can see that ALM automatically assigns the value Release 10.5 to the Target
Release field. This is because the Cycle 4 a - Full cycle is part of the Release 10.5
release.

5. Add a new comment to explain the change in the severity level.

a. Click the Add Comment button. A new section is added to the Comments box,
displaying your user name and the current date.

b. Type: This defect should be fixed in the next service pack.

6. View the Attachments.
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10.

11.

Click Attachments on the sidebar. Note that the URL attachment is listed.
View Linked Entities.

Click Linked Entities on the sidebar to view entities that have been linked to the defect.
Linked entities can include requirements, tests, test sets, test instances, runs, run steps, and
other defects. There are currently no linked entities. You will learn how to link a defect to a test
in "Linking Defects to Tests" on page 116.

View the History.

Click History on the sidebar to view the history of changes made to the defect. For each
change, the grid displays the date and time of the change and the name of the user who made
the change. You can expand a change to view a list of fields modified during the change. For
each field, the grid displays the old value and the new value.

Close the Defect Details dialog box.

Click OK to exit the dialog box.

Update defects directly in the Defects Grid.

Note: If you are using HP ALM Essentials Edition, ignore this step.

a. Inthe Defects Grid, select defect 35.

b. Click the Detected in Cycle box and click the arrow. In the releases tree, expand the
release folder Mercury Tours Application and the release Release 10.5. Select the
Cycle 1 - New Features cycle and click OK.

c. Drag the horizontal scroll bar to the right until the Target Cycle column comes into view.
Click the Target Cycle box for defect ID 23, and click the arrow. In the releases tree,
expand the release folder Mercury Tours Application and the release Release 10.5.
Select the Cycle 1 - New Features cycle and click OK.

Update multiple records simultaneously.
a. Inthe Defects Grid, select defect ID 23.
b. Hold down the CTRL key, and select defect 36. Now both defects 35 and 36 are selected.

c. Select Edit > Update Selected. The Update Selected dialog box opens.
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Update Selected ﬁ

Update Field: Actual Fix Time w

Value: |

|gnore errors

[ update | ciose | Holp |

d. Click the arrow adjacent to the Update Field box, and select Assigned To. Notice that
the Value box displays the Assigned To value of the defect you selected last.

e. Click the arrow adjacent to the Value box. The users list opens.

Q1 View by Group

s Name Full name
o alex_alm

o alice_alm

& bal

o cecil_alm

i devengl
ﬂjames_alm
i kelly_alm

& mary_alm

& michael_alm
¢4 paul_alm

o peter_alm

f. Inthe users list, select michael_alm, and click OK.
g. Inthe Update Selected dialog box, click Update.

h. After the update completes, an Information dialog box displays a summary of the update.
Click OK, then close the Update Selected dialog box.

12. View the number of defects opened in Cycle 1 - New Features on the Quality tab.
Note: If you are using HP ALM Essentials Edition, ignore this step.

a. Onthe ALM sidebar, under Management, select Releases. On the Releases tree, expand
the release folder Mercury Tours Application and the release Release 10.5, and select
the cycle Cycle 1 - New Features. Click the Quality tab.
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b. Inthe Defect Opening Rate graph, you can see the defects detected in Cycle 1 - New
Features according to defect severity.

c. Inthe Outstanding Defects graph, you can see the outstanding defects in Cycle 1 - New
Features according to defect status.

Linking Defects to Tests

You can link a test in your test plan to a specific defect in the Defects Grid. This is useful, for
example, when a new test is created specifically for a known defect. By creating linkage, you can
determine if the test should be run based on the status of the defect. Note that you can also link the
defect to other entities, such as requirements.

A defect can be linked directly or indirectly to an entity. When you add a defect link to an entity,
ALM adds a direct link to this entity and indirect links to other related entities.

The following diagram illustrates the flow of indirect linkage:

Test Set
Run Step “ Test Instance

Forinstance, when you link a defect to a run step, it adds an indirect link to its run, test instance,
test set, and test. If the same test is covered by a requirement, an indirect link is also added to the
requirement. Note that the indirect linkage is a one-directional flow. For example, if you link a defect
toarun, itis not indirectly linked to its run steps.

In this exercise, you will link your defect to the Flight Confirmation test in the Test Plan module,
and view the linked test in the Defects Grid.

To link a defect to a test:
1. Display the Test Plan module.
On the ALM sidebar, under Testing, select Test Plan.
2. Select the Flight Confirmation test.

In the test plan tree, under Flight Reservation, expand the Flight Confirmation test subject,
and select the Flight Confirmation test. Click the Linked Defects tab.

3. Add alinked defect.

a. Inthe Linked Defects tab, click the Link Existing Defect arrow and choose Select. The
Defects to Link dialog box opens.
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|es Defects To Link [ = &J

Sv-I &=

Mo Filter Defined

_ Defect ID Detected Assigned To Status Summal
gEap By g y
ta 1 alice_alm james_alm Fixed The list of flig.
im 2 alice_alm james_alm Reopen The list of ava..
ta 3 alice_alm james_alm Cpen The list of flig..
] 4 alice_alm james_alm Closed Nothing happ..
B 5 alice_alm james_alm Open The list of flig..
Description
= Summary The list of flights is given even when past date set as departing date
Description Comments

¥

ST | BT U AahEEE =TT

3

3

BI UAay =

e

Test Set: Mercury Tours Functionality
Test: [1]Departing Date
Run: Run_9-2_10-26-57

Select the defect you added in "Adding New Defects" on page 109 and click the Link
button. Your defect is added to the Linked Defects grid.

Tip: If you cannot find your defect in the Defects to Link dialog box, click the Set
Filter/Sort arrow and choose Clear Filter/Sort to clear the filter that is applied to the
grid.

4. View the linked test in the Defects Grid.

d.

On the ALM sidebar, select Defects.

In the Defects Grid, click the defect ID of the defect you added in "Adding New Defects" on
page 109. The Defect Details dialog box opens.

Click Linked Entities on the sidebar, and select the Others tab. The Flight Confirmation
test is linked to your defect.

Click OK to close the Defect Details dialog box.

Creating Favorite Views

A favorite view is a view of an ALM window configured with the settings you applied to it. For
example, in the Defects Grid, you may want to apply a filter to display only the defects that were
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detected by you, are assigned to you, or have the status “Not Closed”.

In this exercise, you will create a favorite view in the Defects Grid.

To create a favorite view:

1. Make sure that the Defects module is displayed.

If the Defects module is not displayed, on the ALM sidebar, select Defects.

2. Define afilter to view defects you detected that are not closed.

a. Click the Set Filter/Sort button. The Filter defects dialog box opens.

-

Filter defects

=x=)

EARENE
No Filter Defined

Filter = Cross Filter

Field Name

View Order | Group

Filter Condition

i Actual Fix Time

Assigned To
Browser

Category

Closed in Version
Closing Date
Defect ID

Detected By
Detected in Cycle
Detected in Release
Detected in \VVersion
Detected on Date
Estimated Fix Time

Language

A

b. Forthe Detected By field, click the Filter Condition box. Click the arrow. The Select
Filter Condition dialog box opens.
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Select Filter Condition -
Condition: ||
Q| View by Group gr:d i
5 Name Full name ({
) _
. [CurrentUser] Not E
aa alex_alm =
& alice_alm < i
& bal >=
P+ cecil_alm =

Under Name, select the [CurrentUser] variable, or select your ALM login name from the
list. Click OK to close the Select Filter Condition dialog box.

For the Status field, click the Filter Condition box. Click the arrow. The Select Filter
Condition dialog box opens.

In the right pane, click the logical expression Not.

In the left pane, select Closed.

Condition: | Not Closed

Click OK to close the Select Filter Condition dialog box.

Click OK to apply your chosen filter. The Defects Grid displays the defects you detected
that are not closed.
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3. Add afavorite view.

a. Inthe Favorites menu, select Add to Favorites. The Add Favorite dialog box opens.

Add Favorite [&J

* Mame

| %
» & Prvate |
» B3 Public

ke

b. Inthe Name box, type: My detected defects (status ‘Not Closed’).

c. You can add a favorite view to either a public folder or a private folder. Views in the public
folder are accessible to all users. Views in the private folder are accessible only to the
person who created them. Select Private.

d. Click OK. The new favorite view is added to your private folder, and is displayed in the list
of recently used favorite views, located under the Private and Public folders.

Favorites  Analysis
|14 Add to Favorites...
! 1% Organize Favorites. ..

|7~ Private (B 77 My detected defects (status ‘Mot Closed).
& Public »

17 1 private: My detected defects (status ‘Mot Closed’).

4. Organize favorites.

a. Inthe Favorites menu, select Organize Favorites. The Organize Favorites dialog box
opens.
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e

Organize Favorites ﬁ

i My dete"cted defects (status ‘Not Closed’).
4 Public

Use drag and drop to move favorites and folders.

b. Double-click the Public folder.

c. Click the New Folder button. The New Favorite Folder dialog box opens.

is added as a sub-folder to the Public folder.

- &5 Private
7 My detected defects (status "Not Closed').

~ &5 Publi

ir QA Bug Verification

i QA Team Member - My Fixed and Rejected defects
7 R&D Team Member - Defects Assigned to Me

e. Drag the following favorites into the QA defects folder:
o QA Bug Verification
o QA Team Member - My Fixed and Rejected defects

f. Click Yes to confirm, and close the Organize Favorites dialog box.

HP ALM (12.00)

In the Favorite Folder Name box, type QA defects, and click OK. The QA defects folder
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You can instruct ALM to create alerts automatically and send emails to notify those responsible
when certain changes occur in your project that may impact the application lifecycle management
process. You can also add your own follow-up alerts.

To generate automatic notification alerts, your ALM project administrator must activate alert rules in
Project Customization. Alert rules are based on associations you make in ALM between
requirements, tests, and defects. When an entity in your project changes, ALM alerts any
associated entities that may be impacted by the change. The alerts can be seen by all users. ALM
also notifies the person responsible for the entity at the time of the change of any associated
entities that may be impacted by the change.

ALM also enables you to add your own follow-up flag to a specific requirement, test, test instance,
or defect to remind you to follow up on an issue. When the follow-up date arrives, ALM sends you
an email reminder.

In this lesson, you will learn about:

Trggering an Alert . 123
Creating Follow Up Alerts
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Triggering an Alert

When a requirement, test, test instance, or defect in your project changes, ALM can notify those
responsible for any associated entities. You can associate tests with requirements (see "Creating
and Viewing Coverage" on page 52) and defects with other ALM entities (see "Linking Defects to
Tests" on page 116). In addition, you can create traceability links between requirements. For more
information on creating traceability links between requirements, see the HP Application Lifecycle
Management User Guide.

ALM can generate alerts for these changes:

Which associated Who is

What changed? entities are flagged? notified?

Requirement (excluding change of Direct Cover Testg Test c.jesigners

Status and risk-based quality management fields) Requirements Requirement

authors

Defect status changed to Fixed Test instances Responsible
testers

Test ran successfully Defects Users
assigned to
defects

In this exercise, you will trigger alerts for tests by changing the associated requirement. You will
modify the View Reservations requirement and then you will view the flagged tests.

To trigger an alert:
1. Display the requirements tree.
a. Onthe ALM sidebar, under Requirements, select Requirements.
b. Inthe Requirements module, select View > Requirement Details.
2. Select the requirement that you want to change.
Under Reservation Management, select the View Reservations requirement.
3. View the associated tests.

To view the tests that will be impacted by the change, click the Test Coverage tab. The tab
displays the associated tests.

4. Change the priority of the View Reservations requirement.
a. Click the Details tab.

b. Click the down arrow adjacent to the Priority box and select 5-Urgent.
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Note: Version Control: If you are prompted to check out the requirement, click OK.

This change causes ALM to generate alerts for the tests associated with the requirement.
ALM also sends email notification to the designers of the associated tests.

Note: Version Control: Check in the new version of the requirement. Right-click the
requirement, and select Versions > Check In. Click OK to confirm.

5. View the alert for the Flight Confirmation test.

a. Inthe Test Coverage tab, click the link to the Flight Confirmation test. The test is
highlighted in the test plan tree.

Tip: If you cannot find the test in the test coverage grid, click the Set Filter/Sort arrow
and choose Clear Filter/Sort to clear the filter that is applied to the grid.

b. Click the Refresh All button.

@ &P Name
~ [ Subject
v JL Unattached
» [ Cruises
~ [=Flight Reservation
+ (3 Book Flight
~ [Flight Confirmatian
E» Flight Confirmation

» Flight Confirmation Nawvigation

= =
(=0 I =B =

o» Flight Confirmation Page
3 Print Confirmation
»  [E@Flight Cost
1y » EFFlight Finder
v 3 Select Flight
0 @ 2 Flight Reservation
%% Flight_Reservation
a # Flight_Reservation_Stress
3 ltinerary
8 Mercury Tours Site
£ Modeling
3 Payment Methods

»

- v w v

The Flight Confirmation test has an alert flag @, indicating that a change was made to an
associated requirement.

c. Click the Alerts flag for the Flight Confirmation test. The Alerts dialog box opens.
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0 Alerts

Be

Alerts for test <Flight Confirmation=

- Associated require... ~ Generate at 10/27/2013 11:46:18 AM X

1 »

In the requirement View Reservations associated with this test
the Version Status changed to "Checked In" [Motified user is
[alice alm]]. It is recommended that vou review this test. hd

1

The alert indicates the requirement and the change that triggered the alert. It also indicates
the name of the person to whom ALM sends email notification of this change.

Note: Version Control: The alert states that the version status has changed to
Checked In. It does not indicate which fields have been modified. You can then
compare the new version with the previous version.

d. Click OK.
6. View the alerts of the other associated tests.

In the test plan tree, view the alerts of the following tests: Itinerary > Itinerary Page and
Itinerary > View Reservations > Review Reservations.

Creating Follow Up Alerts

ALM enables you to add your own alerts to remind you to follow up on outstanding issues. In this
exercise, you will add a follow-up flag to a defect whose status you want to check one week from
today.

When you add a follow-up flag, ALM also adds an information bar that reminds you about the follow-
up alert. When the follow-up date arrives, ALM sends you an email reminder, and changes the flag
icon from gray to red.

Follow-up flags are specific to your user name, meaning that only you can see your follow-up alerts.

To create a follow up alert:
1. Display the Defects module.
On the ALM sidebar, select Defects.

2. Select the defect that you want to flag with a follow up reminder.
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In the Defects Grid, select a defect.
3. Create the follow up alert.

a. Click the Flag for Follow Up button. The Flag For Follow Up dialog box opens.

Flag For Follow Up w

Follow up by: | 10/27/20713 v

Description:

b. Perform the following:
Follow up by: Select the date one week from today.
Description: Type: Remind me about this defect on this date.

c. Click OK. The flag icon is added to the defect record.

Defects Edit View Favorites Analysis

T MewDefect.. 8|S T~ [V P+ =2-aqi-&|E @
Mo Filter Defined

_ Actual Fix... Assigned To Browser Category Closed in...
U ek
0o mary_alm Defect
0@ mary_alm Defect
o peter_alm Defect
! 3 peter_alm Defect
Im mary_alm Defect
o Defect
! Defect
! Defect
0@ alice_alm
U
!
g mary_alm Defect
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ALM reports and graphs help you assess your application lifecycle management process. You can
generate reports and graphs at any time during the process.

Project reports enable you to design and generate versatile reports containing information from the
ALM project.

You can create graphs or project reports either in the Analysis View module, or during your work in
the Requirements, Test Plan, Test Lab, Business Components, or Defects modules. In either
case, you can save the graphs and reports in the Analysis View module for future reference.

Using the Dashboard View module, you can also create dashboard pages that display multiple
graphs side-by-side.

In this lesson, you will learn about:

Generating Project Reports il 128
Generating Grapns ... 133
Generating Entity Graphs in the Analysis View Module ... ... . ... ... ... 133
Generating Business View Graphs in the Analysis View Module _............................ 139
Generating Predefined Graphs ... 144
Sharing Graphs il 146
Generating Business View Excel Repomts ... .. . 147
Generating Dashboard Pages . .. ... L 152
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Generating Project Reports

Project reports enable you to compile versatile reports of project data.

In a project report, you define sections and sub-sections, each listing records of a specified ALM
entity.

To each report section, you assign a template that determines the fields and layout of the section.
You also assign document and style templates that determine the overall report appearance.

In this exercise, you will create a report of tests with their linked defects.

To generate a project report:
1. Openthe ALM_Demo project.

If the ALM_Demo project is not already open, log in to the project. For more information, see
"Starting ALM" on page 16.

2. Display the Analysis View module.
On the ALM sidebar, under Dashboard, select Analysis View.
3. Add afolder to the Private root folder.
a. Inthetree, select the Private folder.
b. Click the New Folder button. The New Folder dialog box opens.
c. Under Folder Name, type My_Analysis_ltems.

d. Click OK. The new folder is added as a sub-folder of the Private folder. The Details tab
displays the folder name and the user who created the folder.

e. Inthe Description tab, type This folder includes my demo analysis items.
4. Create a project report.

a. Click the New Item button and select New Project Report. The New Project Report
dialog box opens.

b. Inthe Project Report Name box, type Reviewed tests and linked defects.

c. Click OK. A new project report is added to the folder you created. Notice that the 1icon
represents a project report.
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The Configuration tab is selected.
Details Configuration View

B ¥ | M & | [Q Preview B Generate & Download AsZip | Z] Template Creator

»

Document Document Output Options
Output Format : HTML hd
Document Templates
Document Template : | Document Template v | i ,

Style Template : Style Template ~| &

m

Histary Template : Histery Template ~| &
Document Additional Options
@ Auto-Update Tzble of Contents
Embed Text and Image Attachmenis

Select a Baseline

5. Add amain section to report.
a. Click the Add Report Section button. The Add Report Section dialog box opens.
b. Under Type, select Tests. The default section name Tests displays in the Name field.

Add Report Section ﬁ

Type
=E v

Name

Tests

c. Click OK. The Tests section is added to the report tree, under the Document root folder.
6. Add a sub-section to the report.
a. Inthe report tree, right-click the Tests section, and select Add Report Section.
In the Add Report Section dialog box, you can select an entity related to the main section.
b. Under Type, select Defects. The Relationship field describes the nature of the

relationship between the tests and defects. The default section name Linked Defects
displays in the Name field.
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Add Report Section &J

Type

Defects v
Relationship

Linked Defects o
Name

Linked Defects

c. Click OK. The Linked Defects section is added to the report tree, under the Tests section.
7. Configure document settings.

a. Inthe report tree, select the Document root node.

Details | Configuration View

——
BN @ Preview gl Generate ~ Download As Zip | ] Template Greator

- Document Diocument Output Options i
7 Tests Output Format -
Linked Defects put Form, HTML d

Document Templates
Document Template : | Document Template v ia ,
Style Template : Style Template v ia
History Template : History Template v ia £

Document Additional Options :

@ Auto-Update Table of Contents
Embed Text and Image Attachments

Select a Baseline

b. Inthe right pane, in the Output Format field, select PDF.

c. Under Document Templates, you assign templates that affect different areas of the

report.
Template
Type Description
Document Defines fields on the title page, headers and footers, page orientation,
Template and other document layout settings.
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Template
Type

Style
Template

History
Template

Description

Defines formatting of report elements. For example, tables, headings,
and paragraphs.

Defines the style in which history information is displayed in report
sections.

Default templates are assigned to the different template types. Additional templates can be
designed by the project administrator in Project Customization.

d. Click the Edit Document Field Values button alongside the Document Template field.
The Edit Document Template Field Values dialog box opens.

Edit Document Template Field Values ﬁ

Choose A Field

Field Names

Field Value

Project
Titlel
summary
Author

Project -

The dialog box enables you to type values for fields in areas such as the title page, headers
and footers, as defined in the document template.

e. Foreach field name, type the following values:

Field Name
Project
Title1
summary

Author

f. Click OK.

HP ALM (12.00)

Field Value

ALM Demo Project

Interim Report

An interim report of reviewed tests and their linked defects.

Alex ALM
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8. Configure the Tests report section.

a. Inthe report tree, select the Tests section.

Detsils | Configuration | View

B ¥ | M & | & Preview B Generate & Download As Zip | 1&] Template Creator

- Document Report Section Details
- ffests

Uinked Defects Name : Tests

Entity : Tests
Relationship Type None
Template Details
® Project Template : Test Template
Custom Template
Na Template (This section is for relationship purpeses anly)
Filter
T

=g

Graph Selection

W select [yl New 3¢

b. Under Report Section Details, in the Name field, rename the section Reviewed Tests.

The section name is used as the section title in the report.

c. Under Template Details, make sure Project Template is selected.

d. Click the arrow, and select Test Template created by Alice. The template you assign to
the section determines the section format, and the entity fields displayed in the section.

e. Under Filter, click the Set Filter/Sort button. The Filter Tests dialog box opens.

f. Click the arrow adjacent to the Reviewed field.

g. Inthe Select Filter Condition dialog box, select Reviewed, and click OK.

h. Click OK to close the Filter Tests dialog box.
9. Configure the Linked Tests report section.

a. Select the Linked Defects section.

b. Click the arrow alongside Project Template, and select Defect Tabular Template.

Tabular templates display records in rows of a table.

10. Generate the report.
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Click Generate. A dialog box opens, displaying the progress of the report generation.

When the report is ready, a PDF reader opens, displaying the report results.

Generating Graphs

You can create graphs in the Analysis View module, that display data from the Requirements, Test
Plan, Test Lab, Business Components, and Defects modules. You can also create predefined
graphs directly from the Requirements, Test Plan, Test Lab, Business Components, and Defects
modules. In either case, you can use a graph wizard to guide you through the stages of creating a
graph.

You can create two types of graphs, entity graphs or business view graphs. Entity graphs display
data directly from the various modules. Business view graphs are based on project entities, and
ensure that only information that is relevant to a business consumer is contained in the graph.

After creating a graph, you can share the graph for viewing in a Web browser outside ALM.

This section includes:

Generating Entity Graphs in the Analysis View Module ... ... . ... . ... 133
Generating Business View Graphs in the Analysis View Module .......... ... ... ... ............ 139
Generating Predefined Graphs ... . . o . 144
Sharing Graphs . 146

Generating Entity Graphs in the Analysis View
Module

In the Analysis View module, you can create graphs and configure them according to your
specifications. You can also create a graph using the graph wizard. The graph wizard takes you
through the steps involved in creating a graph and defining its settings.

You create graphs in either a public folder or a private folder. Graphs in a public folder are
accessible to all users. Graphs in a private folder are accessible only to the user who created them.

In this exercise, you will use the graph wizard to generate an entity graph that summarizes the
defects by status and priority level.

To generate an entity graph in the Analysis View module:
1. Make sure the Analysis View module is displayed.

If the Analysis View module is not displayed, on the ALM sidebar, under Dashboard, select
Analysis View.

2. Open the graph wizard.
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Click the New Item button and select Graph Wizard. The graph wizard opens to the Select

Graph Type page.

-

Step 1 of 5: Select Graph Type

)

7
Application
L#ePtytle
Management
Graph wizard

a\

-

Graph Type

Business View Graph

Defects - Summary Graph

o W Closed
P 35
£ = M Fixed
=
g W rew
=} 25
B g 18 B open
E N 12 M Rejected
5- Reopen
o
; 0 . 0 & '
N -
I 82 ¢ 3
-k 2
=
v
Assigned To

3. Select the graph type.

Select Entity Graph.

4. Select the entity type.

a. Click Next. The Select Entity Type page opens.

Step 2 of 5: Select Entity Type (2o
Entity:
@ Defects - Defects - Summary Graph
npplicatiun Graph Type
Lifecycle B @ - I Closed
Management ® Summary Graph . £ M Fixed
raph
Graph wizard Progress Graph % s W Hew
=
Trend Graph é 18 M Cpen
12 M Rejected
Age Graph . I efecte
5 I Reopen
\ Description Pt -
The Defects - Summary Graph shows a summary of the number 'i é ;t', g s g
of defects in a project. or the estimated/actual amount of time § E 2 sel K4
taken to fix these defects. The information is displayed - & §
according to the criteria that you specify. You can specify the g
type of data displayed along the x-ads, the type of data v
displayed along the y-ads, and the defect infformation by which Assigned To
data is grouped.
~

b. Under Entity, select Defects.

c. Under Graph Type, make sure Summary Graph is selected.
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5. Select the projects to include.

Note: If you are using HP ALM Essentials Edition, ignore this step.

a. Click Next. The Select Projects page opens.

Step 3 of 5: Select Projects u

@ Project Selection Defects - Summary Graph
® Use Current Project

Application
Lifecycle Use Selected Projects a1 - Closed
Management 8 0= W Fixed
Graph wizard Domain Project § H New
s
DEFAULT  ALM_Demo z ™ v = B open
5 10 12 M Rejected
\ 5 I Reopen
o =
Y I
BEERE
- £ 3
7
Assigned To

|l [ concel | <gack | wem> | ey

b. You caninclude data from multiple projects in the graph. For this exercise, we will use only
the current project. Make sure Use Current Project is selected.

6. Define afilter to view defects with high to urgent priority.
a. Click Next. The Select Filter page opens.

Step 4 of 5: Select Filter e S

Filter Selection
@ @E X Defects - Summary Graph

nl pr :';:lgm Define a new filter a Closed
m 38
Management 8,2 B Fied
Graph wizard § W New
e 25
5" 18 M Open
5 3 12 M Rejected
\ 5 I Reopen
s -
' . ' b .
- a =W [
B EERE
- % 3
7
Assigned To

|l [ concel | <gack | wem- | uep

b. Under Filter Selection, select Define a new filter. Click the Filter button. The Filter
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defects dialog box opens.

c. Click the down arrow adjacent to the Priority field. The Select Filter Condition dialog box
opens.

d. Intheright pane, select the logical expression >=.

e. Intheleft pane, select 3-High. The condition appears as follows:
Condition: | »=3-High

f. Click OK to close the Select Filter Condition dialog box.
7. Define afilter to view defects that are not closed.

a. Click the down arrow adjacent to the Status field. The Select Filter Condition dialog box
opens.

b. Inthe right pane, select the logical expression Not.

c. Inthe left pane, select Closed. The condition appears as follows:

Condition | Not Closed

d. Click OK to close the Select Filter Condition dialog box.
e. Click OK to close the Filter defects dialog box.
8. Set the graph attributes.

a. Click Next. The Select Graph Attributes page opens.

Step 5 of 5: Select Graph Attributes ﬂ
@ Group By field: Defects - Summary Graph
<MNane= v
Application
Lifecycle X-axis field: 8 = Closed
Management - 8, = W Fixed
Graph wizard Assigned To w § —_—
E 1 w M Open
5 12 W Rejected
\ 5. I Reopen
L4+ & s
Lt 3 8 % §
i : = 4 3z
- & 2
7
Assigned To
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b. Under Group By field, make sure that it is set to <None>.
c. Under X-axis field, select Priority to view the number of defects by priority.
9. Generate the Graph.

Click Finish. The graph is displayed in the graph window.

- .
[ Defects Summary Graph - by Priority’ ESRRE %™
Bore: WO B OO|nealAEd BB |

Defects Summary Graph - by "Priority”
9 | <Total>
|
§ 6
5
(=1
5
E
E
5
=
3
1
= = E
S £ )
oh = 3
z B i
-+
Priority
Last Generated (Local Time): 10/3002013 8:23:43 AM
Add to AnalysisTree | Cancel | Help |

.

The graph shows a summary of defects with High to Urgent priority, whose status is not
Closed.

10. Save the graph in the Analysis View module.
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a. Click Add to Analysis Tree. The New Graph dialog box opens.

[ik] New Graph

-

= ] | )

Graph Name:
Defects Summary Graph - by Priority’

Select Folder

b. Expand the Private folder, and select My_Analysis_ltems.

c. Click Save. The Defects Summary graph is saved in the analysis tree, and displayed in the

View tab.

11. Display additional defect details.

a. Click abarin the graph. The Drill Down Results dialog box opens and displays the defects

that belong to the bar.
f R
[is] Drill Down Results = | (B e S—-
My_analysis_items Chart Drill-Down. X-fds: 3-High, Group-By: <Total>, Number of items: 5 & [[ﬂ E‘
lE] tap Defect ID Actual Fix Time Assigned To Browser Category Closedin...
om 1 james_alm Internet Explorer.. Defect
Bm 3 james_alm Defect
0 z peter_zlm Defect
m o mane =lm Mcfart
Description: Comments:

Test Set: Mercury Tours Functionality
Test: [1]Departing Date

Run: Run_8-2_10-26-57

Step: Step 1: Past Departing Date

Description:
1. Select the One Way option.

Check each of the following possibilities:
- Previous maonth, any date selected.

»

m

2. Forthe departing flight, select any past date.

b. Close the Drill Down Results dialog box.

12. Display other graph views.
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a. Click the Pie Chart button to display the graph as a pie chart.

b. Click the Data Grid button to display the data as a grid.

Generating Business View Graphs in the Analysis
View Module

In this exercise, you will use the graph wizard to generate a business view graph that summarizes
the requirements by status and priority level.

To generate a business view graph in the Analysis View module:
1. Make sure the Analysis View module is displayed.

If the Analysis View module is not displayed, on the ALM sidebar, under Dashboard, select
Analysis View.

2. Open the graph wizard.

Click the New Item button and select Graph Wizard. The graph wizard opens to the Select

Graph Type page.

Step 1 of 5: Select Graph Type (X
@ Tasts Broken by Requirements
Application Eni

tity Graph »
Lifecycle mHbyarep > = alex_alm
Management 1 alice_alm
Crapn wizard i = michas sim
5180 - M shelly_aim
5 -]
\ o 17 Py : —-
i ff g
2 5 w
: c
a
Requirement Types

3. Select the graph type.
Select Business View Graph.

4. Select the business view.
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a. Click Next. The Select Business View page opens.

Step 2 of 5: Select Business View u
@ | Filter: Tests Broken by Requiremeants
.. Defects_history [Defects_history)
Application - -
Lifecycle [ Release Cycles (Release_Cycles) S alex_ale
Ha“ame“t H Releases (Releases) : ""5:-':"'
Graph wizard cecti_am
[ RelessesindCycles (ReleasesfndCycles) ﬁ : “‘r:[;:“'—la'"‘
; : 180 shedly_alm
=] ‘Requirements (Requirements) 5 L |
3 Reguirements Authored by me (Requi t E l . ﬁ
7 s
\ [ Reguirements Coverage (Requirements_Cov [} - ¢ wm
a = @
[ Requirements Traced From (Requirements_T -i g g 5 g
H Reguirements Traced To (Reguirements_Tra E 3 a .
[ Reguirements With Linked Defects (Require a
[ Requirements ‘with Target Releases (Require Requirement Types.

[

[ T DU PRSP S . NS PRSI SR

b. Select Requirements.

5. Select the projects to include.

Note: If you are using HP ALM Essentials Edition, ignore this step.

a. Click Next. The Select Projects page opens.

Step 3 of 5: Select Projects ]
Project Selection
@ Tests Broken by Requirements
(® Use Current Project
Application )
Use Selected Projects 0
Lifecycle = e = alex_aim
Management W alice_aim
M cecil_alm
Graph wizard Domain Project ﬁ W michasi_alm
DEFAULT Demo ™ - M shelly_slm
E l 2
e
\ P e
§ £ 2 ¢ £
g 5 Y & ¢
g (™
a
Requirement Types

-

b. You can include data from multiple projects in the graph. For this exercise, we will use only
the current project. Make sure Use Current Project is selected.

6. Define afilter to view requirements with high to urgent priority.
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a. Click Next. The Select Filter page opens.

Step 4 of 5: Select Filter |
@ w | By E] Tests Broken by Requirements
Applicatiun Mo filter was defined. -

§ o 333
Lifecycle Field Name 2 Criteria 1 alex_alm
Hanagement i alice_alm
Graph wizard ozl o % ceolain
Parent Reg Name Em} ] ::2::!;::"‘
Priority 5 | }
Product E I o8
17 A
\ ReqID o 5 mm
% a > o
Reg Name g g z 5 :
a 3 8
Req Order 1D E E @
Req Path E
Req Type D Requirement Types

Req Tvpe Name

el | Gmcel | <Back | Nem> | Hep

b. Click the down arrow in the Criteria column adjacent to the Priority field. The Select Filter
Condition dialog box opens.

c. Intheright pane, select the logical expression >=.

d. Inthe left pane, select 3-High. The condition appears as follows:
Condition: = 3-High

e. Click OK to close the Select Filter Condition dialog box.
7. Define afilter to view defects that are not closed.

a. Click the down arrow in the Criteria column adjacent to the Reviewed field. The Select
Filter Condition dialog box opens.

b. Inthe left pane, select Not Reviewed. The condition appears as follows:

c. Click OK to close the Select Filter Condition dialog box.

8. Set the graph attributes.
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a. Click Next. The Select Graph Attributes page opens.

Step 5 of 5: Select Graph Attributes (e
Hofods
@ Tests Broken by Requirements
Reg ID v
Application Yofods -
: 380
Lifecycle alex_alem
Management Count i o alice_slm
B cecil_alm
Graph wizard Grouped By: l michael_alm
M shelly_alm
<Meone: w

w

D\

M.lnberﬁtestﬁ
a3
runcronat [ I &
Testing IIg

Group - e
Sacurity l

Business Model

Requirement Types

el | Gncel | <Back | Finisn | Hep

b. Under X-axis, select Priority and under Y-axis, select Count to view the number of
requirements by priority.

c. Under Grouped By, make sure that it is set to <None>.
9. Generate the Graph.

Click Finish. The graph is displayed in the graph window.
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(3, Requirements [E=R =)

Naa [ en| B |

glGenerate||I| 2 = @|@ ]

@ «Total=

Murnber of rows

Sth- a
§4-VGW Hhh- &11 g

E
o
=
3
']

Last Generated (Local Time): 10/30/2013 9:56:22 AM

[ id o Analysis Tree | Cancel | Help ]

The graph shows a summary of requirements with High to Urgent priority that have not been
reviewed.

10. Save the graph in the Analysis View module.
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a. Click Add to Analysis Tree. The New Business View Graph dialog box opens.

[0}, New Business View Graph E@ﬂ—hj

Business View Graph Name:

Feguirements

ot

k Private
» Public

b. Expand the Private folder, and select My_Analysis_ltems.

c. Click Save. The Requirements graph is saved in the analysis tree, and displayed in the
View tab.

11. Display other graph views.

a. Click the Pie Chart button to display the graph as a pie chart.

b. Click the Data Grid button to display the data as a grid.

Generating Predefined Graphs

You can create predefined graphs during your work in the Requirements, Test Plan, Test Lab,
Business Components, and Defects modules. Predefined graphs enable you to create several
types of graphs in each module, using the existing module filter. You can use predefined graphs for

one-time reference, or save them in the Analysis View module, where you can continue to configure
their data and appearance.

In this exercise, you will generate a summary graph from the Defects module.
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To generate a predefined graph:
1. Display the Defects module.
On the ALM sidebar, select Defects.
2. Clearthe Defects grid filter.

Click the Set Filter/Sort arrow, and choose Clear Filter/Sort to clear the filter that is applied
to the grid.

3. Generate areport.

Choose Analysis > Graphs > Defects Summary - Group by Status. The graph window
opens, displaying the selected graph.

[ (] Defects Summary - Group by 'Status’ E@g
Foreat: I @ EH| 0 0| @& |BEL-3 B

Defects Summary - Group by "Status’

14 14
W Closed
Fixed
Mew
M Cpen
W Rejected
3 Reopen

alice_aim”
peter_akn”

Murnber of Defedts
[=] S [=] FS
I o
o am.. -I i
w am._l

<unknownz

Assigned To

Last Generated (Local Time): 1003002013 10:03:00 AM

[1dd o AnalysisTree | _Concel | ety |

The graph shows the number of defects that exist in your project, according to the people to
whom they are assigned. Defects in the graph’s columns are grouped according to their status.

4. Close the graph window.

Click the Cancel button.
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Sharing Graphs

You can allow ALM users or others to view read-only versions of graphs outside ALM. Each time
you access the graph outside ALM, it displays the most up-to-date information.

In this exercise, you will share the Defects Summary graph you created in the Generating Entity
Graphs in the Analysis View Module exercise.

To share a graph:
1. Display the Analysis View module.
On the ALM sidebar, under Dashboard, select Analysis View.
2. Share the Defects Summary graph.

a. Inthe Private folder, under My_Analysis_ltems, select Defects Summary Graph -
Group by ‘Priority’.

b. Right-click and select Share Analysis Item. The Share Analysis Item dialog box opens.

Share Analysis [tem ﬁ

You can share analysis items by copying an analysis tem URL, and pasting the link in a website or email. Clicking the
|URL opens the analysis tem directly in @ web browser, without having to download the application client.

* Copy Analysis tem URL {Authentication Required)

Sharing the Analysis tem Address enables users to view a read-only version of the analysis tem directhy in their
browser window. To view the analysis item, users are reguested to enter their name and password.

" Copy Analysis kem Public URL

Sharing the Analysis tem Public Address enables others to view a read-only version of the analysis tem directhy in
their browser window. Mo authentication is required to view the analysis tem.

" Reset Analysis tem Public URL

c. Select Copy Analysis Item Public URL. This option allows others to view the graph
without entering ALM user credentials.

d. Click OK. A URL of the graph is saved to the clipboard.

3. View the graph outside ALM.
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a. Open aWeb browser window.

b. Inthe address bar, paste the clipboard content, and press ENTER. The graph is displayed
in the Web browser.

Defects Summary Graph -By Priority

Mumber of Defects

# <Total>

5
I
” g
%
-

Priority

Last Generated: 10/30/13 1:06:57 PM
Goto graph in Application Lifecycle Management

Below the graph, the Last Generated date and time is displayed, and a link to the itemin
ALM.

Generating Business View Excel Reports

You can create Excel reports based on business views. A business view is a data layer that exists
on top of the database and which reflects only those project entity fields that represent information
that is useful from a business perspective. Business views can be based on single entities, such an
Baselines or Defects, while others can represent more complex relationships between entities,
such as Defects With Linked Requirements.The reports are created and configured in Microsoft
Excel, and uploaded to the Analysis View module.

In this exercise, you will use Microsoft Excel to generate a business view Excel report that

summarizes the defects by status and priority level.

Note: The HP ALM Business Views Microsoft Excel Add-in supports only Microsoft Excel
2010 (32-bit) and Microsoft Excel 2013 (32-bit). If you are using a different version of Microsoft
Excel, proceed to "Generating Dashboard Pages" on page 152.
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To generate a business view Excel report in the Analysis View module:

1. Make sure the Analysis View module is displayed.

If the Analysis View module is not displayed, on the ALM sidebar, under Dashboard, select
Analysis View.

2. Create anew business view Excel report.

a. Inthe Private folder, select the My_Analysis_ltems folder.
b. Click the New Item button and select New Business View Excel Report. The New
Business View Excel Report dialog box opens.
c. Inthe Business View Excel Report Name box, type High Priority Open Defects.
d. Click OK. A new business view Excel report is added to the folder you created. Notice that
the X icon represents a business view Excel report.
The Configuration tab is selected.
Details | Configuration Wiew
El Generate 'L.'Q Mew Excel |_i| Install Addin =
Excel File
File name : 4+
(i) Ewcel report cannot be generated until an excel file is uploaded.
3. Open Excel.
a. Click Install Addin. The HP ALM Business Views Microsoft Excel Add-in is installed in
Excel.
b. Click New Excel. Microsoft Excel opens with the HP ALM tab in the ribbon.
c. Inthe HP ALM tab, click Login. The ALM login window opens. Log in exactly as you

logged in to ALM at the beginning of the tutorial.

4. Generate the business view report in Excel.

HP ALM (12.00) Page 148 of 184



Tutorial
Chapter 8: Analyzing ALM Data

a. Click Add. The Add Worksheet dialog box opens.

Add Worksheet =S

Select one or more business views for the report workshests:

Filter: b

- Business Views

H Baselines (Baselines)
Components [Compaonents)
Defects (Defects)
Defects Assigned to me (Defects_Assigned_to_me)
Defects With Linked Defects (Defects_with_Linked_Defects)
Defects \with Linked Requirements [Defects_\with_Linked_Req
Defects \with Linked Tests (Defects_with_Linked_Tests)
Defects With Mo Linked_Req (Defects_With_Mo_Linked_Req)
Defects_history (Defects_history)
Release Cycles (Release_Cycles)
Releazes (Feleazes)

ReleasesfndCycles (ReleasesAndCycles)

Remuramentz (Remiorements

Description:

b. Select Defects.

c. Click OK. A new business view Excel worksheet is added and the Worksheet
Configuration pane is opened.
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Worksheet Configuration - X
Fields Filter | Sorting | Advanced

Select fields to be included in the current workshest:
Defects Fields: Selected fields:

Defect 1D

Summary

Description

Priority

Severity

Status

Estimated Fix Time
Actual Fix Time
Assigned To

Comments

Detected By

Detected in Version
Detected in Release Name
Detected in Release 1D
Detected in Cycle Name
Detected in Cycle 1D
Detected on Date

Has Change

Closed in Veersion
Cloging Date

Planned Cloging Version
Target Release Name
Target Release D
Target Cycle Mame
Target Cycle ID
Subject Name

Subject 1D

Project

Reproducible?
Bxdended Reference
TestSet Reference
Modified

&«

(i) To change columns order, drag and drop the columns in Excel table.

5. Configure the business view report.
a. IntheFilter tab, select Priority in the Field Name column.

b. Inthe associated Criteria column, click the arrow. The Select Filter Condition dialog box
opens.
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c. Click 4-Very High, Or, and 5-Urgent.
d. Click OK.
e. Select Status in the Field Name column.

f. Inthe associated Criteria column, click the arrow. The Select Filter Condition dialog box
opens.

g. Click Not, Closed, And, Not, and Rejected.

h. Click OK. The business view Excel report shows only those defects whose priority is Very
High or Urgent and whose status is not Closed and not Rejected.

6. Save the new report in ALM.

a. Click Save and select Save to ALM. The Save Business View Excel Report dialog box
opens.

F =

[% Save Business View Excel Report = | B .

Business View Excel Report Name:

Book4

ot
» BEF FPrivate

» B Public

A

b. Inthe Select Folder box, browse to the My_Analysis_ltems folder and select the High
Priority Open Defects report. The Business View Excel Report Name box is automatically
valued with High Priority Open Defects.

c. Click Save.

d. Click Yes in the Replace Confirm message. The report is saved to ALM.

7. Generate the report in ALM.

a. Return tothe Analysis View module in ALM.

b. Click Refresh. The High Priority Open Defects report is selected with the Configuration tab
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open.
c. Click Generate. The Download Excel File dialog box opens.

d. Browse to the location on your client machine where you want to save the Excel report,
enter High Priority Open Defects in the File name field, and click Save.

The report opens in Excel with the latest data included.

Generating Dashboard Pages

Using the Dashboard module, you can arrange and view multiple graphs on a single dashboard
page. You select the graphs to include in the dashboard page from the graphs in the analysis tree.
You can arrange and resize the graphs on the page.

You create dashboard pages in either a public folder or a private folder. Dashboard pages in a
public folder are accessible to all users. Dashboard pages in a private folder are accessible only to
the user who created them.

In this exercise, you will create a dashboard page for the defect graphs in the public folder.

To generate a dashboard page:
1. Display the Dashboard View module.
On the ALM sidebar, under Dashboard, select Dashboard View.
2. Add a page to the Public folder.
a. Inthe tree, select the Public folder.
b. Click the New Page button. The New Dashboard Page dialog box opens.
c. Inthe Dashboard Page Name field, type Summary of Defects page.
d. Click OK.A dashboard page is added to the dashboard tree under the Public folder.
3. Select the graphs that you want to include in the dashboard page.
a. Click the Configuration tab.

b. Inthe Graphs Tree pane, expand the Public folder.

HP ALM (12.00) Page 152 of 184



Tutorial
Chapter 8: Analyzing ALM Data

c. Expand the Defects folder. The folder includes four graphs.

Graphs Tree

a B &S
Filter: Type["BVGraph™ OR "Graph™]
» E& Private
- Public
* Bl Business Views
- Defects
[l Unresclved Defects (all themes) Per Cycle
[i] Unresclved Defects (all themes) Per Person
[ Unresclved Defects (zll themes) Per Severity
[l Unresclved Defects (all themes) Per Subject
* Bl Excel Reports
4 Requirements
» B3l Tests Execution
» B3 Themes
[l Active Defects (all themes)
[ Scorecard Release 10.5 -QA (Mo Target Values)

d. Double-click the first graph. A placeholder for the graph is created in the Configuration tab

displaying the graph’s title.
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e. Add the other three graphs to the dashboard page.

Details | Configuration Wiew

- Graphs Tree

1 b
Unresolved Defects (al alB o
themes) Per Cycle
Filter: Type[ B\VGraph™ OR "Graph™]
» Private
= + = Public
Unresolved Defects (all - .
themes) Per Person Business Views
- Defects
[h] Unresclved Defects (all themes) Per Cy
21 [] Unresclved Defects (zll themes) Per Per
Unresolved Defects (all 1 lved Defects (all th Per Se
themes) Per Severity [in] Unresohv (all themes) Per
[ia] Unresclved Defects (all themes) Per Su
r Excel Reports
sle r Reguirements
Unresolved Defects (all i k Testa Execution
themes) Per Subject 2 R ™
G Themes

(] Active Defects (all themes)
[ Scorecard Release 10.5 QA (No Target V

4. Rearrange the dashboard page.

a. Select the second placeholder and drag it upwards so that it is alongside the first
placeholder.
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b. Select the fourth placeholder and drag it upwards so that it is alongside the third

placeholder.

Details

o

Configuration

=iz

Unresolved Defects (all themes) Per Cycle
Person

=iz

Unresolved Defects (all themes) Per

Severty Subject

5. View the dashboard page.

Unresolved Defects (all themes) Per

Unresolved Defects (all themes) Per

Graphs Tree

(=]

Q| E
Filter: Type['BVGraph™ OR "Graph’]
+ B Private
- Public
+ B Business Views
- Defects
[s] Unresclved Defects (zll themes) Per Cycle
[s] Unresclved Defects (all themes) Per Person
[is] Unresclved Defects (all themes) Per Severity
[is] Unresolved Defects (all themes) Per Subject
4 Excel Reports
» B3 Requirements
» 3 Tests Execution
» B3 Themes
[is] Active Defects (all themes)
[ Scorecard Release 10.5 QA (Mo Target Values)

a. Click the View tab. ALM generates and displays the graphs in the View tab.

Details Configuration Wiew

Summary of Defects page

Unresolved Defect... themes) Per Cycle

#

£ 30 2

= |

520

g 10

E 1 1 3

ER
£
=
2
H]
£
E]
E

Cycle 3 a - Saniy[1003]
Cycle 4 a - Ful[1004]

Yok 2 - Mew. ession[1002]

&
Detected in Cycle

Last Generated (Local Time): 10/20/2013 1:52:47 PM

Unresolved Defects...mes) Per Severity

12 1
10

g9

2

17}

=] [

5 6

C

5

g

5 3

Z3 2

o
2 H 3 o ]
H = 3 T T
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The dashboard page displays the unresolved defects per cycle, per person, per severity,
and per subject.

b. To view the dashboard page in full-screen mode, click the View Page in Full Screen
button, located in the upper-right corner of the page.

c. Toreturn to the standard view, click the Close button, located in the upper-right corner of
the page.

HP ALM (12.00) Page 156 of 184



Chapter 9: Creating Libraries and
Baselines

A library represents a set of entities in a project and the relationships between them. The entities in
a library can include requirements, tests, test resources, and business components. A baseline is a
snapshot of the library at a specific point in time. Baselines enable you to keep track of changes
made to your project over time.

You create libraries in the Libraries module.

You can compare baselines at all stages of the application lifecycle management process. For
example, you can compare two baselines in a library to review changes made to tests in the library
over time. You can also compare a baseline to the current entities in the library.

In this lesson, you will create a library of tests and requirements. You will then compare two
baselines in the library to review changes made to tests in the library over time.

Note: This lesson is not available for HP ALM Essentials Edition.

In this lesson, you will learn about:

Creating Libranies il 158
Creating Baselines . ... L 159
Comparning Baselines ... . 161
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Creating Libraries

In this exercise, you will add a library of tests and requirements to ALM. To perform this exercise
you must log in as alex_alm.

To create a library:
1. Make sure tologinto ALM_Demo as alex_alm.

Open the HP ALM Login window. In the Login Name box, type alex_alm. Skip the Password
box.

For more information, see "Starting ALM" on page 16.
2. Display the Libraries module.

On the ALM sidebar, under Management, select Libraries.
3. Create a library folder.

a. Inthelibraries tree, select the root Libraries folder. Click the New Folder button. The New
Library Folder dialog box opens.

b. Inthe Library Folder Name box, type Folder1.
c. Click OK. The Folder1 folder is added to the libraries tree.

d. Inthe Description box in the right pane, type the following description for the library folder:
This folder contains a library of tests and requirements.

4. Add alibrary to your library folder.
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a. Click the Create Library button. The New Library dialog box opens on the Content page.

) New Library =l

X |9 R %

=lame:

2 Details Requirements = Resources | Components | Tests

i | Content
ST

+ B3 Requirements

b. Inthe Name box, type Library1.

c. Inthe Requirements tab, expand the Requirements root folder. Select the check box
adjacent to the Mercury Tours Application folder, to include the folder in the library.

d. Click the Tests tab. Make sure the Tests in selected folders option is selected. Expand
the Subject root folder, and select the Mercury Tours Site folder to include in the library.

e. Click Details on the sidebar. In the Description box, type This library includes tests and
requirements.

f. Click OK. The new library is added to the libraries tree.

Creating Baselines

A baseline is a snapshot of your library at a specific point in time. You can use a baseline to mark
any significant milestone in the application lifecycle management process. A baseline includes all
the entities defined in the library, including requirements, tests, test resources, and business
components. Baselines also include the relationships between the entities in the library, such as
traceability and coverage. Baselines enable you to keep track of changes made to your project over
time.

In the following exercise, you will create an initial baseline that will later be compared to another
baseline to evaluate the impact of changes.
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To create a baseline:
1. Make sure the Libraries module is displayed.

If the Libraries module is not displayed, on the ALM sidebar, under Management, select
Libraries.

2. Add abaseline to your library.
a. Inthe libraries tree, select the Library1 library.

b. Click the Create Baseline button. The Baseline Verification dialog box opens, and a
verification process begins.

Baseline Verification ﬁ
]

Werification results:

Baseline expected content :
Tests ;12
Requirements ; 140

The Verification results window displays the results of the library size verification. The
process checks that the size of the library does not exceed the limit defined in Site
Administration.

c. Click Continue. The New Baseline dialog box opens.

d. Inthe Baseline Name field, type Baseline1. Click OK. The baseline is added to the
libraries tree, and the creation process begins.
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Libraries Edit View

2

ERHals-XE|x -

- Libraries
- Folder1
* [ Library1

L5l Baselinel

Details

=MName: Baselinel Baseline ID: 1001

Created By: =3 Creation Date: | 10/30/2013 1:00: [
Medified: 10/30/2013 1:00: [

The Easeline is being created. m

Description

BI UMAay =iz = =|eTT & B aal

The baseline is created in a background process, and may take some time. You can
continue working in ALM during the baseline creation process.

e. Inthe Details tab, click the Description pane and type Baseline of tests and requirements.

3. View the baseline log file.

In the Details tab, click the View Log button. The Log: Create Baseline dialog box opens and
displays the progress. Click Close to close the dialog box.

The View Log button is no longer displayed.

Comparing Baselines

You can compare two baselines in a library. For example, you can compare baselines at different
stages of development to assess the impact of changes made to requirements in your project. You
can then update the relevant tests in your project accordingly.

You can also compare a baseline to the current entities in the library. For example, suppose you
create a baseline at the start of a new release. Over time, changes are made to requirements in the
library. To determine whether product development is proceeding as planned, you can compare
requirements in the initial baseline with the current requirements in the library.

In the following exercise, you will add test coverage to a requirement and then create another
baseline. You will then compare your two baselines to evaluate the impact of the changes.
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To compare baselines:
1. Modify a requirement.
a. Onthe ALM sidebar, under Requirements, select Requirements.
b. Select View > Requirement Details.

c. Inthe requirements tree, under Mercury Tours Application, expand Application
Usability. Select Keyboard Support.

d. Click the Test Coverage tab. The Test Coverage tab displays coverage for this
requirement.

e. Ifthe Test Plan Tree tab on the right is not displayed, click the Select Tests button.

f. Inthe Test Plan Tree tab, expand the Mercury Tours Site and HTML Pages subject
folders.

g. Double-click the HTML Page Source test. The test is added to the coverage grid.
2. Create a new baseline.

Repeat Steps 1 and 2 in "Creating Baselines" on page 159. Name your new baseline
Baseline2.

3. Select a baseline with which to compare.
a. Inthelibraries tree, select Baseline1. Click the Compare To button, and select Select
Baseline to compare the baseline with another baseline. The Select Baseline dialog box
opens.

b. Click the arrow and select Baseline2 from the list. Click OK.

c. Click OK to close the Select Baseline dialog box. Click Yes to close the Warning dialog
box. The Compare Baselines Tool dialog box opens.
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It Compare Baselines Tool

[i] Reguirements P2 =
= TestFolders

Baseline:Baseline1 (Library:Library1)

Mo changes
Entities

3 @ Mercury Tours Application

Baseline:Baseline2 (Library:Library1)
. al=
Added:0 Modified:1 Absentd Moved:0

Entities Changes

3 @ Mercury Tours Application

The baselines are displayed in separate panes, with the more recently created baseline
displayed in the right pane. In each pane, the library’s entities are displayed in the same
hierarchical tree structure as defined in the specific module.

4. View requirement changes between the baselines.
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a. Click the Go To Next Change button in the right pane to view the change.

I8 Compare Baselines Tool = | B |l
5] Requirements 2| =
= TestFolders
Baseline:Baseline (Library:Library1) Baseline:Baseline? (Library:Library1)
S A 4| E
MNo changes Added:0 Modfied:1 Absent:0 Moved:0
Entities Entities Changes

- @ Mercury Tours Application

¥ @ Application Client System

» (&) Application Performance

3 @ Application Security

- @ Application Usability
3 @ Correct Error Messages
3 @ Keyboard Support
» (&) Spelling And Language Correctness
3 @ Task Simplicity

» (&) \Web Page Structure And Layout Consiste...

3 @ Eocking System

» (&) Online Travel Booking Services
» (&) Online Travel Information Source
» (&) Profile Management

» (&) Reservation Management

- @ Mercury Tours Application
3 @ Application Client Syste
» (&) Application Performance
3 @ Application Security
- @ Application Usability
» (&) Correct Error Mess_.
3 @ Keyboard Support | Modified E
» (&) Spelling And Langu..
3 @ Task Simplicity
» (&) \Web Page Structur..
3 @ Bocking System
+ (&) Online Travel Booking...
+ (&) Online Travel Informati..
» (&) Profile Management
+ (&) Reservation Managem

Differences between the two baselines are indicated in the Changes column. The tool
indicates that there is a difference in the Keyboard Support requirement between the

baselines.

b. To compare the modified requirement between baselines, select Keyboard Support and
click the Compare Entities button on the toolbar. The Compare Entities dialog box opens.

c. Click the Test Coverage button on the sidebar.
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5[t Compare Entities - Requirements

Compare Keyboard Support in "Baseline 1" to Keyboard Support in "Baseline2"

View: | Show all v
[ Details

Il Attachments

[(2 Requirement Traceability
T TestCoverage

| B
[] Show full path
Changes Keyboard Support in "Baseline1" Keyboard Support in...
By Welcome Page B Welcome Page
[E HTML Page Layout [E HTML Page Layout
25 Tab Order 25 Tab Order
2 Forms 2 Forms
l:l [Z» HTML Page Source
Configuration Coverage ¥
Changes Keyboard S Keyboard Support in
‘welcome Page ‘welcome Page
HTML Page Layout HTML Page Layout
Tab Order Tab Order
Forms Forms
l:l HTML Page Source
| Close | Help |

The Test Coverage view displays details of the entity in each baseline.

d. Click Close.
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In the previous lessons, you learned how to use ALM to help you manage all phases of the
application lifecycle management process, including specifying releases and cycles, specifying
requirements, planning tests, running tests, and tracking defects.

In this lesson, you will learn how to customize your ALM project to meet the needs of your team.
You can control access to a project by defining the users who can access the project and by
specifying the types of tasks each user can perform. When new members are added to your team,
you assign them to the projects that they will be using, and specify the tasks that they can perform.

You can also customize your ALM project by modifying system fields or by adding user-defined
fields. System fields are ALM default fields. You cannot add or delete system fields, you can only
modify them. User fields are fields that you can define. You can add, modify, and delete user-
defined fields.

Fields can be associated with system and user-defined lists. A list contains the values that the user
can enter in a field. For example, if you are running tests on two different database servers, you can
add a Database field to your project. You can then create a selection list containing the values
Oracle and Microsoft SQL, and associate the list with the Database field.

In this lesson, you will learn about:

Starting Project Customization . ... 167
Adding aNew Project User .. 169
AssigningalUsertoalUser GroUD . ... ... 171
Defininga User-Defined Field ... ... . 173
Creating a Project List . 175
Creating BusiNeSS VIEWS . . ... 179
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Starting Project Customization

You customize your ALM projects using the Project Customization window. In this exercise, you
will log in to the Project Customization window with project administrator privileges.

To start project customization:
1. Openthe HP ALM Login window.

Make sure that the ALM Login window is open. For more information, see "Starting ALM" on
page 16.

2. Type a user name with project administrator privileges and authenticate.
a. Inthe Login Name box, type alex_alm.
b. Skip the Password box. A password was not assigned to this user name.

c. Click the Authenticate button. ALM verifies your user name and password and determines
which domains and projects you can access.

3. Loginto the project.
a. Inthe Domain list, select Default.
b. Inthe Projectlist, select ALM_Demo.
c. Click the Login button.
The ALM main window opens and displays the module in which you were last working.

4. Open the Project Customization window.

a. Onthe ALM masthead, click 'I:I' and select Customize. The Project Customization
window opens.
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@ Application Lifecycle Management - Project Customization

Domain: DEFAULT, Project: Demo | User: alex_alm | 0 1 Return

£ User Properties
@ Project Users

{5 Groups and Permissions
[ Module Access
@ Project Entities

43 Risk-Based Quality Management
Project Lists

&3 Automail

B Alert Rules

2] vorkflow

3 Project Planning and Tracking
[E] Project Report Templates

[9 Business Process Test

[1 Business Views

Sprinter

User Propetics

[ Save | B ChangeFassword

User Name: slex_slm Full Name:

Email Phene Number.

Status: & Acive Deactivation Date:

By default, the Project Customization window contains the following links:

Option

User
Properties

Project
Users

Groups and
Permissions

Module
Access

Project
Entities

Requirement
Types

Risk-Based
Quality
Management

HP ALM (12.00)

Description

Enables you to change your user properties. For example, you can
change your email address. You can also change your password.

Enables you to add and remove users from an ALM project. You can also
assign users to user groups to restrict user access privileges.

Enables you to assign privileges to user groups by specifying permission
settings.

Enables you to control the modules that each user group can access. By
preventing users from accessing unnecessary modules, you can better
utilize your ALM licenses.

Enables you to modify the behavior of ALM system fields or define user-
defined fields that are unique to your project. For example, if you are
running tests on several builds of an application, you can add a Detected
in Build user-defined field to the New Defect dialog box. You can then
associate it with a selection list containing the values for this field.

Enables you to customize the definitions for requirement types.

ALM Editions: This option is not available for HP ALM Essentials
Edition.

Enables you to customize settings for risk-based quality management.

ALM Editions: This option is not available for HP ALM Essentials
Edition.
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Option

Project Lists

Automail

Alert Rules

Workflow

Project
Planning and
Tracking

Project
Report
Templates

Business
Process
Testing

Business
Views

Sprinter

Description

Enables you to add customized lists to a project. A list contains values
that the user can enter in system or user-defined fields. For example, for
the Detected in Build field, you can create a selection list containing the
values Build1, Build2, and Build3.

Enables you to set up automatic mail notification rules to inform users via
email each time changes are made to specified defects.

Enables you to activate alert rules for your project. This instructs ALM to
create alerts and send emails when changes occur in the project.

Enables you to generate scripts that perform commonly needed
customizations on dialog box fields in the Defects module. In addition,
you can write scripts to customize dialog boxes in other modules, and
control the actions that users can perform.

Enables you to create and customize the project planning and tracking
(PPT)KPIs.

ALM Editions: The Project Planning and Tracking link in Project
Customization is not available for HP ALM Essentials Edition and HP
Quality Center Enterprise Edition.

Enables you to create and customize report templates that project users
can assign to template based reports.

Enables you to configure Business Process Testing and Business
Process Testing Enterprise Edition.

Enables you to create business views that can be used as a basis for
creating reports in the Analysis View module.

Enables you to configure settings for working with HP Sprinter for
manual testing in ALM.

ALM Editions: The Sprinter link in Project Customization is not
available for HP ALM Essentials Edition and Performance Center
Edition.

Adding a New Project User

You can control access to an ALM project by defining the users who can log in to the project, and by
specifying the types of tasks each user may perform.

For each project, you select project users from the ALM site users list. This list is created in Site
Administration.
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From Project Customization, you add users to a project and assign them to user groups. Each user
group has access to certain ALM tasks.

In this exercise, you will add a new project user to the ALM_Demo project.

Note: For the purpose of the exercise, we will first remove a user from the project, and then
add the user to the project again.

To add a new project user:
1. Make sure that you are logged in to ALM as a project administrator.

For more information on how to open the Project Customization window, see "Starting Project
Customization" on page 167.

2. Open the Project Users page.

In the Project Customization window, click the Project Users link. The Project Users page
opens and displays a list of users that have been assigned to the project.

Project Users
FI: Save LJJJ AddUser ~ 3€ Remove User

Name Ful Details | Membership

alex_alm

aglice_alm
cecil alm User Name: Slex_alm Full Name:
james_alm

E-mail: Phone Mumber:
kelly_alm

Deactivation
Date:

mary_alm Status: ﬂ Active
michael_alm

paul_alm

peter_alm

robert_alm

Eo> E> Eo Eo B> Bo Bo Eo Bo B> Bo Bo

shelly_alm Description:

3. Remove auser.

In the Project Users list, select cecil_alm, and click Remove User. Click Yes to confirm.
4. Addanew user name.

a. Click the Add User down arrow.

You can add an existing user from the list of site users by typing the user's name or by
selecting the user from the list of site users. You can also create a new user and add the
new user to the project.
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b. Select Add User by Name. The Add User dialog box opens.

Add User S|

|User Mame:

c. Inthe User Name box, type cecil_alm and click OK.

The new user is added to the Project Users list and the user properties are displayed in the
Details tab. User personal settings are defined in Site Administration.

Project Users
F]EI Save | g AddUser » 3§ Remove User

Name Full... Details =~ Membership

—
alex_alm

alice_alm
james_alm User Mame: cecil_alm Full Name:
kelly_alm

E-mail: Phone Number:
mary_alm

Deactivation
Date:

michael_alm Status: .'_‘. Active
paul_slm

peter_alm

robert_alm

shelly_alm

ExEoEo Eo Eo Eo Eo Eo Eo B2 B2 Bo

cecil_alm Description:

Assigning a User to a User Group

To enable users to do their job, and to protect a project from unauthorized access, ALM enables you
to assign each user to a specific user group. Each group has access to certain ALM tasks. You can
use the predefined user groups with their default permissions or you can customize your own user
groups with unique sets of permissions.

In this exercise, you will assign the new user cecil_alm to the QATester user group.
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To assign a user to a user group:
1. Make sure that the Project Users page is displayed.

If the Project Users page is not already open, click the Project Users link in the Project
Customization window.

Project Users
FI:I Save I:',} Add User - 3§ Remove User

Name Full... Details = Membership

alex_slm
aglice_alm
james_alm User Name: ceci_alm Full Name:

kelly_alm

E-mail: Phone Number:
mary_alm

Deactivation
Date:

michael_alm Status: ﬂ Active

paul_slm
peter_alm
robert_alm

shelly_alm

E> E> B> Eo Eo Eo Eo Eo Eo Eo Eo Bo

cecil_alm Description:

2. Select cecil_alm from the Project Users list.
In the Project Users list, select cecil_alm.
3. Display user's membership in user groups.

Click the Membership tab. The user groups to which cecil_alm belongs and does not belong
are displayed.
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Project Users

FI:I Save l::}' Add User = 3§ Remove User

Name
glex_alm
glice_alm
james_alm
kelly_alm
mary_alm
michael_alm
paul_alm
peter_alm
robert_alm

shelly_alm

E> B> B> Bo Bo Bo Bo Bo Bo Bo B2 Bo

cecil_alm

Details Membership

Mat Member of

#» Defect Reporter

= Developer

= Project Manager

% QA Manager

i= (ATester

%2 AnD Manager

i= TDAdmin »

4. Assign cecil_alm to the QATester group.

Member of

.
im iewer

Under Not Member of, select QATester and click the right arrow button to move the group to

Member of.

5. Remove cecil_alm from the Viewer group.

a. Under Member of, select Viewer and click the left arrow button to move the group to Not

Member of.

b. Click Save to save the changes to the Project Users page. Click OK.

Defining a User-Defined Field

You can define user-defined fields that are unique to your project, or modify the behavior of ALM

system fields.

The fields are stored in ALM project entities. For example, the Defect entity contains data entered in

the Defects module.
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In the following exercise, you will add the Database user-defined field to the Defect entity. This field
indicates the server database in use when testing an application.

To add a user-defined field:
1. Make sure that the Project Customization window is displayed.

For more information on how to open the Project Customization window, see "Starting Project
Customization" on page 167.

2. Open the Project Entities page.

In the Project Customization window, click the Project Entities link. The Project Entities page
opens.

Project Entities

A sove | & - %

b g Baselines Settings
» §] Business Component
P | Business Process Model Activities
» B Business Process Model Folders
* & Business Process Model Paths
b 2 Business Process Models
» (7 Cycle

P [} Defect

» & KR

b Library

» @ Milestone
b (23 Release

» 3 Release Folder

» [£] Requirement

F * Resource

» EJ Resource Folder
» [ Fun

P [¥] Scope ltem

v JL Test

P §J1 Test Configuration
» JL TestInstance

b <P> Test Parameter

» JL, Test Set

4 Test Step

3. Add a new user-defined field to the Defect entity.
a. Under Project Entities, expand Defect.

b. Click the User Fields folder and click the New Field button. A new field is added under the
User Fields folder.
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Project Entities
[& save | gp NewFicld = 3¢ Delete Field

b Lg Baselines Settings
» L Business Component _—
b | Business Process Model Activities
» & Business Process Model Folders

+ & Business Process Model Paths Label: BG_USER_05

b 5 Business Process Models Type: String

Name: BG_USER_DG

b (7 Cyele
- Defect
Sanitizati : Text v
» B3 System Fields antization type

- User Fields

Length: 40

m

History Required

Masked Searchable

E# Browser
7 Category

E# Language
7 Product Area
7 Regression

» I KF

b L Library

b 4@ Milestone

b (o2 Release

BG_USER_nn indicates a user-defined field under the Defect entity.
4. Rename the default field name.
a. Inthe Label box, instead of the default name, type Database.
b. Click Save.

c. Click OK.

Creating a Project List

You can associate fields with system and user-defined lists. A list contains values that the user can
enterin afield.

In the previous exercise you added the Database field. In the following exercise you will create a list

and assign it to the Database field. You will then open the New Defect dialog box to view the new
field.

To create a project list:
1. Make sure that the Project Customization window is displayed.

For more information on how to open the Project Customization window, see "Starting Project
Customization" on page 167.

2. Open the Project Lists page.
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In the Project Customization window, click the Project Lists link. The Project Lists page

opens.

Project Lists

[& save | 55 Mewlist 35
& Al Projects

& BC_FAIL_COND

& Browser

1 Bug Status

& Categery

1 Component Instance Fail C
& Component Status

& CompType

& Configurations

1 Coverage Mode

& Coverage Status

& HTML Edition Versions

& Java Edition Versions

@ Link Type

@ Model Prototype

@ Operating System

@ Parameter Types

1 Plan Status

1 Priority

& Product Area

& REQM Functional Complexi
& RBQM Risk Levels

& RET Business Impact Level
1 RET Failure Probability Lev
1 RET Testing Levels

1 Requirement Status

@ Reguirement Type

1 Reguirements

1 Resource Location

3. Create anew list.

a. Click New List. The New List dialog box opens.

b. Inthe List Name box, type DB. Click OK to close the New List dialog box.

4. Add Items to your list.

HP ALM (12.00)
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a. Click New Item. The New Item dialog box opens. Type Oracle and click OK.

b. Repeat the same procedure and add MS SQL to the DB list.

Project Lists

[® save | 25 Newlist 35 RenameList &5 Delete List

(i Activity Status i< Newltem 5= New Subtem 3= Renameltem &/ Delete ltem
1 Administration Versions
f@ All Languages

1 Al Projects

& BC_FAIL_COND

& Browser

& Bug Status

f@ Category

1 Component Instance Fail C
& Component Status

1@ CompType

& Configurations

& Coverage Mode

1 Coverage Status

i= Oracle

= saL

c. Click Save to save the changes to the Project Lists page. Click OK.
5. Assign the list to the Database field.

a. Inthe Project Customization window, click the Project Entities link. The Project Entities
page opens.

b. Under Project Entities, expand Defect.

c. Expandthe User Fields folder and select Database.
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d. Under Settings, in the Type list, select Lookup List to set the field type as a drop-down
list. The Lookup list section is displayed below the field settings.

Project Entities
[ Save | gp MewField ~ $¢ Delete Field
b g Baselines Settings

» ] Business Component

b | Business Process Model Activities .
) Name: BG_USER_DE
+ [ Business Process Model Folders
b 4 Business Process Model Paths Label: Database
b = Business Process Models Type: Lockup List v
-
b (5 Cycle Length:
- Defect
Sanitizat :
» B3 System Fields antizztion tpe
- User Fields Histary Reguired
&7 Browser Masked Searchable
7 Category
C# Database
Lookup list
E# Language P
E# Product Area Activity Status ~
7 Regression
» L:J KPI Werify value
b ) Library Allow Multiple Values
b @ Milestone

b (23 Release
+ B3 Release Folder
b [£] Reguirement

e. Under Lookup List, select the DB list.

f. Click Save to save the changes to the Project Entities page. Click OK.
6. View the new user-defined field in the New Defect dialog box.

a. Click the Return button located on the upper-right corner of the window.

b. Inthe Customization Changes dialog box, select Major Change, and click OK. The
Project Customization window closes, and you return to your ALM project.

c. Inthe Defects module, click the New Defect button. The New Defect dialog box opens.
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. &1 New Defect | i

F=4 ni‘_]' B [y ‘E| By Use Default Values Set Default Values

= Summary:

5 Details Details

Il Attachments
Closing Date: v Database: | v
Detected in Cycle: v Detected in Relea. v
Detected in Versio.. w Estimated Fix Tim..
Language: ~ Modified:
Description:
B I U Aab === 3206717 & EHY aa B

The Database field is displayed in the New Defect dialog box. You may need to drag the
scroll bar down to display the field.

d. Click the down arrow and view the database types you defined. Click Close.

Creating Business Views

Business views are a semantic data layer that can be used as a basis for the various ALM reporting
tools. Business views are based on project entities, and ensure that only information that is relevant
to a business consumer is contained in the report.

In the following exercise you will create a business view for creating graph reports.

To create a business view:
1. Make sure that the Project Customization window is displayed.

For more information on how to open the Project Customization window, see "Starting Project
Customization" on page 167.

2. Open the Business Views page.

In the Project Customization window, click the Business Views link. The Business Views
page opens.
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Business Views

Fﬂ save | §) AddView [[] Duplicate vView | 3¢ Delete view | ¥ Validate Al > Import Views
+ [ Views Query Designer | Details | Query Messages
Y Baselines
2 Comporents View - | B AddEntity = ® [@ Preview o Validate View | Status | Published v ’_’
oy Defects £ Main
Y Defects Assigned tom IE‘_I =
y
4 Defects With Linked De U = - - =
aseline (baseling) [ ibrary (libra =
A Defects Vith Linksd Re Coo L HE - ’Iy,)( Cr
Y Defects With Linked Te [ Atachment fhas_at r .Mynchrunuus statu
N [T Auto complete type [T Atachment fhas_at A
l Defects With No Linked [w  Baseline ID (id) [T Auto complete type 5
il Defects_history [ Capture State (capt ™ Created By [owner)
|¥  Created By {owner} ™ Created from Baseli
Rel Cycl
i Release Cycles [w  Creation Date (crea [~ Created from Baseli
Y Releases [w  Description (descrip [~ Created from Domai
A, ReleasesAndCycles ™ s repository capture [~ Created from Library b
) [T Modified {vis) [~ Created from Library
4 Requirements V' Name [name) I~ Created From Librar =
2 Reguirements Authore [T Parent (Library} ID { [~ Created from Projec
™ Version Stamp (ver_ [T Created or Synchrol
Jl Requirements Coverag ~ I~ Creation Date crea
2 Requirements Traced [~ Descrintion (descrin 2
. Requirements Traced Output | Expression Label Alias Criteria Or... Or... |

Y Requirements With Lin
JY Requirements With Tar

DQL Query Builder

Select baseline id. baseline name. baseline.description, baseline owner, baseline creation_date, library name As lib_name. library.id As lib_id

L Run lterations From baseline Inner Join library On baseline lib_id = library.id
% Run Steps
&% Runs
2 2l

3. Create anew business view.
a. Click Add View. The New View dialog box opens.

b. Inthe Label box, type Mercury Tour Defects. In the Technical Name box, type MT_
Defects. Click OK to close the New View dialog box.

4. Add project entities to your business view.

a. Click Add Entity in the Query Designer tab. The Model tree opens in the right pane. The
Model tree displays all project entities and fields in the current project.

b. Select the Defect entity and click the Add arrow to move it to the Main pane.
5. Define relationships between the project entities.

a. Inthe Main pane, select the Defect entity.

b. Click Add Related Entity. The Add Related Entity dialog box opens.

c. InTarget Entity, click the arrow and select Requirement. The Relation Name field is
automatically valued with Linked Requirements.
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d. Click OK.

Business Views

B Sa\:el B Addview [I] Duplicate View

¥ Delete View | ¥ Validate e«u‘ < ExportViews 3> Import Views

+ A views Query Designer | Details | Query Messages
Ju Baselines
J& Components WView ® ‘ [& Preview o validate View | Status | Mot Published v ‘ O Show SQL Query
o Defects @ Main | Model *
A Defects Assign Nl
s
2 Defects With Li / ,R-Eqm;ment Los2 @_I a
Defects Wiith Li I i W
& e Defect (defect) [ Defect Link (defect..|5) ,|: mh"'e"' at |Fier -
i Defects With Li r oo A roo o fonrer) » [ Report To Report Project Templ
el Foc Time [ I Crested By fowner) I” Comments (com| _ ) Report To Report Project Templ
o Defects Wit N usl Fox Time | =d By (owner) " Creation Date ic » [ Report User Templste (report_u
A Defects I Assigned To for = ool [T Creation Date fore I Creation Time &
fects_history [~ Atachmert (attz__ [~ Defect ID first_end ™ Descrption (des._| » ) Requirement (requirement)
u Mercury Tour D I~ Browser fuser_0 T Link Comment (com [~ Direct Cover Stz b [ Requirement Baseline (requirem
A Release Cyc! I Category fuser_ I LnkIDd) ™ Fes Rch Te { -
Elease Lycles [~ Closedin Verso [~ Unk Type ink_type | I s Template fste » [ Requirement History (requireme
i Releases " Closing Date (ch I” Linked Entity ID se [~ Modfied fast_m 3 » ) Reguirement Multi Value (requir
A Releasestndy I~ Comments [dev, ™ Linked Entity Type 1 ™ Neme fname)
v [~ Cycle D [eycle_ - I Nombor of sons » [ Requirement Multi Value Basel
A Reguirements '|: B:‘laz‘a‘sgs(g.l}sel 1 [~ Old Type (obsoh » [ Reguirement Multi Value Versio
R s A ect ID [ [~ PPM Assigned~
i Reuwemn‘s A tl DESG“—WM des = - em R:q‘i';; f » [ Requirement Target Cycle (requ
equirement [~ PPM Request N » () Requirement Target Release (re
A Reauirements T ’|: gm Eeﬂuezi » () Reauirement Trace (req_trace)
A Requirements T que »
™ PPM Sarver UR — (0 Requirement Trace Baseline (re
A Requirements ’|: ;:F!\:tf\:nchmnﬂ ‘ ‘ - b ) Requirement Type (requirement
- tiorty freq_prio =
J4 Reguirements —. - i » ) Reguirement Version Control (re
i Run herations » () Resource (resource)
2 Run Steps Ouput | Exprossion [ Label | Ales [ crtera [ or [or | - Esseline | .
[ Resource Baseline (resource_|
i Runs 5 ‘ ‘ ‘ | ‘ ‘ b ) Resource Folder (resource_fold
4 Runs With Link » (0 Resource Folder Baseline (reso
i Test Configurati e » [0 Resource History {resource_hist
i uery Builder ;
Ju Test Configurati » [} Resource Multi Value (resource
; Select * -
i TestDesign Ste o efect » [0 Resource Multi Value Baseline (
4 Testlnstances :nnerjuln defect, _hm:“ DDrv defect id = "?e;emggvkczwr‘slfndpu\ndt_\d ot a1 » (O Resource Mult Value Version C
Inner Join requirement On requirement id = defect_link second_sndpoirt_
o Testinstances defect_link second_sndpoint_type = REQ" -l b | Peenuroa Varsinn Con

6. Preview the new business view.
a. Click Validate. Any validation warning or error messages are shown in the bottom pane.
b. Click Preview. The Query Results are shown in the bottom pane.
c. Change the Status to Published.

d. Click Save.
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ALM helps you organize and manage all phases of the application lifecycle management process,
including defining releases, specifying requirements, planning tests, executing tests, and tracking
defects. Throughout each phase, you can analyze data by generating detailed reports and graphs.

Rc:al.easge Reqqq’emgnt Test Planning Test Execution Defect Tracking
Specifications Specifications

Analysis

Phase Description

Release Develop a release-cycle management plan to help you manage application
Specifications = releases and cycles efficiently. You can track the progress of an application
release against your plan to determine whether your release is on track.

Requirement = Define requirements to meet your business and testing needs. You can manage

Specifications = the requirements and conduct multi-dimensional traceability between
requirements, tests and defects, across multiple releases and cycles. ALM
provides real-time visibility of requirements coverage and associated defects to
evaluate quality and business risk.

Test Planning = Based on the project requirements, you can build test plans and design tests.
ALM provides a repository for both manual and automated tests.

Test Create a subset of the tests in your project designed to achieve specific test
Execution goals. ALM supports sanity, functional, regression, and advanced testing.
Execute scheduled tests to diagnose and resolve problems.

Defect Submit defects and track their repair progress. Analyzing defects and defect

Tracking trends helps you make effective “go/no go” decisions. ALM supports the entire
defect lifecycle — from initial problem detection through fixing the defect and
verifying the fix.
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We appreciate your feedback!

If you have comments about this document, you can contact the documentation team by email. If
an email client is configured on this system, click the link above and an email window opens with
the following information in the subject line:

Feedback on Tutorial (ALM 12.00)
Just add your feedback to the email and click send.

If no email client is available, copy the information above to a new message in a web mail client,
and send your feedback to SW-Doc@hp.com.
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